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INTRODUCTION 
WELCOME TO ONESOURCE GLOBAL TAX FOR SAP 
ARIBA SOLUTIONS 
Corporations using SAP Ariba Procurement Solutions can improve their tax accuracy by integrating with 
the ONESOURCE Global Tax for SAP Ariba Solution. This solution enables Buying Organizations to get 
fast, accurate tax (Sales, Use, GST and VAT like) results on procurement transactions and a complete 
audit trail from which you can generate both standard and custom reports, as well as information to assist 
in returns preparations.   

The ONESOURCE Global Tax for SAP Ariba Solutions makes the tax calculation process easy by 
eliminating the need for preparing the complex tax master data like tax codes, rates, jurisdictions and 
other look ups manually. The very basic and easy tax master data would suffice in addition to web service 
configuration to get tax rates from globally recognized, robust tax engine backed up by dynamic tax 
content. 

This solution covers Use Tax, GST and VAT like taxes except taxes for Brazil for SAP Ariba Buying 
(previous product name: Ariba Procure-to-Order), SAP Ariba Buying and Invoicing. (Previous product 
name: Ariba Procure-to-Pay), SAP Ariba Invoice Management (previous product name: Ariba Invoice 
Professional) using SOAP based web services. 

WHO SHOULD READ THIS GUIDE? 
If you are responsible for overseeing setting up ONESOURCE Global Tax for SAP Ariba Solutions, you 
will need to coordinate help from the following people: 

• SAP Ariba Procurement Solutions Business Systems Analyst 
• SAP Ariba Procurement Solution Configuration Consultant 

  
A good understanding of this guide by the project team is required to ensure a successful installation. 

PREREQUISITES 
For a seamless and successful deployment of Integration for SAP Ariba Solutions follow all instructions 
within this guide. 

When working on Integration for SAP Ariba you must have a deep knowledge of the SAP Ariba 
Procurement Solution features and functionality covering all aspects of SAP Tax Code concept, SAP 
Ariba Tax Master Data, SAP Ariba Master Data maintenance by using Import/Export Tasks, SAP Ariba 
Integration Task configuration as an expert configurator or consultant in these areas. We recommend that 
you assemble a team to implement this product because it requires both functional and technical input. 
Your team should include someone who thoroughly understands business requirements and processes 
and web service and SOAP integration concepts. 
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The following tasks are expected to be completed before ONESOURCE Global Tax for SAP Ariba 
Solutions is configured in Customer’s Ariba instance: 

Task Task Name Description/Details Responsible Team 

1 SAP Ariba 
Customer and 
Thomson 
Reuters need to 
sign an 
agreement on 
ONESOURCE 
tax integration 
service 

SAP Ariba Customer Support 
Team and Thomson Reuters 
Professional Team 

2 Enable Tax API 
feature toggle in 
Ariba system 

SAP Ariba Professional 
Team/Customer Support Team 

3 Set SAP Ariba 
site parameters 
required to be 
maintained for 
utilizing third-
party tax 
calculation 
feature 

Parameters that are recommended by SAP 
Ariba/prescribed in SAP Ariba Tax 
Configuration Product Document 

SAP Ariba Professional 
Team/Customer Support Team 

Please consult SAP Ariba Customer Support for enabling external tax calculation in SAP Ariba 
Buying Solutions. SAP Ariba will be able to guide on required feature toggles and parameters 
that need to be enabled.   

SYSTEM PREREQUISITES 
The configuration involves creating a Web Service End-point using SOAP communication protocol to 
request tax calculation service from cloud system to a cloud based system and does not involve any new 
software components installation. 

System Requirements 

SAP Ariba Procurement Solution 14s or Higher 

ONESOURCE Indirect Tax 
Determination Tax Calculation Service version 2011-09-01 

ONESOURCE Global Tax for SAP 
ARIBA Solutions ONESOURCE Global Tax for SAP ARIBA Solutions 

  

ÿ
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SCOPE OF THIS SOLUTION 
The ONESOURCE Global Tax for SAP Ariba Solutions makes tax calculation process simple by 
eliminating the need for manual tax master data preparation as required for a native Ariba tax 
solution. This integration solution utilizes dynamic tax content and a robust tax engine making it 
easy for even the most complicated tax scenarios. 

The solution has been developed to comply with the following scope 

• SAP Ariba Procurement Solutions with version 14s or Higher. 

• Tax calculation using this product happens on SAP Ariba Purchase Requisitions (Goods, 
Services of type catalog or Non-catalog) and Invoice Reconciliation Documents (PO based, 
Non-PO based and ERS based). 

• Use Tax, GST and VAT like taxes are covered at global level except Brazil. 

RESOURCES 
Resource Description 

Customer Support 
Look for answers in the Knowledge Base, or open a support ticket on 
https://tax.thomsonreuters.com/support/onesource/indirect-tax 

Configuration Guide 
This guide instructs how to configure and setup the integration product to 
enable tax calculations using ONESOURCE Indirect Tax Determination. 

SUPPORT PROTOCOL 
The ONESOURCE Global Tax for SAP Ariba Solutions is built, maintained, and owned by Thomson 
Reuters Tax & Accounting Indirect Tax. The business unit has a dedicated group of employees who have 
built this product. SAP Ariba built the tax API within SAP Ariba hence they support the process of 
gathering data within SAP Ariba and making it available to the tax API. Thomson Reuters Integration 
maps data between SAP Ariba Tax API and Determination.   In case of an issue with the ONESOURCE 
Global Tax for SAP Ariba Solutions, please follow below mentioned simple steps to open a support ticket 
with Thomson Reuters: 

1. Identify the potential issue and gather all necessary facts (log files, scenarios, configurations, 
screen prints). 

2. Provide steps to reproduce the scenario leading to the issue. 
3. Provide system environment information such as your SAP Ariba Procurement Solution version, 

Cloud Integration version.   ONESOURCE Indirect Tax Determination version and ONESOURCE 
Global Tax Integration for SAP Ariba Solutions integration version. 

4. Open a support ticket with Indirect Tax at 
https://tax.thomsonreuters.com/support/onesource/indirect-tax 

STYLE CONVENTIONS 
Style conventions provide a guide as to how to interpret information. 

Bold text indicates most user interface elements, such as: 

 

https://tax.thomsonreuters.com/support/onesource/indirect-tax/
https://tax.thomsonreuters.com/support/onesource/indirect-tax
https://tax.thomsonreuters.com/support/onesource/indirect-tax/?search=000026965
https://tax.thomsonreuters.com/support/onesource/indirect-tax
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• Data you are expected to enter, such as in a text field 
• Pages, buttons, tabs, and field names 
• Dialog boxes, drop-down lists, selections within lists, and check box titles 
• Windows 
• Menu items 

Italic text indicates the following: 

• File and folder names 
• Software programming terminology and executable files 
• Document titles 

CAPITALIZED text indicates keyboard commands, such as ENTER, or database components. 

Courier text indicates command-line input/output. 

<brackets> indicate user entry. For example, <host> indicates you should replace the text and angle 
brackets with your server name. 

Book titles are shown in italics and sections within a book are in quotation marks, such as “Tips and 
Tricks” in the ONESOURCE Indirect Tax User Guide. 

Indicates suggestions or additional, detailed information. 

Indicates important text that should be carefully reviewed before proceeding. 
ÿ
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APPLICATION OVERVIEW 
This chapter describes: 

• The purpose and benefits of the ONESOURCE Global Tax for SAP Ariba Solutions application 
• A high-level overview of the business process flow   
• A description of the program flow by which the process works 

PURPOSE AND BENEFITS 
The ONESOURCE Global Tax for SAP Ariba Solutions application enables an organization using SAP 
Ariba Procurement Solutions (SAP Ariba Buying, SAP Ariba Buying and Invoicing, SAP Ariba Invoice 
Management) to accurately and efficiently calculate, accrue, and record tax for SAP Ariba Purchase 
Requisitions and Invoices. 

This product enables Organizations to utilize tax calculation service from a robust tax engine backed up 
by world class dynamic and most up to date tax content. With very minimal master data maintenance, 
users can benefit from tax calculation on SAP Ariba approvable like Requisition, Invoice Reconciliation for 
domestic, foreign and cross-border tax scenarios from simple to complex in nature. 

When ONESOURCE Global Tax for SAP Ariba solutions is integrated with SAP Ariba Procurement 
Solution, time and effort required for manual tax master data maintenance is saved while accessing most 
up to date content in real-time. 

BUSINESS PROCESS FLOW 
The exact procure to pay business process flow may vary by Buyer Organization practice, Buyer 
Organization’s SAP Ariba and ERP system landscape but tax calculation service from ONESOURCE 
Global Tax for SAP Ariba Solutions is available son SAP Ariba Purchase Requisition and Invoice 
Reconciliation documents in SAP Ariba Cloud Buying Solution. 

The following steps lists the process flow for tax calculation with a general procure to pay business 
transaction process: 

• The SAP Ariba Procurement Solution (SAP Ariba Buying, SAP Ariba Buying and Invoicing) 
makes tax call on purchase requisition when user submits the document for approval.   

• SAP Ariba Procurement Solution sends the data at document level which is relevant for tax using 
web service/SOAP message channel. 

• ONESOURCE Global Tax for SAP Ariba Solutions determines accurate tax data and responds 
back to SAP Ariba system with tax details (Tax Authorities, rate/amount, SAP Tax Code, SAP 
Account key and other information). SAP Ariba system captures data from tax call response and 
updates the details on Purchase Requisition line item. 

• If for any reason user would like to change purchase requisition (on allowed requisition and order 
statuses) tax will re-calculated upon update document submission and during approval process. 
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• As per SAP Ariba Procurement standard functionality, Purchase Order would be created 
automatically once Purchase Requisition is approved. In addition to other data, tax data also gets 
copied to Purchase Order Line items and so there would not be other tax call on Purchase Order 
If tax is recalculated on change purchase requisition transaction, updated taxes would be copied 
over to purchase order line items like other changes. 

• As a next step, supplier receives the Purchase Order and may choose to confirm Order and send 
Advanced Ship Notice. Once Buyer Organization receives the goods or services, user posts the 
receipts (in case of receipt relevant transactions). Supplier submits Invoice for goods supplied or 
services rendered. 

• During Invoice processing on SAP Ariba Buying and Invoicing or SAP Ariba Invoice Management 
solution, the system makes tax call on Invoice Reconciliation Document to verify taxes entered by 
Supplier. 

• ONESOURCE Global Tax for SAP Ariba Solution determines and proposes expected taxes. If tax 
data on Invoice Reconciliation document matches with what ONESOURCE calculated, taxes 
would be reconciled and if no other variances are found, invoice gets reconciled. This process is 
repeated when the supplier also submits other non-standard invoice types like Line-item Debit 
Memo or Line-item Credit Memo. 

But if there is any variance between tax information on IR document and tax calculation response 
from ONESOURCE Global Tax for SAP Ariba Solution, SAP Ariba system issues exceptions. 
Exception handling is SAP Ariba standard process. IR document has option to recalculate taxes. 
Buyer Organization’s user can trigger tax call by selecting Recalculate Tax option on IR 
document. In case of IR rejection, subsequent Supplier re-submission, tax call would be made 
automatically when Invoice is re-submitted like Invoice posting process. 

• This process flow would be similar irrespective of type of Procurement source like catalog or non-
catalog based items, PO based, or Non-PO based Invoices and ERS based invoice. 

The following diagram describes the tax request and response process in a typical Ariba Procure to Pay 
Business Process: 
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Supplier Transaction System 

arrows

The ONESOURCE Global Tax for SAP Ariba Solutions is built to make Tax calculation process simple 
and easy supported by robust tax engine and world class research based dynamic tax content. Utilizing 
the tax calculation service from ONESOURCE Global Tax for SAP Ariba Solutions enable SAP Ariba 
Customer to save time required to set up tax process in SAP Ariba and tax master data maintenance. 

And, being supported by dynamic tax content and robust tax engine, simple to complex and domestic, 
foreign and cross border tax scenarios can be handled. 
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INTEGRATION FRAMEWORK 
The ONESOURCE Global Tax for SAP Ariba Solutions integration framework comprises SAP Ariba Tax 
API communicating with ONESOURCE Tax Solution in real time using Web Services/SOAP protocol.   

SAP Ariba Tax API is designed to make a web service call to the external Tax calculation service provider 
for tax calculation services and receive a response to update transaction documents. SAP Ariba 
Procurement Solution is configured with Web Service and Endpoint for ONESOURCE Global Tax for SAP 
Ariba Solutions.   During procurement transaction, Tax API is invoked to make the external tax calculation. 

ONESOURCE Global Tax for SAP Ariba Solutions receives a tax call where ONESOURCE Global Tax 
enriches the SAP Ariba application data and hands it over to ONESOURCE Indirect Tax Determination 
for tax calculation purpose. Once tax is determined, the response is converted per SAP Ariba message 
format by ONESOURCE Global Tax and sent over to SAP Ariba Tax API. SAP Ariba Tax API receives 
the response and updates the transaction documents with tax information received from ONESOURCE 
Global Tax for SAP Ariba Solutions. The tax call and response occur in real time to provide seamless 
integration between SAP Ariba Procurement Solution and ONESOURCE Global Tax for SAP Ariba 
Solutions.   

INDIRECT

TAX

THOMSON REUTERS

SAP Ariba TAXAPI ONESOURCE
Solutions Real-time Tax Calculation

ONESOURCE
Tax ServiceIntegration
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TAX CALCULATION USING 
ONESOURCE GLOBAL TAX FOR SAP 
ARIBA SOLUTIONS 
PROCESS AND TRANSACTION FLOW 
The integration of SAP Ariba Procurement Solution with ONESOURCE Global Tax for SAP Ariba 
Solutions would provide seamless and real-time tax calculation service. With ONESORCE integration, 
Buyer Organization need not to maintain tax rates for each tax authority instead can rely on 
ONESOURCE Indirect Tax Determination System for complex tax component details, dynamic rate 
changes. ONESOURCE Indirect Tax Determination makes use of complex algorithms on dynamic and 
research based global tax content to determine to calculate accurate taxes. 

A typical SAP Ariba Procure to Pay transaction with ONESOURCE Global Tax for SAP Ariba Solutions 
would be as shown in below diagram: 
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The tax calculation takes place on Purchase Requisition and on Invoice Reconciliation Document. The 
details process flow is as following: 

1. Procurement business process normally starts with Purchase Requisition. During requisition 
processing buyer user can calculate taxes by simply clicking on Update Taxes button (newly 
introduced) available on requisition summary page (on top and bottom of the page). 

Update Taxes button present on top and bottom of the page: 

Buyer SAP ECC s,-m Ariba P2P System TR Tax Cloud Solution Ariba Network   
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2. SAP Ariba Procurement initiates the tax call and transmits document level information available on 
requisition to ONESOURCE Indirect Tax Determination. Based on transaction information received 
for requisition and based on corresponding legal entity (ex: SAP Company Code on requisition) tax 
set up in ONESOURCE Indirect Tax Determination, applicable tax rates are determined, and tax 
amount is calculated.   

3. ONESOURCE Global Tax for SAP Ariba Solutions then sends back to SAP Ariba Procurement 
Solution detailed tax information including tax authorities, tax types, tax rates and tax amount. SAP 
Ariba solution would update the tax information on requisition document. The tax call request and 
response occurs in real time.   

4. Ariba user can continue to process the requisition where document can be either saved for future 
processing or submitted for approval. When requisition is submitted for approval, tax call is made 
automatically to determine and calculate taxes.   

PR1319:AribaDemo Print Continue Shopping UpdateTaxes Delete Save Submit

Summary

Title: AribaDemo CartSummary

OnBehalfOf VenuKotagiri ILOffice Supplies(1) $3.000.00USD

DelayPurchaseUntil: i

Total(1item) $3000.00USD

CompanyCode:3000(IDESUS INC)

MyLabels: ApplyLabel..

DeliverTo: Requestor

Need-byDate:

SupplierPart#:3001_PhotoCopier2

CommodityCode:Photocopiers

Material Group:00601(Office Machines)

Purch Org:3000(IDESUSA)

Vendor.3001(IL Office Supplies)
LineItemText:

Contact.ILOfficeSupplies

Payment Terms:0001

Actions UpdateTotal

ContinueShopping UpdateTaxes Delete Save Submit
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Update Taxes button is an optional feature which can be used to simulate tax calculation 
and check what could be expected tax. Ariba user can either save or submit the requisition 
without clicking on Update Taxes button. When user submits the requisition for approval, 
tax call is made automatically and ONESOURCE Global Tax Determination solution 
provides tax results. 

If Buyer SAP Ariba Procurement Solution is enabled for external budget check, when user 
clicks on Update Taxes button taxes calculated externally will be sent over to backend 
ERP to check the availability of funds. 

5. During requisition approval process, approver with appropriate edit authorizations may make 
changes. SAP Ariba makes tax calculation request to keep the tax amount up-to date based on 
changed requisition document. 

6. SAP Ariba received tax result from ONESOURCE Global Tax and updates requisition document. 
Taxes column at line item level shows the tax amount calculated by external tax engine.   
The tax amount hyper link and Details buttons will show more details on taxes. 

Click on Tax Amount hyper link or Details button to check details of tax amount. 

1ItemTotal Hide Details

No. ServiceItemTypeDescription Qty Unit Price Discount NetAmount ChargesTaxes Amount

Multi-
Purpose each $3,000.00 USD USD $3.000.00USDPhotocopier-

$247.50USD $3,247.50USD
3001PCA

SupplierPart#3001_PhotoCopier2

CommodityCode:Photocopiers
Material Group:00601(Office Machines)

Purch Org:3000(IDESUSA)

Vendor. 3001(IL Office Supplies)
Line ItemText:

Contact:ILOfficeSupplies
Payment Terms:0001

Actions UpdateTotal

1ltem Total Hide leals

TaxDetailsforLineItem1-Multi-PurposePhotocopier-3001PCA

TaxCode:A1,

TaxComponents

Name IsDeductible RateApplied On Amount

StateSales/Use No 6.25%USSG2:StandardSellercollectedusetaxappliesbecauseofsalefromoutsidejurisdiction.|9980lP$187.50USD

City Sales/Use No 1.0% USSG21:StandardSellercollectedusetaxappliesbecauseofsalefromoutsidejurisdiction.99811P$30.00USD

District Sales/UseNo 1.0% USSG21:StandardSellercollectedusetaxappliesbecauseofsalefromoutsidejurisdiction.j9981P$30.00USD

TaxAmount:$247.50USD

OK

ÿ
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Here user can see Tax Code A1 coming from ONESOURCE Global Tax for SAP Ariba Solutions. This is 
the SAP Tax Code configured in ONESOURCE Indirect Tax. In addition to SAP Tax Code, ONESOURCE 
Global Tax for SAP Ariba Solutions also provides the SAP Account Key as part of tax response.   

The SAP Account key is not visible on UI but would be part of purchase order export and payment 
request export messages. The SAP Tax Code and Account Key (AccounInstruction is new name for this 
message xml element from Integration version 1.0.2.0/higher). 

7. When requisition is finally approved, a Purchase Order is created automatically. In addition to other 
information, Tax information also gets copied over to Purchase Order. 

Purchase Order line item shows tax like Purchase Requisition under Taxes column. 

8. Click on Tax Amount hyperlink or Detail to check tax amount details. 

9. When Purchase Order is routed to Supplier or either available on Ariba Network, Supplier would ship 
goods or provide services. Buyer user upon receiving goods/services would create receipts as a 
general process/as applicable. Supplier can submit Invoice either on Ariba Network or an Invoice 

Summary Approval Flow Receipts Invoices Payments History

Order ID:PO424

Version:1

Title: Ariba Demo

Supplier:IL Office Supplies
Contact: IL Office Supplies

Close Order:Open

My Labels: Apply Label.

Line Items

1 Line Item Hide Details

Type ÿ ReqlD Qty Unit Description Supplier Part Number Price Discount  Net Amount ChargesTaxes Amount

Multi-

PR1319 each Purpose
Photocopier-3001_PhotoCopier2$3,000.00 USD $3,000.00 USD $247.50 USD$3,247.50 USD Detail
3001PCA

Tax Details for Line Item 1 - Multi-Purpose Photocopier-3001PCA

Tax Code:A1,

TaxComponents

Name Is Deductible  Rate Applied On Amount

StateSales/Use No 6.25% USSG2: Standard Seller collected use tax applies because of sale from outside jurisdiction.|9980|P$187.50 USD

City Sales/Use No 1.0% USSG21: Standard Seller collected use tax applies because of sale from outside jurisdiction.|9981|P$30.00 USD

District Sales/UseNo 1.0% USSG21: Standard Seller collected use tax applies because of sale from outside jurisdiction.|9981|P$30.00 USD

Tax Amount:$247.50 USD

OK
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agent may enter it in SAP Ariba Procurement Solution if it is a paper Invoice (Ariba allows different 
mediums and channels for submitting Invoices) 

10. During Invoice reconciliation process, SAP Ariba makes a tax call and exports information on Vendor 
Invoice. ONESOURCE Global Tax for SAP Ariba Solutions would perform tax calculation and 
responds back with expected tax rate, amount, tax authorities, the tax types and the tax code which is 
updated on Invoice Reconciliation line items. 

11. Navigate to Invoice Reconciliation > Line View > Line Items to view tax response from ONESOURCE 
Global Tax for SAP Ariba Solutions. 

Click on Tax Amount hyper link under Taxes column on Line Items table or Details hyperlink to check 
detailed tax information. 

IRAribaDemo-818

These are the details of the request you selected. Depending on its status, you can edit, change, copy, cancel, or submit the request for approval. You may also print the details of the request. Reviev

Force Pay Print

Exceptions Line View Approval Flow Reference History

IRAriba Demo-818

Invoice ID: INVAriba Demo-818
InvoiceFrom: IL OfficeSupplieson Sun,08Oct, 2017
Invoice Type: Purchase Order
Purchase Order(s): PO424

Header Information

HeaderTaxes,Charges,and Discount

Nameÿ Exceptions Type TaxableAmount Amount Accounting Details

No items

LineItems

No. Description ExceptionsOrder QtyUnit Price DiscountChargesTaxesÿ GrossAmount AccountingDetails

1 Multi-PurposePhotocopier-3001PCA PO424 1 each $3.000.00USD $247.50USD S3,247.50USD (1) Details

Details AccountingDetails Action
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Clicking on Details would open the Line item in a new page and shows Taxes details as below (scroll 
down the page to see tax details). 

User can see Tax Code A1, expected tax type, Tax Description, Expected Tax Rate, Tax Amount and 
other details 

12. If no validation errors and variance exceptions occur, Invoice Reconciliation would be successful. 
  

13. Reconciled Invoices generate Payment Export (OK2PAY) and interfaced to backend ERP system for 
Invoice posting and Financial Accounting update. The tax information provided by ONESOURCE 
Global Tax is captured on OKP2AY and used during Invoice posting in backend ERP system. 

INVOICE RECONCILIATION - TAX VARIANCE AND 
EXCEPTION HANDLING 
There may be tax variance between taxes charged by Supplier on Invoice with what has been calculated 
by ONESOURCE Global Tax for SAP Ariba Solutions. ONESOURCE tax calculation logic is complex and 
utilizes all possible and available information to determine the most accurate and appropriate taxes for a 
given scenario at any given time. 

There are three exceptions that may happen on Invoice Reconciliation document. 

HeaderTaxes,Chargesÿand Discount

Name ÿ Exceptions Type Taxable Amount Amount Accounting Delails

No items

Line Items

No. Description ExceptionsOrder Qty Unit Price Discount ChargesTaxesÿ Gross Amount AccountingDetails

Multi-Purpose Photocopier-3001PCA PO424 1 eachS3.000.00 USD S247.50USD S3,247.50 USD (1) Details

Details AccountingDetails Action

Taxes

TaxCode:A1 Taxes: $247.50 USD

Description

TaxType TaxDescriptionAccrual ÿReferenceDate Expected TaxRateTaxable Total Amount Expected TaxAmount

DistrictsalesorusetaxesnotappliedbypoliticalboundariesDistrictSales/Use Sun,08 Oct,20170% S3.000.00USD$30.00USD S30.00USD

Sales or use taxeslevied by a city City Sales/Use Sun,08 Oct,2017 0% S3.000.00USDS30.00USD S30.00USD

Salesoruse taxesleviedbyastate StateSales/Use Sun,08Oct,20170% $3.000.00USDS187.50USD S187.50USD Feedback
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Under Tax Variance Exception 
When Vendor Charged Tax, (VCT) amount is less than tax amount calculated by ONESOURCE Global 
Tax for SAP Ariba Solution, this results in under tax variance. 

Over-Tax Variance Exception 
When Vendor Charged Tax (VCT) amount is greater than tax amount calculated by ONESOURCE Global 
Tax for Ariba solution, this will result in Over-tax variance exception. Under tax and Over tax variances 
can be accepted or rejected by buyer users.   
Taxes are accrued when buyer users accept Tax amounts calculated by ONESOURCE Global Tax for 
Ariba solution charged Tax instead of Vendor Charged Tax when reconciling invoices with under tax 
variance exceptions. 

Handling the Under-Tax Variance or over tax variance exception is not impacted with the introduction of 
external tax calculation. Only difference here is instead of SAP Ariba Native tax solution, external tax 
provider ONESOUORCE provides expected tax details. The entire process of exception handling can be 
carried out as usual. 

Tax Calculation Failed Exception 
This exception is generated when there is a mismatch between Supplier provided tax type(s) and the tax 
calculated by ONESOURCE Global Tax for SAP Ariba Solutions. 

This exception cannot be accepted. Exception handlers who were added on Invoice Reconciliation 
document can verify if tax types selected by Supplier are invalid based on what has been proposed by 
ONESOURCE Global Tax for SAP Ariba Solutions. Invoice can be rejected with comments to Supplier 
requesting for replacement of wrong tax types with correct tax type on Ariba. 

Supplier can re-submit Invoice with correct tax types which is then handled using regular workflow where 
Invoice Reconciliation would make a tax call and if Supplier charged tax amount and selected tax types 
are correct, reconciliation would be successful. 

If exception handler finds that problem could be with ONESOURCE Global Tax for SAP Ariba Solutions, 
then first buyer user needs to contact ONESOURCE Indirect Tax Professional Services for resolving the 
issue. If problem exists with tax calculation service provider and issue has been fixed, exception handler 
can click on Recalculate Tax button to retrigger the tax call and get the tax response. 

INTEGRATION VERSION 2.0.0.0 
FUNCTIONALITY 
SAP Ariba enhanced Tax API or Ariba API2 is an improved integration solution which includes new 
functionalities and features on both SAP Ariba Buying and Invoicing solution as well as   ONESOURCE 
Global Tax for Ariba solution. This version also contains fixes for some of the existing bugs on earlier 
versions of the integration solution. The new enhancements on the integrated solutions includes 
enhancements on Tax Calculations, Invoice Reconciliation and OK2PAY integration with backend ERP. 
This new version will also support Direct Pay Permit feature as well as eliminate some of the customer 
pain points on tax type matching and tax type limitation on Ariba Network. 
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ONESOURCE Global Tax for SAP Ariba Solutions (Ariba Integration) through release 2.0.0.0 offers 
following new features: 

1. Tax Response with both summarized and granular tax data. 
2. Tax Response for US Scenario with Authority Types which matches Ariba tax types. 
3. Direct Pay Permit functionality. 
4. Support Tax Calculation Requests on SAP Ariba Line-Item Debit Memo, Line-item Credit Memo 

in addition to Purchase Requisitions and Standard Invoice documents. 
5. Support Second Tax Calculation Request on SAP Ariba Invoice Reconciliation documents 

(Standard Invoice, Line-item Credit Memo, Line-item Debit Memo). 
6. Audit Second Tax Calculation Request on SAP Ariba Invoice Reconciliation documents (Standard 

Invoice, Line-item Credit Memo, Line-item Debit Memo) for compliance and reporting purpose. 

CHANGES TO TAX CALCULATION REQUEST AND ARIBA 
TAX RESPONSE 
The SAP Ariba Cloud Buying and Invoicing solution with enhanced Tax API will make tax calculation 
request on Purchase Requisition, Standard Invoice, Line-item Debit Memo, Line-item Credit Memo 
documents unlike the previous versions which calculates taxes only on Purchase Requisition and 
Standard Invoice only. 
SAP Ariba also makes two types of tax calculation requests with enhanced Tax API. The xml element 
RequestType on the tax calculation request is useful to identify type of tax calculation request. 
Below tables shows the type of Ariba document, type of tax calculation requests and its purpose. 

Tax Call Request Type Ariba Purchase Requisition Ariba Invoice Reconciliation 
TaxCalculation X X 
ERPPosting Not Applicable X 

RequestType Purpose SAP Ariba Document Type 
TaxCalculation Calculation of tax 1. Purchase Requisition 

2. Standard Invoice   
3. Line-item Credit Memo 
4. Line-item Debit Memo 

ERPPosting posting instructions for 
OK2PAY 

1. Standard Invoice 
2. Line-item Credit Memo 
3. Line-item Debit Memo 
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PRE-REQUISITE FOR ONESOURCE GLOBAL TAX FOR SAP 
ARIBA SOLUTIONS 2.0.0.0 

Integration 
Deployment 
Model 

Prerequisite 

Cloud 1. Enable SAP Ariba Cloud Buying Solution with enhanced Tax API or Tax API2. 

2. Existing SAP Ariba Cloud Buying Customers accept Data Definition for new XSD 
part of enhanced Tax API or Tax API2. 

3. Subscribe to Ariba Integration version ONESOURCE Global Tax for SAP Ariba 
Solutions 2.0.0.0. 

4. Update SAP Ariba Cloud Buying Solution with the latest Endpoint for ONESOURCE 
Global Tax for SAP Ariba Solution 2.0.0.0. 

5. Refer 
“ConfigurationGuideONESOURCEGlobalTaxforSAPAribaSolutions_2000.docx” 
from Thomson Reuters and “Tax and Charge Configuration Guide” from SAP Ariba 
for more details. 

The latest version of SAP Ariba Cloud Buying Solution comes with enhanced Ariba Tax API and 
the Integration User will not 
new features of the enhanced API. However SAP Ariba Customers (Buying Organizations) who 

upgrade their realm with latest SAP Ariba releases/versions may need to accept the data 
definition changes to activate the new XSD that is part of the enhanced Tax API/Tax API2.    

Please check APPENDIXIII for steps to accept Data Definition changes in SAP Ariba Cloud 
Buying Solution. (This is also be available from SAP Ariba Product Documentation help portal).    
Check section UPDATE ENDPOINT to update Endpoint Configuration for latest Integration   
version. For any questions regarding data definition and enhanced Tax API, please reach out to   
SAP Ariba Customer Support/Customer Engagement Executive. 

TAX RESPONSE WITH SUMMARIZED AND GRANULAR TAX 
DATA 
Ariba Integration will respond to match the tax granularity on calculated taxes from ONESOURCE 
Determination/Tax engine to the granularity of taxes in the Vendor Charged Tax on Ariba Invoice. In 
transactions where SAP Ariba Invoice Reconciliation documents are submitted without Vendor Charged 
Tax, Ariba Integration will provide granular tax data by default from ONESOURCE Determination/tax 
engine. The tax response for SAP Ariba Purchase Requisition tax calculation requests will always have 
granular tax date as vendors do not provide any tax on Purchase Requisitions. 

When Vendor Charged Tax on Ariba Invoice is in summarized format (ex: SalesTax $10.00), Integration 
will provide tax response in Summarized format for Invoice reconciliation purpose in SAP Ariba Cloud 

  

be required to accept Data Definition changes to make use of the 
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Buying Solutions and in granular format (State Sales/Use $5.00 and City/Use 5$.00) for Buyer User’s 
verification purpose (to show what constitutes the SalesTax of $10.00) 

Illustration: 

Ariba Tax calculation request: 
SAP Ariba Tax Calculation Request for Invoice Reconciliation Document IR-Test-123 
Gross Amount $100.00 
Vendor Tax (Summarized format) SalesTax $10.00   

Ariba Tax Response:   
Summarized section and Granular section on Ariba tax response. 
(Illustrated figure in next page) 

LineItem 
item 

ExternalTaxItem 
item Summarized Format 

SalesTax $10.00 
TaxComponents Granular Format 

item State Sales/Use    $5.00 
item City Sales/Use       $2.00 
item County Sales/Use $2.00 
item District Sales/Use $1.00 

The illustrated figure is to help understand message structure with respect to Summarized and 
Granular tax data on the response. Ariba Tax Response will have more data in different models 
based on tax calculation request type and business scenario. Please check WSDL to see   
complete list of elements on request and response. 

Vendor can submit Invoice with tax charge in granular format i.e. sales tax of $10.00 can be entered by 
tax authority type in like State Sales/Use $5.00. City Sales/Use $5.00. When Vendor tax is in granular 
format, Ariba tax response will be granular. 

Illustration: 

Ariba Tax calculation request: 
SAP Ariba Tax Calculation Request for Invoice Reconciliation Document IR-Test-123 
Gross Amount $100.00 
Vendor Tax (Granular format):   

State Sales/Use $5.00 
City Sales/Use $5.00 

  
Ariba Tax Response: 
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The item under ExternalTaxItem will show tax data in Granular format. SAP Ariba system will use this 
section for Invoice Reconciliation purpose. TaxComponents will not have any data as tax data under 
ExternalTaxItem is already in granular format.   
(Illustrated figure in next page) 
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LineItem 
item 

ExternalTaxItem 
item Granular 

Format item State Sales/Use      $5.00 
TaxComponents 
<No Items> 
item City Sales/Use        $2.00 
TaxComponents 
<No Items> 
item County Sales/Use   $2.00 
TaxComponents 
<No Items> 
item District Sales/Use   $1.00 
TaxComponents 
<No Items> 

The illustrated figure is just to provide understanding on how granular response will look like. 
Ariba Tax Response will have more data in different models based on tax calculation request 
type and business scenario. Please check WSDL to see complete list of elements on request 

and response. 
  

TAX RESPONSE WITH ARIBA TAX TYPES 
Ariba Integration version 2.0.0.0 (ONESOURCE Global Tax for SAP Ariba Solutions) with enhanced 
functionality reduces complexity associated with Ariba types vs. Determination tax authority types. 

For easy understanding this feature is presented here with some important Use Cases. 

Use Case 1: Ariba out of box tax type “SalesTax”/ “SUTTax” on Ariba tax 
response 
Suppliers/Vendors in U.S. usually choose Ariba out of the box summarized tax type “SalesTax” to charge 
U.S. Sales and Use Tax instead of granular tax authority types like State Sales/Use and City Sales/Use 
tax. With Integration version 2.0.0.0, tax response will contain Ariba out of the box tax type “SalesTax”/ 
”SUTTax” (under ExternalTaxType on response xml) instead of Determination Authority type.   

The Ariba tax type may vary based on ERP Variant used in SAP Ariba Cloud Procurement system. 
For this use case, Integration will contain same Ariba tax type that is seen on Ariba tax calculation request 
so irrespective of ERP variant and corresponding Ariba tax type, tax response will have matching 
summarized Ariba out of the box tax type. 
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Illustration: 
1. If tax calculation request from SAP Ariba has “SalesTax” (Ariba tax for Vendor tax), response 

from Integration will have “SalesTax” as ExternalTaxType. 
2. If tax calculation request from SAP Ariba has “SUTTax” (Ariba tax type for Vendor tax), response 

from Integration will have “SUTTax” as ExternalTaxTye. 

Use Case 2: Purchase Requisition and Non-U.S. Invoice Reconciliation 
Documents   
SAP Ariba Purchase Requisition would not have Vendor tax and hence Ariba Tax Response for tax 
calculation requests from Ariba Purchase Requisition documents will have ONESOURCE Determination 
Authority types as tax types.   

The tax response for tax calculation requests on Invoice Reconciliation Documents with non-U.S. taxable 
countries (ex: VAT, GST) Integration will have Determination tax authority types (VAT, GST, PST, HST) 
as ExternalTaxType for tax type matching in Ariba. 

Illustration: 
1. ExternalTaxType on the Integration tax response for a tax call on Purchase Requisition: 

a. U.S. Scenario – State Sales/Use Tax; City Sales/Use Tax 
b. DE/GB Scenario – VAT 
c. CA Scenario – GST, PST 

Use Case 3: Ariba out of the box tax type “vat” for Determination Country specific 
Tax Authority types (TVA, IVA, MWST) 
Ariba standard tax type for VAT is “vat” and it is used for most of the VAT or VAT like Countries. But 
Determination has country specific authority types like MWST for Switzerland, IVA for Mexico, TVA for 
France. To prevent the tax type mismatch between “vat” on Ariba Invoice vs MWST, TVA, IVA from 
Determination, Integration provides a workaround using Determination Tax Code Qualifier Configuration 
where Ariba tax type can be entered on ERP Tax Code which then can be mapped to ExternalTaxType 
on response. This feature will be continued with release 2.0.0.0. 

Illustration: 
1. For France Domestic transaction, on tax calculation response, Integration will send “TVA” 

(Determination tax authority) as ExternalTaxType by default.   
2. But if User configures out of the box Ariba Tax Types on Determination Tax Code Qualifier (on 

FR ERP Tax Codes) with Ariba tax type “vat”, Integration will send “vat” as ExternalTaxType. 

Ariba tax types configured on ERP Tax Codes in Determination Tax Code Qualifier will take 
precedence over the standard Determination authority tax types when populating 
ExternalTaxType (used for tax type matching in Ariba) on response.   
Please see Tax Code Qualifier Based Ariba Tax Type functionality for more details. 

Advantages of Ariba Tax Types in Tax Response 
1. Reduce tax type mismatch between Ariba tax types and ONESOURCE Determination Tax Authority 

types during Invoice Reconciliation process. This will save procurement/AP/Tax users time for more 
strategic work. 
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2. This feature will also eliminate the need for maintenance of Ariba tax type files (TaxType.csv and 
TaxTypeMap.csv) with numerical designators on Ariba Procurement solution. Examples include State 
Sales.Use_1, State Sales.Use_2, State Sales.Use_3, State Sales.Use_4 etc. 

DIRECT PAY PERMIT INDICATOR 
Some Businesses (usually Manufacturing entities) may obtain Direct Pay Permit from State/Local tax 
authorities to self-assess, accrue and remit Use tax on Purchases instead of paying Sales tax to 
Suppliers/Vendors. 
SAP Ariba Cloud Buying Solution with enhanced Tax API or Tax API2 offers Direct Pay Permit exception 
with the help of Ariba Integration (ONESOURCE Global Tax for SAP Ariba Solutions). 

Process 
1. Integration user configures Direct Pay Permit using Determination Exemption Certificate feature. 
2. Ariba Integration sets “IsBuyerPayableTax” flag as “true” on Ariba Tax Response when purchase 

transaction scenario contains Organization Unit/Company Code and Tax Authority combination which 
are maintained in Determination Exemption Certificate configuration. 

3. SAP Ariba system raises an Invoice exception on line items where Vendor charges sales tax but 
Integration identifies the location and tax authority as Direct Pay Permit locations and therefore 
should be vendor tax exempt. 

4. SAP Ariba system Buyer user (who is part of exception handling process chain) may dispute Invoice 
Amount so that zero tax amount is paid to Vendor (Payable to vendor do not contain vendor charged 
tax). 

5. Buyer Organization accrue the consumer use tax and remits the tax to appropriate tax authorities 
directly. 

Required Configuration 
1. Configure Direct Pay Permit location(s) and Tax Authorities in Determination using Exemption 

Certificate Functionality. 

For a specific Determination Company:   
a. Create new Customer with the same name as the Determination Company 
b. Create Customer Number equal to the External Company ID associated with that Company 

for which Direct Pay Permit is being configured. 
c. Create an exemption certificate for new customer with the following attributes: 

Field Value 
Number Permit Number 
Valid From (Today’s Date) 
Active (Checked) 
Status Approved 
Exempt Reason Direct Pay Permit 
Applied To Choose the appropriate State 
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d. Create exemption reason with the following values: 

Field Value 
Long Code Direct Pay Permit 
Short Code DP 
Description Direct Pay Permit 

Do not check the Fully Exempt Box. Determination do not exempt any percentage of amount 
from calculated tax amount. Certificate functionality is used to identify a transaction with Direct 
Pay locations. The Determination response (LINE.TAX.EXEMPT_REASON) will 
show Direct Pay as exempt reason based on which Integration would flag 

IsBuyerPayableTax as true. This will help SAP Ariba Cloud Buying System to raise an exception if Vendor 
charges tax on an           Invoice with Direct Pay location. 

Please refer Determination Exemption Certificate help topic for more information. 

Enable required SAP Ariba system parameters and configure Invoice exception for Direct Pay Permit 
exception (link). 

a. Parameter Application.Invoicing.DisallowAcceptOnExceptionTypes should be configured 
for Buyer Payable Tax Invoice exception to disallow using the accept button on IR 
exceptions. If empty, accept action is allowed. When configured with an exception type, 
system would not allow accept on that exception type. 

b. Activate and Configure Buyer Payable Tax Invoice Exception Type as suggested in SAP 
Ariba Product Guide “Tax and Charge Configuration”. 

  
1. SAP Ariba Customer Support may help maintain the required Parameters and provide 

advice on new Invoice exception type.   
2. SAP Ariba User with Customer Administrator Group membership or Invoice  

Administrator, Invoice Manager Group membership can maintain (activate and configure)    
Invoice exception types. 

TAX CALCULATION REQUEST ON ARIBA CREDIT MEMO 
AND DEBIT MEMO DOCUMENTS 

SAP Ariba will make tax calculation requests on Line-item Debit Memo, Line-item Credit Memo 
documents in addition to standard Invoice. The document type for all the documents is Invoice 
Reconciliation.   

With SAP Ariba Tax API2 and Ariba Integration version 1.0.3.x when we say tax calculation request 
on Invoice Reconciliation document it is assumed that it is being referred to tax calculation request on 
standard Invoice, Line-item Debit Memo, Line-item Credit Memo.   

SAP Ariba tax calculation request and Tax Response xml message model for Line-item Debit Memo 
and Line-item Credit Memo will be like request and response xml message model for standard 
Invoice Document.   

ÿ
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SECOND TAX CALCULATION REQUEST 
This tax calculation request is referred with different names as it serves different purposes.   

• Second Call: Ariba makes this call after first tax calculation request and hence the name Second 
call/Second tax calculation request. 

• ERPPosting Request: Ariba uses the tax response as source of backend ERP account posting 
Instructions. 

• Audit Call: The second tax calculation request or ERP Posting call is audited in ONESOURCE 
Determination and so it is also referred as Audit Call. 

AUDIT 
PROCESS OVERVIEW 
ONESOURCE Global Tax for SAP Ariba Solutions audits Ariba tax transactions in addition to determining 
and calculating the taxes. This feature will enable users, who are already using tax calculation service to 
capture all SAP Ariba Invoice Reconciliation transactions to ONESOURCE Indirect Tax Determination 
audit data base for Reporting and Compliance purposes. 
With Ariba’s enhanced Tax API and ONESOURCE Global Tax 2.0.0.0 version audit process will be 
automatic unlike the earlier version. SAP Ariba makes second tax calculation request to ONESOURCE 
Global Tax on reconciled Invoices which are ready for invoicing in backend ERP system. 

ONESOURCE Global Tax audits tax calculation requests on SAP Ariba Invoice Reconciliation (standard 
Invoice, line level credit memo, line level debit memo) documents. Tax calculation requests on SAP Ariba 
Purchase Requisition will not be audited. 

PROCESS FLOW 
• SAP Ariba Cloud Buying Solution makes tax calculation request on Invoice Reconciliation 

Documents (request type at message level is TaxCalculation) including standard Invoice, Line-
item Debit Memo, Line-item Credit Memos. 

• ONESOURCE Global Tax provide tax calculation results and SAP Ariba updates tax results on 
documents and completes the reconciliation process. 

• When Invoice gets reconciled, SAP Ariba makes second tax calculation request (at message 
level request type is ERPPosting). This request is also known as Audit call. 

• SAP Ariba request includes Vendor tax amount (xml element OriginalSupplierAmount) and total 
tax (xml element FinalAmount) on IR document which tells Integration that if any tax is being 
accrued (during Invoice reconciliation to handle tax variance exception(s)). 

• ONESOURCE Global Tax forwards the request to Determination. For this Ariba request, 
Integration identifies tax accruals if any and makes the call to Determination accordingly to get 
appropriate tax rate, ERP Posting Key for vendor tax portion and consumer use tax portion of the 
tax from ONSOURCE Determination. 

• ONESOURCE Determination calculates taxes for ERPPosting request, saves the transaction to 
audit database and concurrently SAP Ariba receives the tax response.    
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o All tax transactions from SAP Ariba (documents with no tax accrual, partial tax accrual, 
total tax accrual) will be saved to Determination Audit database. 

o In case of Partial Tax Accrual scenario (Buyer accrues the difference between Vendor tax 
amount on Ariba Invoice and Determination calculated tax amount). 

• When Ariba receives a response for Audit calculation request, Invoice Reconciliation Document 
status changes to Paying (Please note that IR document status are configurable in SAP Ariba 
Cloud Buying Solutions). 

ONESOURCE Global Tax version 1.0.3.x allows multiple tax calculation requests on same SAP 
Ariba document. ONESOURCE Determination audit updates audit database with latest tax 
transactions so that the most current and unique transaction data is available for reporting. 

MULTIPLE AUDIT TAX CALCULATION REQUESTS 
• OK2PAY/Payment Request will have some of the tax calculation information like ERP Posting 

Key (AccounInstruction), Tax Code, Rate, Amount etc. from ONESOUR0CE Global Tax tax 
response for the second call. 

• For any reason, if OK2PAY interface to backend ERP system fails, SAP Ariba makes another 
ERPPosting call to ONESOURCE Global Tax. 

• ONESOURCE Global Tax allows multiple tax calculation requests on same SAP Ariba document. 
Determination will calculate tax, save transaction to audit database and send response to SAP 
Ariba system. 

• ONESOURCE Determination keeps the latest transaction data by cancelling the earlier 
transaction data for the same SAP Ariba document. 

• Tax calculation requests on SAP Ariba line level credit memo documents will also be handled by 
Determination audit like tax calculation/audit process on standard Invoice/Invoice Reconciliation 
Document. 

• Transaction data saved to ONESOURCE Determination Audit data base can be accessed 
through standard ONESOURCE Determination Audit Reports (please refer ONESOURCE 
Determination documentation to learn about standard Audit reports). 

USE TAX ACCRUAL AND AUDIT 
• The tax calculation on Invoice Reconciliation Documents (standard, line-item credit memo, line-

item debit memo) may result in tax variance. SAP Ariba (when tolerances, parameters and 
workflow are setup) will raise tax variance exception.   

• SAP Ariba Buyer user responsible for Invoice Reconciliation exception handling may accept 
either the vendor tax amount on Invoice or the external tax engine amount. 

• After IR document reconciliation, SAP Ariba makes second call/ERPPosting call and 
ONESOURCE Global Tax will calculate tax, save tax transaction to audit database and send tax 
response to SAP Ariba system. 

• SAP Ariba Buyer User’s decision (exception handling) may result in total tax accrual, partial tax 
accrual (difference between Vendor tax and Determination calculated tax is accrued), no tax 
accrual. 

  



Error Handling 27 

End-Point Configuration 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

• In case of partial tax accrual, ONESOURCE Global Tax Ariba tax response will contain tax blocks 
for both Vendor tax and User tax accrual with appropriate ERP Posting Key (xml message 
element is AccountInstructions) and flag to denote if tax is accrued or not (xml message element 
IsAccrual)   

o IsAccrual will be true for use tax accrual portion and false for Vendor tax portion of the 
total tax amount 

o ERPPosting key will be selected for Vendor tax portion and Use tax accrual portion from 
Determination Tax Code Qualifier. 

• SAP Ariba will include ERP Posting Key (AccounInstructions) and accrual indicator (Yes/No) on 
OK2PAY/Payment Export which is used for Invoice posting in backend ERP system. 

ERROR HANDLING 
Errors may occur during tax calculation process in ONESOURCE Global Tax for SAP Ariba Solutions for 
any reasons like missing master data or configuration. In case of multiple errors, ONESOURCE Global 
Tax will return the error with higher severity to Ariba Solution. 

ONESOURCE Global Tax version 1.0.2.0 and higher will provide access to transaction logs using User 
Interface. Transaction logs (request from SAP Ariba system, request to ONESOURCE Determination, 
response from ONESOURCE Determination, response to SAP Ariba) in xml format. These xml logs can 
be utilized as part of troubleshooting process. 

To learn about how logs can be configured and accessed, please see refer Transaction Logging and 
XMLs Log enablement sections. 

Customers can refer Support Protocol mentioned in this document for help on troubleshooting and 
resolution of the errors. 

CONFIGURATION SET UP - ARIBA 
END-POINT CONFIGURATION 
SAP ARIBA Procurement Solution uses a web services channel with SOAP protocol to send requests and 
receive responses from ONESOURCE Global Tax for SAP Ariba Solutions tax calculation service. 

SAP ARIBA Procurement Solution’s SOAP web services include integration tasks which require End-point 
to request and receive response through logical communication channels. End-point consists of URL and 
an authentication process which controls the access to that End-point. End-points can be of type inbound 
or outbound. Here we need outbound End-points to make tax calls to ONESOURCE Global Tax for SAP 
Ariba Solutions.   SAP Ariba initiates the call using outbound End-point. 

Users with roles/authorization groups Customer Administrator/Integration Administrator can be 
able to configure End-point.   

The following steps with screenshots from SAP Ariba Procurement Solution explain 
configuration process: 
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1. Log in to SAP Ariba Solution (SAP Ariba Buying and Invoicing, SAP Ariba Buying, SAP Ariba 
Invoice Management) 

2. On the SAP Ariba Spend Management dash board navigate to Manage > Core Administration 

HOME PROCUREMENT INVOICING CATALOG MORE... Recent- Manage Create T

Administration Purchase Orders

Payment Payment ID ERP Payment # Supplier Invoice # Purchas Approval Processes Queues

Contracts Receive

Common Actions
To Do Core Administration Reconcile Charges

Create My Tasks Reconcile Invoice

Requisition ID ÿ Date From Status
My To Do Report Search Filters

Analytical Report No items
Payments Supplier Knowledge

Supplier
Personal Workspace Unassigned Charges

Customer My Documents
More Prepackaged Reports

ID Title Date ÿ
Manage Public Reports
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3. SAP Ariba system opens a panel on left side of the home screen 

4. Click on End-Point Configuration link found under Integration Manager.   

5. Click on Create New button to create an End-Point.   

HOME PROCUREMENT INVOICING ADMINISTRATION

Recent Manage Create 
MORE...

Integration Manager
Site Manager
Data Import/Export

Audit Log

Integration Manager Data Import/Export Data Definition

Data Import/Export
Import and export data. View status, details, errors, and Review and accept changes to the data definition in

Data Definition the history of past data imports and exports. integration events.
Integration Configuration

Integration Configuration End Point ConfigurationEnd Point Configuration

Integration Toolkit Security Search, edit, activate or deactivate data import/export Configure external systems connection information.
Master Data Default Values tasks. Search fields are case-insensitive and you can enter

HOME PROCUREMENT INVOICING ADMINISTRATION

Recent Manage Create 
MORE...

Integration Manager
Site Manager

Data Import/Export
s   g n    o  e n n n Audit Log

Integration Manager Data Import/Export Data Definition
Data Import/Export

Import and export data. View status, details, errors, and Review and accept changes to the data definition in
Data Definition the history of past data imports and exports. integration events.
Integration Configuration

End Point Configuration Integration Configuration EndPointConfiguration

Integration Toolkit Security Search, edit, activate or deactivate data import/export Configure external systems connection information.

Master Data Default Values tasks. Search fields are case-insensitive and you can enter
all or part of a name.
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6. The user interface Create End-Point has three sections   
i. General,   
ii. Web Services Security,   
iii. HTTP Authentication. 

SAP Ariba System offers user interface to enter End-point URL, set up authentication method and 
to enter credentials. 

7. Maintain End-Point Name, Type and Address: 

Under section General > 

1. Enter a desired Name for End-point in input field Name ex: IndirectTax_ONESOURCE 
2. Select Outbound radio button for type of End-point 

When End-point type Outbound is selected, system will display a URL field >    
  
Enter URL for the End-point on the target system (ONESOURCE Global Tax for SAP Ariba 
Solutions) 

HOME PROCUREMENT CATALOG ( ADMINISTRATION MORE... Recent Manage Create -

EndPointConfiguration
Site Manager
Data Import/Export

Audit Log Search for existing end points or create new end points. Search fields are case-insensitive and you can enter all or part of a name.

Integration Manager
Data Import/Export Search Filters: Add/Remove Search Filters

Data Definition End Point:
Integration Configuration

End Point Configuration Type: No Choice Inbound  Outbound Search List All
Integration Toolkit Security
Master Data Default Values

Master Data Manager
Name Type

Customization Manager No items

User Manager Create New

End Point Configuration-Create End Point Save Cancel
1.entera desired

name

General

Configure inbound and outbound integration end points. Optionally define a/Neb Services Security certificate and/or the HTTP authentication credential to use to secure theMore

2.selectradiobutton
Name. IndirectTax ONESOURCE forOutbound

3. enter URL for
Type. Inbound Outbound

end point

URL: * https://int-ariba-uat.hostedtax.thomsonreuters.com/ExternalTRTaxService/TaxService
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Thomson Reuters ONESOURCE Indirect Tax Professional Services would provide the End-
point address (URL) for your test and production System set up during implementation process. 

8. Scroll down the page to HTTP section to maintain credentials for HTTP Authentication 

1. Enter User ID in Login field and Password in Password and Verify Password fields 

2. Click on Save button to save the changes and to create the End-point. 

The log in credentials that would be required here are same as log in credentials used for 
accessing ONESOURCE Determination system with “Source System” role. 

9. To verify the End-Point created on End-Point Configuration screen: 

1. enter name of the End-point created in End-Point input field > select Type as Outbound > 
click on Search 

2. System would display End-Point created as shown below: 

End Point Configuration 

Search for existing end points or create new end points Search fields are case-insensitive and you can enter all or part of a name. 

Search Filters: 

Name 

lndirectT ax 

HTTP Authentication 

End Point lndireclTax 

Type No Choice 

Type 

Outbound 

Add/Remove Search Fillers 

Inbound OutboundOutbound 
List All 

Edit 

Specify HTTP authentication credential. Passwords are case-sensitive, and must be between 12 and 16 characters long. They can include any Latin characters and punctuation More 

Login· anbadev 

Password 

Veri fy Password: 

1. enter log in 
credentials 

Cancel 

ÿ
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ENABLE WEB SERVICE INTEGRATION 
By enabling integration task, we link End-point to the integration task. Here the Integration Task Export 
Document Data to External Tax Calculation would be linked to the End-Point created in earlier step. 

1. Navigate to Manage > Core Administrator > Integration Manager > click on Integration 
Configuration option 

2. Click on List All to list all Integration tasks   
Or, 
Select Format: Web Service, 
Select End-Point: (End-point name created in Configure End-Point Step)    

3. Choose Status: Disabled > click on Search button. 

4. System would display the integration task Export Document Data for External Tax Calculation 

5. Click on Actions button > Click on option Enable 

6. Now choose the Status Enabled under Search Filters section and click Search to confirm the End-
point activated. 

Search Filters:

Task Name:

Format: Web Service

End Point: IndirectTax

Status: Enabled Disabled Search List All

Configuration

Tasks ÿ Format Enabled Supported Formats

Export Document Data for External Tax Calculation
Web

Exports data on approvable documents (such as requisitions and invoice NoService [Web Service] Actions
reconciliations) to the external system for calculation of tax. 1IP3

Enable 

Disable
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Now, we have created End-Point, activated it and linked it to Integration task which sends the data to 
ONESOURCE Global Tax for SAP Ariba Solutions. 

DATA IMPORT/EXPORT TASKS 
ONESOURCE Global Tax for SAP Ariba Solutions require following Import tasks to be maintained to 
calculate taxes accurately. These import tasks enable importing master data utilized during tax 
calculation. 

EXTERNAL TAX CALCULATION PROVIDER 
This task is useful to control the combination of SAP ECC Company Code and SAP Ariba Procurement 
approvable (Purchase Requisition, Invoice Reconciliation) for which Buyer Organization would like to get 
the tax calculation function by using 3rd party vendor in this case Thomson Reuter’s ONESOURCE Global 
Tax for SAP Ariba Solutions.   

Search Filters:

Task Name:

Format: WebService

End Point: IndirectTax

Status: Enabled Disabled Search List All

Configuration

Tasks ÿ Format Enabled Supported Formats

No items

Search Filters:

Task Name:

Format: Web Service

End Point: IndirectTax

Status: Enabled Disabled Search List All

Configuration click on the task name link

Tasks ÿ Format Enabled Supported Formats

Export Document Data for External Tax Calculation Web
Exports data on approvable documents (such as requisitions and invoice YesService [Web Service] Actions
reconciliations) to the external system for calculation of tax.
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The file structure is as follows: 

• Field COMPANYCODE is SAP ECC Company Code (organizational unit) 
• Field TAXSOURCE is always ThomsonReuters for utilizing tax calculation service from 

ONESOURCE Global Tax for SAP Ariba Solutions.   
• Field APPROVABLENAME can have two values ariba.purchasing.core.Requisition which is 

SAP Ariba Procurement Document type for Purchase Requisition and 
ariba.invoicing.core.InvoiceReconciliation which is Invoice Reconciliation document. This 
allows enablement of tax calculations either for one process (requisition or invoice) or for both. 

Thomson Reuter’s ONESOURCE Indirect Tax Professional Services can assist with providing 
sample CSV import file.   

Import data in to SAP Ariba Procurement Solution like other master data imports which is also explained 
here as follows: 

Import Procedure: 

1. On the SAP Ariba Spend Management Dash board click > Manage > Core Administration 
2. System would display a panel on left side of the Home Screen with work space option Integration 

Manager 

The task Import External Tax Calculation Providers cans also be found > Site Manager > Data 
Import/Export. 

3. Click the expansion arrow for Integration Manager > Click on Data Import/Export option 
4. Find the task you want to enable. Select List All or enter search criteria and click Search 

UTF-8ÿ1
COMPANYCODE,TAXSOURCE,APPROVABLENAME

430o,ThomsonReuters,ariba.invoicing.core.InvoiceReconciliation

20oo,ThomsonReuters,ariba.invoicing.core.InvoiceReconciliation

10oo,ThomsonReuters,ariba.invoicing.core.InvoiceReconciliation

2200,ThomsonReuters,ariba.invoicing.core.InvoiceReconciliation

30oo,ThomsonReuters,ariba.invoicing.core.InvoiceReconciliation

430o,ThomsonReuters,ariba.purchasing.core.Reguisition

20oo,ThomsonReuters,ariba.purchasing.core.Reguisition

10oo,ThomsonReuters,ariba.purchasing.core.Reguisition

2200,ThomsonReuters,ariba.purchasing.core.Reguisition

30oo,ThomsonReuters,ariba.purchasing.core.Requisition
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Data Import/Export Tasks 
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5. Click on Import button to open the user interface for importing the data 

6. By default, the import operation type Load is selected > Click on Browse button to find the 
TaxCalculationProviderExport.csv file on user’s computer system > click Run to import the file. 

Data Import/Export

Exclamation marks (l) indicate tasks that completed with errors or warnings. Refresh the screen to show current status.

Download Data Dictionary
1. Enter search term to find an Import

Task (not case sensitive)

Search Filters:

Task Name: tax Search List All

2. Click Search
Import Export Web Service Status button

3. System would display
Import relevant Import Tasks here U Refresh Status

Tasks Integration Toolkit Namesÿÿ  Status Last Imported

Completed08/14/2017
Import Tax Codes 05:45:05 PM Import 

Import Company Code Tax Registration Completed08/14/2017
11:21:09 AM Import Numbers

Import Purchase Orqanization to Supplier 08/14/2017

Search Filters:

Task Name: tax Search List All

Import Web Service Status

Import URefreshStatus

Tasks Integration Toolkit Names ÿStatus Last Imported

Completed 08/14/2017
Import Tax Codes Click on Import button 05:45:05 PM Import

Import Company Code Tax Registration for the task being mnleted 08/14/2017
imported 11:21:09 AM ImportNumbers

Import External Tax Calculation Providers
Completed08/11/2017

05:58:20 PM Import
Import Supplier Tax Registration Numbers

Completed 07/11/2017
05:12:48 PM Import 

Completed01/25/2017
Import Tax Types Import07:51:09 PM
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Data Import/Export Tasks 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

7. Click OK to confirm the data import. 

Data Import for Task "lmport External Tax Calculation Providers"

Choose the operation you want to perform. Browse or specify the file where you want to import the data.

1.Choose type of import operation
ex: for initial load choose Create

Select Import Operation: operation

Load

Create

modified.

Update Only

database, it is not created. If you do not want to modify a particular object, do not include it in the data file. This operation can cause
deactivated objects to be reactivated.

Deactivate

Deactivates objects in the database based on objects in the data file. If you do not want to deactivate a particular object, do not
include it in the data file.

2. locate csv data file
on your system

Enter the location of the TaxCalculationProvider.csv file:

Tax Import Files\IMPORT FILES\TaxCalculationProvider.csvBrowse.

Run Cancel

3. Click on Run button to
execute the import 

operation

Create

modified.

Update Only
Modifies existing objects only in the database using values in the data file. If an object in the data file does not already exist in the

deactivated objects to be reactivated.

Deactivate

Deactivates objects in the database based on objects in the data file. lf you do not want to deactivate a particular object, do not
include it in the data file.

Enter the loc
Confirm Data Import

Are you sure you want to run Import Tax Types?

OK Cancel

Run
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7. System would return to Data Import/Export user interface screen and shows the status > Import > 
Status as Completed. Please click on Refresh Status if Status showed as Processing until Status 
becomes Completed. 

In case of errors, Status column under Import table will be shown as below: 

8. Click on Completed hyper link to view the error, description and history 

Search Filters:

Task Name: tax Search List All

Import Export Web Service Status

Import U Refresh Status

Tasks Integration Toolkit NamesStatus Last Imported

08/14/2017Import Tax Codes Completed 05:45:05 PM Import

Import Company Code Tax 08/14/2017Completed 11:21:09 AM ImportReaistration Numbers 
Import External Tax Calculation Completed 08/11/2017

ImportProviders 05:58:20 PM
Import Supplier Tax Registration Completed 07/11/2017

05:12:48 PM ImportNumbers

Completed 01/25/2017
Import Tax Types? 07:51:09 PM Import

Status

Completed ()
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Data Import/Export Tasks 
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CONFIGURATION GUIDE 

9. Click on Error Details to view the detail description of error and where the error has occurred. 

  

Details of the data import or export, including any errors that occurred, and the history of past data imports and exports are displayed below.

Details Error Details History

Process Start Date:12/08/201605:45:31PM

Last Processed: 12/08/201605:45:31PM

Status: Completed (!)

Records created:2

Records updated:0

Records deleted: 0

Records exported:D

Client Type:
Client Version:

ClientInformatic

Details Error Details History

61155282

Date: 12/08/2016 05:45:31 PM
Hide Details

Error Items

Item ID ÿSeverityFile Name Line Number  Error Message Other Addresses

Invalid field name SystemCommodityCode. Specify a field name that has
been used in the tax code lookup.
Invalid line item type for field name SystemCommodityCode.
Invalid dotted field path for field name SystemCommodityCode. Provide a
dotted field path that is valid for the specified line item type.
Error executing trigger IntegrationPostCreate on
[ariba.tax.core.TaxCodeLookupFieldMapping [Baseld 2765676267708

Error AE+ljuQoPvJsi8 zaj88pto.2g9qys0]] with data {
DottedFieldPath = "File ITaxCodeLookupFieldMap.csv" (line 13, column
DottedFieldPath): 'Description.CommonCommodityCode"
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TAX TYPES 
SAP Ariba Procurement Solution offers standard tax types by default but when Buying Organization 
enables their legal entities/SAP Company Codes to calculate taxes using ONESOURCE Global Tax for 
SAP Ariba Solutions, they need to maintain a comprehensive list of Tax Types provided by ONESOURCE 
Indirect Tax Professional Services. The list covers tax types on global level to ensure comprehensive tax 
regime coverage to provide error free tax results. Buyer Organization can maintain this TaxType.csv in 
addition to default tax types available in SAP Ariba Procurement Solution. 

The sample TaxType.csv file will be as follows: 

The CSV file has fields UniqueName which is the Tax Type name that can be recognized uniquely. The 
column Name can be same name as UniqueName or a descriptive name. The column Category has 
SAP Ariba standard values like 2 ore 64. 2 denote Indirect Tax and 64 denote Withholding Tax. Here 2 is 
a fixed value that needs to be repeated for all Indirect tax types. 

The columns/data description of Tax Type import task is as follows: 

Field Required Description Sample Value 

Unique Name Yes String. References unique Name of Tax Type 
defined in SAP Ariba Procurement Solution VAT 

Name Yes Multilingual String. This is displayed on UI Value Added 
Tax 

Category Yes Integer. The category of the Tax Type 
2 is for Indirect Tax and 64 is for Withholding Tax 2 

TaxType.csv

12345
UTF-8,

UniqueName,Name,Category
CBT,China Business Tax,2
COF,COFINS,2
CST,Central Sales Tax,2
CSU,County Sales/Use Tax,2

7 DPH,Dan z pridane hodnoty,2
ÿ EXC,Excise Tax,2
9 GCT,General Consumption Tax,2
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The import tasks related to Tax are found under Site Manager Workspace. The navigation to the Data 
Import/Export task is as follows: 

1. Ariba Spend Management > Manage > Core Administration > Site Manager > Data Import/Export 

2. Select import operation type Create, select the CSV file from the system and click on execute button 
as shown below 

Data Import/Export

Exclamation marks (l) indicate tasks that completed with errors or warnings. Refresh the screen to show current status.

DownloadDataDictionary

2. Click Search
Search Filters:

Task Name: tax type Search List All

1. enter search text
here

Import Web Service Status

3. syetm would 4. Click
Import display related tasks URefreshStatus

Tasks ÿ Integration Toolkit NamesStatus Last Imported

Import Tax Type Translations Import

Import Tax Types Completed 06/23/2017 11:27:37 AM Import
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3. System takes user to the Import UI screen and show the status which can be in progress or 
completed. If the status is in progress, click on Refresh Status to see the latest one. Status column 
and Task being imported shows the status and time stamp. 

  

Data Import for Task "lmport Tax Types"

Choose the operation you want to perform. Browse or specify the file where you want to import the data.

1. Choose type of import
operation.Ex:here choose
Create for Tax Types initial

Select Import Operation: load

Load

Create

Creates new objects in the database using values in the data file. If an object in the data file already exists in the database, it is not
modlified.

Update Only
Modifies existing objects only in the database using values in the data file. If an object in the data file does not already exist in the
database, it is not created. If you do not want to modify a particular object, do not include it in the data file. This operation can cause
deactivated objects to bereactivated.

Deactivate
Deactivates objects in the database based on objects in the data file. If you do not want to deactivate a particular object, do not
include it in the data file.

2. Locate the import
 file on your system

Enter the location of the TaxType.csv file:

oort FileslMPORT FILES\TaxTypeMaster Files\TaxType.csvBrowse.

Run Cancel

3. Click on Run button to
execute the import operation
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TaxType.csv file that need to be imported in to SAP Ariba Buying Solutions can be found as an 
attachment with the KB Article found on Customer Platform Support at: 
https://tax.thomsonreuters.com/support/onesource/indirect-tax/?search=000039826 

TAX TYPE MAP 
The Tax Type Map import task maintains the mapping between the normal Tax Types entered on 
Supplier Invoice with Tax Types defined in SAP Ariba Procurement Solution.   

The sample TaxTypeMap.csv data file is as follows: 

SAP Ariba Procurement Solution by default maintains mapping for standard tax types but when Buyer 
Organization intend to use Thomson Reuter’s ONESOURCE Global Tax for SAP Ariba Solutions for tax 
calculation service, it is required to maintain a comprehensive list of tax types recommended by Thomson 
Reuters ONESOURCE Indirect Tax Professional Services. 

Search Filters:

Task Name.tax Search List All

Import Export Web Service Status

Import U Refresh Statu

Tasks Integration Toolkit Names Status Last Imported

Completed08/14/2017
Import Tax Codes 05:45:05 PM Import

Import Company Code Tax Registration Completed08/14/2017
11:21:09 AM ImportNumbers

Import External Tax Calculation Providers Completed08/11/2017
05:58:20 PM Import

Import Supplier Tax Registration Numbers Completed 07/11/2017
05:12:48 PM Import

01/25/2017
Import Tax Types? Completed 07:51:09 PM Import

Completed12/19/2016
Import Tax Type Mappings 04:15:31 PM Import

TaxTypeMap.csv

123456
UTF-8,

TaxLineType,Name

CBT,China Business Tax
COF,COFINS

CST,Central Sales Tax
CSu,County Sales/Use Tax

7 DPH,Dan z pridane hodnoty
ÿ EXC,Excise Tax

GCT,General Consumption Tax
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The CSV data file has fields TaxLineType which is tax type defined in SAP Ariba Procurement Solution. 
Field Name represents the normal tax types found on Supplier Invoice. 

Field Required Description Sample 
Value 

Unique Name Yes String. References unique Name of Tax Type 
defined in SAP Ariba Procurement Solution VAT 

Name Yes Multilingual String. This the tax type found on 
Invoices 

Value Added 
Tax 

Once TaxTypeMapping.csv file is ready, it can be imported in to SAP Ariba Procurement Solution using 
import task Import Tax Type Mappings. Please refer steps under IMPORT PROCEDURE section of 
TAX TYPE IMPORT to import the data in to SAP Ariba Solution. 

T TaxTypeMap.csv file that need to be imported in to SAP Ariba Buying Solutions can be 
found as an attachment with the KB Article found on Customer Platform Support at: 
https://tax.thomsonreuters.com/support/onesource/indirect-tax/?search=000039826 

TAXTYPES TRANSLATION 
The Tax Type Translations is an optional import and requited only when the Tax 
Types need to be in a language other than the English. 

The sample Tax Type Translations file is as follows: 

ÿ

TaxType Translations.csv

123456UnigueName,Name,Language
CBT,China BusineSs Tax,French

COF,COFINS,French
CST,Central Sales Tax,French
CSU,County Sales/Use Tax,French

7 DPH,Dan z pridane hodnoty,French
EXC,Excise Tax,French

9 GCT,General Consumption Tax,French
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The data description of the Tax Type Translations is as follows: 

Field Required Description Sample Value 

Unique Name Yes String. References unique Name of Tax Type defined 
in SAP Ariba Procurement Solution VAT 

Name No Multilingual String. This is displayed on UI Value Added Tax 

Language Yes String. The language to which Tax Type is translated French 

The import tasks related to Tax are found under Site Manager Workspace. The navigation to the Data 
Import/Export task is as follows: 

Ariba Spend Management > Manage > Core Administration > Site Manager > Data Import/Export 

Once TaxTypeTranslation.csv file is ready, it can be imported in to SAP Ariba Procurement Solution using 
import task Import Tax Type Translations. Please refer steps under IMPORT PROCEDURE section of 
TAX TYPE IMPORT topic to import the data in to SAP Ariba Solution. 

TAX TYPE MAPPING AND MATCHING 
SAP Ariba Buying Solutions use tax type matching as one of the successful data validation criteria during 
tax reconciliation (part of Invoice Reconciliation). 

• SAP Ariba calls it tax types and ONESOURCE refer it as Tax Authority Types. 
• Tax Type and Tax Type Map are standard tax data used for both native tax engine and external 

tax engine. 
• Tax Type Map helps map common tax types used on Supplier/Vendor Invoices (ex: AN Invoice) 

to tax types used in SAP Ariba Buying Solutions.   
• Ariba matches tax authority types from ONESOURCE response with Ariba tax types during tax 

reconciliation between Vendor tax amount and expected tax amount as calculated by 
ONESOURCE Global Tax. 

• ONESOURCE provides Tax Type and Tax Type Map tax data (KB Article 000039826) based on 
ONESOURCE Determination tax authority types. 

• Ariba allows modification of Field/Column Name) in Tax Type Map and Tax Type data files as 
required/per Business needs. But TaxLineType from Tax Type Map should match with 
UniqueName in Tax Type file for successful tax type should match. 

• Any change to field/column “Name” of common tax types and change to mapping between 
procurement tax type (Ariba Buying Solution) and common tax type used on Ariba Network 
should be done as per SAP Ariba Cloud Application rules. 

 TAX CODES 
Tax Codes import task enable maintenance of Tax codes in SAP Ariba Procurement Solution. Like other 
import tasks in SAP Ariba Procurement Solution, Tax Code import task offers UI to import tax code data. 
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This import task consists of two import CSV files which are TaxCodeHeader.csv and TaxCodeDetail.csv. 
Import Tax Code Task UI offers option to import two CSV files in to the system in single step. 

For SAP Ariba Procurement Solution’s tax integration with ONESOURCE Global Tax for 
SAP Ariba Solutions, only TaxCodeHeader.csv import file with Tax Code data is required. 
And TaxCodeDetails.csv would be imported as an empty file for programmatic use. 

Sample TaxCodeHeader.csv file: 

The description of the fields for the TaxCodeHeader.csv is as follows: 

Field Name Required Description 

MWSKZ Yes String. The unique name of the tax code. A tax code can be updated or 
deactivated using this unique name. 

Name No Multilingual String. User specified name which is displayed on UI 

TEXT1 No Multilingual String. Additional information for the tax code like purpose 

LAND1 Yes String. The unique identifier of the Country for which the tax code is 
applicable 

State No String. The unique name of the state for states in the US 

Tax Code Header Import File Preparation 

The data required for TaxCodeHeader.csv should match your backend ERP system’s company code 
structure. It is therefore recommended to export the relevant company codes form SAP system. 

To prepare the TaxCodeHeader.csv file using Tax Code Data from SAP ECC System follow below steps: 

ÿ

TaxCodeHeader.csv

1 UTF-8,,

23456
MWSKZ,Name,TEXT1,LAND1,State
AO,IDT Standard Output TAX Exempt,,US,
A1,IDT Standard Output TAX,,US,
AA,US is-exempt Output tax,,US,
AZ,AZ Input Tax,,US,

7 CO,IDT Standard 1 Use TAX Exempt,,US,
C1,IDT Standard Use TAX,,US,

9 C5,molex test account,,Us,
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SAP Users with access to table browsing transaction SE16/SE16N and authorization to 
Company Code data can extract the Tax Code data using below steps. 

User need to find out Tax Procedure assigned to the Country of the SAP Company Codes 
before extracting tax code data from T007A table. 

1. First get the Country of the SAP Company Code for which TaxCodeHeader.csv is 
prepared for. This information can be found in SAP Table T001. 

2. Then find Tax Procedure assigned to Country in SAP table T005. 

Country of SAP Company Code:   

Tax Procedure for Country: 

General TableDisplay

BackgroundNumber of Entries ÿÿ

Table T001 Company Codes
Text table No texts

Layout

Maximum no. of hits 500 Maintain entries

Selection Criteria

Fld name 0.Fr.Value To value More Output Technical name

Client MANDT

Company Code 2000 BUKRS
Company Name BUTXT

City ORT01

Country

Tabletobesearched T001 Company Codes

Numberofhits 1

Runtime Maximum no.ofhits 500

Details

CoCode cty
2000 GB
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Once the Tax Procedure assigned to SAP Company Code is found, please follow below steps to extract 
Tax Code data: 

1. Log in to SAP ECC system 

2. Enter Transaction Code SE16N in Command Field and click on Green check mark   

General Table Display

Background Number of Entries ÿÿ

Table T001 Company Codes
Text table No texts

Layout

Maximum no.of hits 500 Maintain entries

Selection Criteria

Fld name 0.Fr.Value To value More Output Technical name

Client MANDT

Company Code 3000 BUKRS

Company Name ÿ BUTXT

City 1 ORT01

Country LAND1

DisplayofEntriesFound

Table tobe searched T005 Countries

Number of hits

Runtime Maximum no.ofhits 500

Details

Cty Procedure
GB ZTPGB

ÿ
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3. System would display table browser UI 

4. Enter: 

A. Tax Procedure of the SAP Company Code found in earlier steps in to Procedure 
input field   

B. Tax Type = V (input tax) 

5. Click on Deselect All button as shown in below screenshot and Select Fields Procedure, 
Tax type and Description 

For Demo purpose here, we used sample Tax Procedure ZTPFB. For Ariba Buyer 
Organization this could be any Tax Procedure configured for corresponding SAP 
Company Code. 

SE16N

SAPEasyAccess-UsermenuforVENuK

ÿ other menu Create role Assian users Documentation

Favorites
ÿ /IDT/LOG-ONESOURCEIndirectTax->Reports->LogReader
ÿ /IDT/AUDIT_DATABASE-ONESOURCEIndirect Tax->Reports->Audit Database Tran
ÿ SALR87012357-AdvanceReturnforTaxonSales/Purchases

UsermenuforVENUK
ONESOURCE Indirect Tax
ONESOURCEIndirectTax-GoodsMovement

General Table Display
BackgroundNumber of Entries s ÿÿ

Table T007A Tax Keys
Text table T007S No texts
Layout
Maximum no. of hits 500 Maintain entries

Selection Criteria

Fld name Fr.Value To value MoreOutput Technical name 
Client MANDT
Procedure

Tax Code $ MWSKZ
$ ÿ ? PRUEF
$ ÿ MWART

$ ÿ MISWX
$ ÿ

EU code ÿ ?
Indicator: Tax code ÿ ?
Product code ? PROCD

ÿ TXIND
ÿ TXREL

Reporting cntry ÿ LSTML
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Please note that the tax codes data extracted from SAP ECC system is the same data 
which is maintained in ONESOURCE Indirect Tax Determination for the purpose of Tax 
Integration between SAP Ariba Procurement Solution and ONESOURCE Global Tax for 
SAP Ariba Solutions. 

First please list all the SAP Company Codes for which Tax Code Qualifier configuration is maintained in 
ONESOURCE Indirect Tax Determination for the input tax (tax types for Purchasing) for SAP Ariba 
Procurement solution tax integration purppose.Then extract Tax Code data for those company codes as 
explained in following steps. 

6. Scroll down to find and select the field Description 

7. Click on Execute button to display table contents for selected criteria, 

8. System would display Tax Code and Description data per selection criteria as below: 

ÿ

General Table Display

Background Number of Entries AllEntries

Table T007A Tax Keys
Text table T007S No texts

Layout

Maximum no.of hits 500 Maintain entries

Selection Criteria

Fld name 0.Fr.Value To value More Output Technical name

Client MANDT

Procedure ZTPGB KALSM
Tax Code MWSKZ

Indicator: Error Mes

Tax type MWART

Tol.per.rate TOLERANCE

TgtTaxCde:EUAcq ZMVSKESA

TgtTaxCode:EUAq ZMVSK ESE

New Def.TaxCde NEWWDEFTAX

COFINSLaW 11BTAXLW4

PIS LaW 1BTAXLVW5

Description TEXT1

?

Proc. Tx Description

ZTPGB I1 IDT Standard Input DFLT
ZTPGB V0 IDT GB Standard Input Tax Exempt
ZTPGB V1 IDT GB Standard Input Tax
ZTPGB V2 IDT GB Reduced RateInputTax
ZTPGB V3 IDT GB Zero Rate Tax Input
ZTPGB V4 IDTGBReverse ChargeInput Tax
ZTPGB V5 IDT GB Deferred Tax Input
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9. Use below table to populate the TaxCodeHeader.csv using Tax Code data found in SAP 
ECC System. 

Field Name Required Description SAP Field 

MWSKZ Yes 
String. The unique name of the tax code. 
A tax code can be updated or deactivated 
using this unique name. 

T007A-MWSKZ 

Name No Multilingual String. User specified name 
which is displayed on UI T007A-TEXT1 (Description) 

TEXT1 No Multilingual String. Additional information 
for the tax code like purpose Optional 

LAND1 Yes 
String. The unique identifier of the 
Country for which the tax code is 
applicable 

T007S-LAND1 or Country 
found for SAP Company Code 
in Table T001 

State No String. The unique name of the state for 
states in the US Optional 

10. Repeat the steps 1 to 7 under section TAX CODE HEADER IMPORT FILE PREPARATION 
for each SAP Company Code for which tax integration is enabled in SAP Ariba Procurement 
Solution.   

A single TaxCodeHeader.csv file can be used for Tax Code data of all Company Codes 
for which external tax integration is enabled in SAP Ariba Procurement Solution. 

Tax Code Details Import File Preparation 
  
The CSV file with only header data as shown in below sample file is required. It is a shell/empty file 
required for programmatic use while importing the data in to SAP Ariba Procurement System. 

The sample TaxCodeDetails.csv is as follows: 

Both TaxCodeHeader.csv and TaxCodeDetails.csv files can be imported using Import Tax Code task user 
interface. 

The navigation to the Data Import/Export task is as follows: 

Ariba Spend Management > Manage > Core Administration > Site Manager > Data Import/Export 

TaxCodeDetails.csv X

1 UTF-8,

2 MWSKZ,Seguence,Component,AppliedOn,LAND1
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Please refer steps under IMPORT PROCEDURE section of TAX TYPE IMPORT topic to import the data 
using Import Tax Codes import task. 

TAX CODES TRANSLATION 
If Customer would like to maintain description of Tax Codes in language other than English, perform Tax 
Codes Translation Task. 

The data description of the file is as follows: 

Field Name Required Description 

UniqueName Yes String. The unique name of the tax code. A tax code can be updated or 
deactivated using this unique name. 

Name Yes The translated Name of the Tax Code (Name field in TaxCodeHeader.csv)   
MultiLingualString. This is displayed on UI 

Description Yes The translated description (TEXT1 field in TaxCodeHeader.csv)   
MultiLingualString. This is displayed on UI 

Language Yes String. The language to which the name and description have been 
translated 

Once the CSV file is prepared, to import tax code translation data file using Import Tax Code 
Translations import task, please refer steps under IMPORT PROCEDURE section of TAX TYPE 
IMPORT to import the data in to SAP Ariba Solution. 

INCOTERMS 
"Inco terms" are international rules for the interpretation of the commonly used terms in international and 
domestic contracts of the sale of goods. 

Inco terms regulate the division of costs and the transfer of risks. 

SAP ERP System provides standard Inco terms through table TINC. The data from SAP ERP table TINC 
can used to populate the Incoterms.csv data import file in SAP Ariba Procurement Solution. 

The sample Inco terms import CSV file is as follows: 

Incotems.csv x

1 UTF-8,

2
3

INCO1,ORTOB,NAME1

FOB,YeS,FOB Boston
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Please follow below steps to extract Inco terms data from SAP ERP and import in to SAP Ariba 
Procurement Solution: 

Extract Inco terms Data from SAP ERP System 
1. Log in to SAP ERP system > enter SE16N in Command Field on home screen-SAP Easy Access 

2. Click on Green Check mark (enter button) to go to table UI 

3. System will display table UI as below 

SAPEasyAccess-UsermenuforVENUK

SE16N

SAPEasyAccess-UsermenuforVENUK

ÿother menu Create role Assign users Documentation

Favorites
 /IDT/LOG - ONESOURCE Indirect Tax -> Reports -> Log Reader
 /IDT/AUDIT_DATABASE - ONESOURCE Indirect Tax -> Reports -> Audit Database Tran

S_ALR_87012357-Advance RetumforTaxonSales/Purchases
1UsermenuforVENuK

SAPEasyAccess-UsermenuforVENUK

SE16N ?

SAPEasyAccess-UsermenuforVENUK

ÿOther menu Createrole Assion users Documentation

Favorites
/IDT/LOG -ONESOURCE Indirect Tax-> Reports ->Log Reader
 /IDT/AUDIT_DATABASE - ONESOURCE Indirect Tax -> Reports -> Audit Database Tran
SALR87012357-Advance Return forTaxonSales/Purchases

User menuforVENUK

  

 

 

 

    

 
 

 
 

 

  

 

    

 
 

 
 



Configuration Set Up - Ariba 53 

Data Import/Export Tasks 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

4. Enter Inco terms table TINC in input field Table and click Green check mark or Enter button on 
keyboard 

5. De-select all fields first and then select the fields which need to be downloaded as shown in 
below screenshots 

General Table Display

BackgroundNumber of Entries ÿÿ

Table
Text table No texts

Layout
Maximum no. of hits 500 Maintain entries

Selection Criteria

Fld name 0.Fr.Value To value More Output Technical name

General TableDisplay

BackgroundNumber of Entries ÿÿ

Table TINC Customers:Incoterms

Text table TINCT No texts

Layout
Maximum no.of hits 500 Maintain entries

Selection Criteria

Fld name 0.Fr.Value To value More Output Technical name

Client MANDT

Incoterms ÿ INCO1

Location mand. ÿ ORTOB

Title tr. loc. OITITLE

GI loading/POD
Description ÿ BEZEI
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6. Select Fields INCO1, ORTOB, BEZEI and then click on Execute button. 

7. System will display all entries per selection criteria: 

General Table Display

BackgroundNumber of Entries ÿÿ

Table TINC Customers: Incoterms

Text table TINCT No texts

Layout
Maximum no. of hits 500 Maintain entries

Selection Criteria

Fld name O.Fr.Value To value More Output Technical name

Client MANDT
Incoterms ÿ INCO1

Location mand. ÿ ORTOB
Title tr. loc. ÿ OITITLE

GI loading/POD OIG_GLPOD

Description BEZEI

General Table Display
lackground Number of Entries ÿÿ

Table Customers:Incoterms

Text table No texts
Layout

Maximum no. of hits 500 Maintain entries

Selection Criteria

Fld name 0. Fr.Value To value More Output Technical name
Client MANDT

Incoterms ÿ INCO1
Location mand. ORTOB

Title tr. loc. OITITLE

GI loading/POD OIG_GLPOD

Description BEZEI
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8. Click on download option to download the content to user’s computer system. 

9. Once data is downloaded, prepare a CSV file like the sample shown here: 

DisplayofEntriesFound

Table to be searched TINC Customers: Incoterms
Number of hits 16
Runtime 0 Maximum no. of hits 500

i Details

IncoTCty Description
CFR X Costs and freight
CIF X Costs, insurance & freight
CIP X Insured freight-free
COD X COD
CPT Freight-free
DAF X Border delivered
DDP X Delivered cleared by customs
DDU X Delivered not cleared by cust.
DEQ X Delivered from quay (cleared)
DES X Delivered from ship
EXW From plant
FAS X Free along side
FCA X Free freight
FH Free house
FOB X Free on board
UN Not free

Table to be searched TINC Customers: Incoterms
Number of hits 16

Runtime 0 Maximum no. of hits 500

Details
IncoTCty Description Spreadsheet
CFR X Costs and freight Word processing
CIF X Costs, insurance & freight

X Insured freight-free
Local File

CIP
COD X COD Send

CPT Freight-free office
DAF X Border delivered ABC Analys.
DDP X Delivered cleared by customs HTML download
DDU X Delivered not cleared by cust.
DEQ X Delivered from quay (cleared)
DES X Delivered from ship
EXW From plant
FAS X Free along side
FCA X Free freight
FH Free house
FOB X Free on board
UN Not free
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  Sample file structure of Inco terms: 

File data definition: 

Field Name SAP Field Required Type and description Sample value 

INCO1 TINC-INCO1 Yes 
String. Refers to the Inco terms code or 
the unique internal identifier for the Inco 
terms. 

FOB 

ORTOB TINC-ORTOB No Boolean. Specifies whether location is 
applicable for the Inco terms. Yes 

NAME1 TINCT-BEZEI Yes String. Description for the Inco terms 
code. Free on board 

The value “X” for SAP TINC-ORTOB should be specified as “Yes” and the value “Blank” 
for SAP TINC-ORTOB should be specified as a comma (,) in Incoterms.csv file. 

Once the import CSV file is prepared, it needs to be imported in to SAP Ariba Solution. 

The import tasks related to Inco terms are found under Site Manager Workspace in SAP Ariba 
Procurement Solution. 

The navigation to the Data Import/Export task is as follows: 

Ariba Spend Management > Manage > Core Administration > Site Manager > Data Import/Export 

Incotems.csv×

1 UTF-8,,
N INCO1,ORTOB,NAME1

3 CFR,Yes,Costs and freight
4 CIF,Yes,Costs, insurance & freight

CIP,Yes,Insured freight-free
6 COD,YeS,COD
7 CPT,,Freight-free

DAF,Yes,Border delivered
6 DDP,Yes,Delivered cleared by customs

10 DDU,Yes,Delivered not cleared by cust.
11 DEQ,Yes,Delivered from quay (cleared)
12 DES,Yes,Delivered from ship
13 EXW,,From plant
14 FAS,Yes,Free along side
15 FCA,Yes,Free freight
16 FH,,Free house
17 FOB,Yes,Free on board
18 UN,,Not free
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Please refer steps under IMPORT PROCEDURE section of TAX TYPE IMPORT to import the data using 
Import Inco terms import task. 

INCOTERMS TRANSLATION 
To maintain translation for Inco terms, the import task, Inco terms translations need to be maintained. 

The Inco terms Translations data definition is as follows: 

Field Name Required Type and description Sample 
value 

INCO1 Yes String. Refers to the Inco terms code or the unique internal 
identifier for the Inco terms. FOB 

Language No String. Refers to the language for the translation German 

NAME1 Yes String. Description for the Inco terms code. Free on 
board 

Prepare the file as shown in below sample CSV file using the Incoterms.csv file. Fields INCO1 and 
NAME1 from Incoterms.csv with a new field called Language makes up the Inco terms Translations.csv 
file. 

Once the CSV file ready using import task Import Inco terms Translations import the file in to SAP 
Ariba Solution.   

Please refer steps under IMPORT PROCEDURE section of TAX TYPE IMPORT topic to import the data 
in to SAP Ariba Solution. 

Incotems Translations.csv 

1 UTF-8,1
2 INCO1,NAME1,Language
3 CFR,Costs and freight,German
4 CIF,Costs,German
ÿ CIP,Insured freiqht-free,German
6 COD,COD,German
7 CPT,Freight-free,German
8 DAF,Border delivered,German
9 DDP,Delivered cleared by customs,German

10 DDU,Delivered not cleared by cust.,German
11 DEQ,Delivered from quay (cleared),German
12 DES,Delivered from ship,German
13 EXW,From plant,German
14 FAS,Free along side,German
15 FCA,Free freight,German
16 FH,Free house,German
17 FOB,Free on board,German
18 UN,Not free,German
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TAX REGISTRATION NUMBERS 

SAP Ariba has created new data import tasks to import Buyer (Company) and Seller (Supplier) Tax 
Registration Numbers in SAP Ariba Procurement and Invoice Solutions. Using these import tasks, 
Customers can import registration numbers. 

As part of ONESOURCE Global Tax for SAP Ariba Solutions implementation, Customers need to run 
these import tasks to maintain registration numbers in SAP Ariba Procurement and Invoicing Solutions 
Registration numbers will be used on tax call request to ONESOURCE Indirect Tax Solution for accurate 
calculation of taxes. 

BUYER TAX REGISTRATION NUMBERS 
Sample CSV file: 

Details about the import data: 

Field Required Description Sample Value 

TaxRegistrationNumber Yes String (50) A unique internal identifier for the 
company code. VAT234432565 

CompanyCode Yes String (50) The unique internal identifier for 
country. 3000 

Country Yes String (50) The tax registration number for the 
company code and country combination US 

  

CompanyCodeTaxRegistration.csv

12345
UTF-8,1
CompanyCode,Country,TaxRegistrationNumber
2000,GB,GB123456788

4300,IN,07ABCHE1234X122

4300,IN,82ABCDE1234X123

2000,GB,GB123456789
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SUPPLIER TAX REGISTRATION NUMBERS 
Sample CSV file: 

Details about the import data: 

Importing these CSV files is like any other Ariba standard data import task. To import this data, follow the 
navigation as explained below. 

1. Go to Manage > Core Administration > Site Manager > Data Import/Export 

Field Required Description Sample Value 

TaxRegistrationNumber Yes String (50). A unique internal identifier for the 
company code. VAT234432565 

Supplier Yes String (50). A unique internal identifier for the 
supplier. 0000000001 

Country Yes String (50). The tax registration number for the 
company code and country combination US 

SupplierTaxRegistration.csv

123456
UTF-8,1
Supplier,Country,TaxRegistrationNumber
2001,GB,GB123456789

9000,IN,28ABCHE1234X123

9000,IN,28ABCDE1234X123

9000,IN,07ABCHE1234X122
7 2001,GB,GB123456788
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2. Follow steps as shown on the above screenshot to access import UI page. 

Data Import/Export

DownloadDataDictionary 1.enter search text 2. click on
(not case sensitive) Search button

Search Filters:

Task Name.registration Search List All

Web Service Status 4. click on lmportImport
button to go to Import
Ul and to import data

3. System displays
Import requested import tasks Refresh Status

Tasks Integration Toolkit Names  ÿStatus Last Imported

Import Company Code Tax Registration Completed08/17/2017 01:26:54 ImportNumbers
Import Supplier Tax Registration Numbers

Import

Data Import for Task "lmport Company Code Tax Registration Numbers"

Choose the operation you want to perform. Browse or specify the file where you want to import the data.

1.selectImportType
Select Import Operation: operation

Load
Creates and modifies objects i
data file already exists ir database, it is modified using the value in the data file.

Create
Creates new objects in the database using values in the data file. If an object in the data file already exists in the database, it is not modified.

Update Only
Modifies existing objects only in the database using values in the data file. If an object in the data file does not already exist in the database, it is not created. If you do not
want to modify a particular object, do not include it in the data file. This operation can cause deactivated objects to be reactivated.

Deactivate
Deactivates objects in the database based on objects in the data file.If you do not want to deactivate a particular object, do not include it in the data file.

2.locate import
Enter the location of the CompanyCodeTaxRegistration.csv file:CSV file on your
C:Usersluc216083\Documents\TR Ariba Test System\MasteBrowse... system

3.click on Run to
import the data

Run Cancel
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3. Click on OK button to continue 

4. Once import task is executed, system takes you back to the Import UI page > Import tab. System 
would show the status and date of completion for the import operation. 

5. Repeat the steps from 1 to 4 to import the Supplier Registration numbers for Import Task Supplier 
Tax Registration Numbers. 

PURCHASE ORGANIZATION TO SUPPLIER MAPPING 
The import task Purchase Organization to Supplier Mapping is an existing task for SAP Variant of SAP 
Ariba Procurement Solution. But the import filed is updated with new field called INCO1 to refer Inco 
terms code maintained in Incoterms.csv import file. 

Data Import for Task "lmport Company Code Tax Registration Numbers"

Choose the operation you want to perform. Browse or specify the fle where you want to import the data.

Select Import Operation:

Load
Creates and modifies objects in the database using values in the data file. If an object in the data file does not already exist in the database, it is created. If an object in the
data file alrea

Create Confirm Data Import
Creates new I the database, it is not modified.

Are you sure you want to run Import Company Code Tax Registration Numbers?
Update Onl

Modifies exis OK Cancel ot already exist in the database, it is not created. If you do not
want to modi ects to be reactivated.

Deactivate
Deactivates objects in the database based on objects in the data file. If you do not want to deactivate a particular object, do not include it in the data file.

Enter the location of the CompanyCodeTaxRegistration.csv file:
C:\Usersluc216083IDocumentsITR Ariba Test SystemlMasteBrowse.

Run Cancel

Download Data Dictionary

Search Filters:

Task Name: registration Search List All

Import Web Service Status Status column
indicatescompletionof
task

Import U Refresh Status

Tasks Integration Toolkit Names   ÿ ÿStatus Last Imported

Import Company Code Tax Registration Completed09/25/2017 11:25:26 ImportNumbers ? AM
Import Supplier Tax Registration Numbers Import
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Inco terms are used by ONESOURCE Indirect Tax Determination. When buyer organization enables a 
SAP Company Code for tax calculation by Thomson Reuter’s ONESOURCE Global Tax for SAP Ariba 
Solutions, this import task need to be updated. 

The sample CSV file for updated import task Purchase Organization to Supplier Mapping is as follows: 

The new column INCO1 is added is seen in the sample file. Please use the values for INCO1column from 
Incoterms.csv import task. Once PurchaseOrgSupplierCombo.csv file is prepared use import task Import 
Purchase Organization to Supplier Mapping to import the data in to SAP Ariba Solution.   

Navigation: Manage > Core Administration > Site Manager > Data Import/Export 

Please refer steps under IMPORT PROCEDURE section of TAX TYPE IMPORT to import the data in to 
SAP Ariba Solution.   

As this is an update to existing data, please use Update import operation type while importing 
the data. 

CUSTOM FIELDS 
SAP ARIBA Customer can make use of Custom fields in the tax calculation process using ONESOURCE 
Global Tax for SAP Ariba Solutions. 

To accomplish this Customer, need to follow the following steps: 

• Customer need to contact SAP ARIBA Customer Support for creating Custom fields. 
• SAP ARIBA Customer Support creates the Custom field(s) per Customer specification and marks 

the fields as tax influencing fields. 
• SAP ARIBA Customer then work with Thomson Reuter’s ONESOURCE Indirect Tax Professional 

Services to make Custom fields as part of external tax call. 
• Thomson Reuter’s Global Tax PS works with internal engineering team to map tax influencing 

custom fields to User Attribute Elements in Tax Integration and Determination Tax policy. 
• Customer and Thomson Reuter’s Global Tax PS team test the newly added Custom fields before 

moving the changes to Production systems (Customer’s SAP ARIBA realm and ONESOURCE 
Global Tax for SAP Ariba Solutions). 

Integration version 1.0.2.0 or higher has User Interface which allows users to make 
configuration with less dependency. 

  

PurchaseOrgSupplierCombo.csvX

1 UTF-8,

2 EKORG,LIFNR,XERSY, INCO1,ZTERM

3 "0008 3010,X,1
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CONFIGURATION SET UP - 
ONESOURCE GLOBAL TAX 
INTEGRATION USER INTERFACE 

The User Interface offers screens to configure the ONESOURCE Global Tax for SAP Ariba Solutions 
(Integration). The Cloud and OP users are offered with same UI features. Integration UI will have 
Application Menu which consist of sub menu items giving access to set up and configuration screens. 

APPLICATION MENU SUB MENU ITEMS/UI SCREENS 

Home 

Configuration Ariba Realm Specific Configurations 

XMLs Log Enablement 

Tax Summarization 

Custom Field Mapping 

Ariba Integration Settings 

Logs 

Integration UI does offer Integration Roles for administration, configuration and view only access of UI 
screens. 

INTEGRATION ROLE DESCRIPTION 

Integrations Admin Allows User to: 
• configure Health Check History settings, 
• Tax Block negation table and 
• view configuration and logs 

Integrations Configurator Allows User to: 
• map Ariba Realm to External Company Prepend,   
• enable XMLs Log for transactions,   
• configure Tax Summarization,   
• configure custom field mapping,   
• view Administration settings and logs. 

Integrations User Allows User to 
• view Administration settings,   
• view Configuration parameters and search logs. 
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PREREQUISITES 
SYSTEM AND USER ACCOUNT PREREQUISITES 

Integration Deployment 
Model Requirements 

Multi-Tenant Hosted 
• Determination User Accounts assigned with required Integration 

Roles 
• Access the ONESOURCE Global Tax for SAP Ariba Solutions 

Integration UI through web browser 

Single-tenant Hosted 

IDT 2018 Cloud   

On-Premise 

• Install Integration UI as specified in the Install Guide 
• Determination User Accounts assigned with required Integration 

Roles 
• Access the ONESOURCE Global Tax for SAP Ariba Solutions 

Integration UI through web browser with endpoint set up in your 
technology stack per OP Installation guide 
(InstallGuideONESOURCEGlobalTaxSAPAribaSolutions_1.0.2.0) 

Customers who are using Multi-Tenant Hosted, Single-tenant Hosted, IDT 2018 Cloud 
deployment models of ONESOURCE Global Tax for SAP Ariba Solutions are commonly 
referred as Cloud Users in this document for simplicity. 

AUTHENTICATION 
User Authentication is managed via ONESOURCE Determination, so you will need the log on credentials 
set up in the ONESOURCE Determination. 

Once logged in to ONESOURCE Global Tax for SAP Ariba Solutions Integration UI, user name and 
tenant will be displayed on the top right-hand corner of each page. 

AUTHORIZATION 
User’s authorization to configure Integration for their ERP Companies depends on the Companies that 
are assigned to User account in the ONESOURCE Determination. 

Authorization to Integration UI screens depends on the Integration Roles that are assigned to the User in 
the ONESOURCE Determination. 

INTEGRATION UI ROLE MATRIX 
The below matrix shows roles and authorization type that each role would provide for a UI Screen and 
Configuration options. 
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Key: C=Create; U=Update; R=Read; D=Delete 

INTEGRATION UI LOG-IN AND BASIC NAVIGATION 
This chapter explains about the log in and general navigation for Integration UI. 

1. Open Internet web browser of your choice (supported versions are mentioned under topic Integration 
User interface). 

2. Enter the Integration UI URL and click enter.   

• OP Users may get the URL from their System Admin/Network teams 
• Cloud users would get this from Thomson Reuters Professional Services 

3. You will reach ONESOURCE Global Tax for SAP Ariba Solutions Integration UI log in page. Enter 
user name and password in the User Name and Password input fields on the log in box in the center 
of the page respectively and click on SIGN IN button. 

Integrations Admin Integrations Configurator Integrations User 
Ariba Realm Specific Configurations 
(SAP Ariba Realm, External Company Prepend) 

R CRUD R 

Ariba Integration Settings 
(Health Check Entry Values, Tax Block Negation) 

CRUD R R 

Custom Field Mapping 
(SAP Ariba Realm, Document Level, Custom Type, 
Ariba Field Name, Determination User Element ID) 

R CRUD R 

XMLs Log Enablement 
(SAP Ariba Realm, Determination Company, 
Document Type) 

R CRUD R 

Tax Summarization 
(US Tax Summarization options, VAT Summarization 
Options) 

R CRUD R 

Logs R R R 

In
te

gr
at

io
n 

Pa
ra

m
et

er
s 

Integration Roles 
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Here are the important elements you would see on the home screen. 

The application menu is same across all the UI Screens and can be navigated from one UI 
screen to another UI Screen. The access to UI screens is determined based on your 
Integration Roles that are assigned to Determination User Account. The companies for which 
you can configure or set up Integration depends on the companies that you have access to 
with your Determination User Account. 

This section covers the UI Screen fields, navigation steps for configuring the ONESOURCE Global Tax 
for SAP Ariba Solutions (also mentioned as Integration in this document for easy reference) 

The features and most of the steps would be same for both Cloud and OP Users. 

Ariba Configuration
M https://onesource-idt-ariba-sat-ux.hostedtax.thomsonreuters.com/#!/login W

TRIncoterms&VATagICCIncotermsRules|IncIntegrating SAPERPSAP PI for BeginnersOracle E-BusinessTaOracle E-Business TaDefining Sales and ÿ

THOMSONREUTERS

ONESOURCEGlobalTaxForSAPAribaSolutions

"AribaDevUser

SIGNIN

2018ThomsonReuters/Tax&Accounting.ThomsonReuters,ONESOURCEand theKinesislogo are trademarksof ThomsonReuters and
THOMSONREUTERS itsaffliatedcompanies.

PrivacyPolicy.Contact Us

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaQAUser
TENANT-IndirectTaxntegrationsQA

Home Configuration AribaIntegrationSettings Logs

TenantIDand Nameof
Integration LogOffbutton

IntegrationUI the User
Menu SystemName whologged
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ARIBA REALM SPECIFIC CONFIGURATIONS 
Ariba Realm Specific Configurations UI Screen allows you to configure mapping between Ariba Realm 
and External Company Prepend. 

SAP Ariba Realm: 

This is the unique realm ID of Customer’s SAP Ariba Buying Solution. 

External Company Prepend (optional in On-Premise): 

The prepend allows to make an Ariba business unit (SAP Company Code) unique across multiple 
systems that might share the same company code structures. ONESOURCE Determination requires that 
the External Company ID is unique for each business. For example, in the case of an acquisition where 
the newly acquired business has the same company code, e.g. 1000, but you have already used 
company code 1000 for a prior business in Determination, you can use the prepend to make the second 
business company codes unique. The prepend will be added in front of the Ariba provided business unit 
code. Multiple Ariba Realms can be associated with same Determination External Company Prepend. 

The use of a prepend is required for Thomson Reuters managed Cloud deployments, the value will be 
provided by Thomson Reuters Professional Services. For on-premise deployments the value is optional, if 
not set the business unit from Ariba will be sent as is. (The realm still must be mapped, just leave the 
prepend blank). 

1. Click on Add Ariba Realm Specific Configuration button to add new entries. 

ÿ ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaQAUser
TENANT-IndirectTaxIntegrationsQA

Home Configuration AribaIntegrationSettings Logs

Ariba RealmSpecificConfigurations

XMLsLogEnablement

TaxSummarization

CustomField Mapping

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaTestConfig
TENANT - Indirect Tax Integrations QA

Home Configuration Ariba Integration Settings Logs

Ariba Realm Specific Configurations

Add Ariba Realm Specific Configuration

ID Action SAPAribaRealm External Company Prepend

QA_TEST INTSAPQA_
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2. You will be navigated to Add Ariba Specific Realm Configuration screen. Enter Ariba realm and 
External Prepend values in the input fields as shown in the screenshot 

For Cloud users SAP Ariba Realm and External Companu Prepend are required fields. But for   
on-premise the prepend is not required. 

3. Click on SAVE button to save the configuration. You will be promoted with a pop up box to confirm 
the action. 

4. Click on YES button if you would like to continue (otherwise click on NO button). 

5. When you click on YES, configuration is saved and you would be navigated to Ariba Realm Specific 
Configurations main screen where display grid shows the new entry 

Home Configuration Ariba Integration SettingsLogs

Add Ariba Specific Realm Configuration
SAP AribaRealm *

prealm_demo

External CompanyPrepend *

This value is provided by Thomson Reuters during Customer onboarding

democompany

SAVE CANCEL

Home Configuration Ariba Integration Settings Logs

Add Ariba Specific Realm Configuration
SAP Ariba Realm *

prealm_demo

Are you sure you want to save the changes?
External Company Prepend *

This value is provided by Thoms
YES NO

democompany

SAVE CANCEL
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EDIT ARIBA REALM SPECIFIC CONFIGURATION 
To make changes to an existing configuration, please follow the below steps. 

1. On Home Screen, go to Configuration > Ariba Realm Specific Configuration 

2. Click on Ariba Realm Specific Configurations option. 

3. Select the Pencil icon on the row in the display grid for which you would like to make changes. 

4. You would be navigated to Edit Ariba Specific Realm Configuration screen. Ariba Realm and External 
Company Prepend fields are shown in the editable mode.   

Home Configuration Ariba Integration SettingsLogs

Ariba Realm Specific Configurations

Add Ariba Realm Specific Configuration

ID Action SAP Ariba Realm External CompanyPrepend

7 prealm_demo democompany

6 QA_TEST INTSAPQA_

Home Configuration Ariba Integration Settings Logs

Ariba Realm Specific Configurations

Add Ariba Realm Specific Configuration

ID Action SAP Ariba Realm External Company Prepend

7 prealm_demo democompany

6 QA_TEST INTSAPQA_
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5. You can make changes to SAP Ariba Realm and External Company Prepend.   

Please note that by changing SAP Ariba Realm, you will be replacing the existing value with the 
new one. And so, consider dependencies like Custom field mapping and XMLs log enablement 
if any. 

6. Click on SAVE button to make changes saved to database. Pop up for prompt shows up and click on 
YES button to continue make changes (otherwise click on NO button). 

Home Configuration AribaIntegrationSettingsLogs

Edit Ariba Specific Realm Configuration
SAP Ariba Realm *

prealm_demo

External CompanyPrepend *

This value is provided by Thomson Reuters during Customer onboarding

democompany

SAVE CANCEL
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7. If you click on YES, changes are made and display grid on the Ariba Realm Specific Configuration 
main screen would show the updated values for selected entries. 

DELETE ARIBA REALM SPECIFIC CONFIGURATION 

When you delete an existing Ariba Realm Specific Configuration, please consider associated 
dependencies like Custom field mapping, External Company Prepend, XMLs log enablement as 
deleting an existing realm would leads to deleting all the associated configurations.   

To delete an existing Ariba Realm Specific Configuration, please follow the below steps: 

1. On Home Screen, go to Configuration > Ariba Realm Specific Configuration. 

2. Click on Ariba Realm Specific Configurations option. 

3. Click on delete icon on the row in the display grid which you would like to delete. 

Home Configuration Ariba Integration SettingsLogs

Edit Ariba Specific Realm Configuration
SAP Ariba Realm *

prealm_demo1

Are you sure you want to save the changes?
External Company Prepend *

This value is provided by Thoms
YES NO

democompany

SAVE CANCEL

Home Configuration Ariba Integration SettingsLogs

Ariba Realm Specific Configurations

Add AribaRealm Specific Configuration

ID Action SAP Ariba Realm External CompanyPrepend

ÿ prealm_demo1 democompany

6 QA_TEST INTSAPQA_

ÿ
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4. You would be prompted to confirm the decision through pop up window. To continue click on YES 
button and otherwise click on NO button. 

5. Display grid on the Ariba Realm Specific Configuration would get updated (it would not show the 
deleted entry). 

  

Home Configuration Ariba Integration SettingsLogs

Ariba Realm Specific Configurations

Add AribaRealm Specific Configuration

ID Action SAP Ariba Realm External CompanyPrepend

ÿ prealm_demo1 democompany

QA_TEST INTSAPQA_

Home Configuration Ariba Integration SettingsLogs

Ariba Realm Specific Configurations

Add Ariba Realm Specific C
Deleting Partition will also delete any dependent objects.Would you like to continue?

ID 'repend

YES NO

INTSAPQA

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaTestConfig
TENANT - Indirect Tax Integrations QA

Deleted successfuly
Home Configuration Ariba Integration Setting

Ariba Realm Specific Configurations

Add AribaRealmSpecificConfiguration

ID Action SAP Ariba Realm ExternalCompanyPrepend

6 QA_TEST INTSAPQA_
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TAX CODE QUALIFIER BASED ARIBA TAX TYPE 
MAPPING 
FUNCTIONALITY 

ONESOURCE Determination uses Authority types (tax authorities which charge tax for a purchase or 
sales transaction) whereas SAP Ariba uses Tax Types to represent tax authorities. Thomson Reuters 
ONESOURCE provides Tax Type and Tax Type Map data files based on authority types which are 
imported in to SAP Ariba Buying Solution. 

As part of the tax response, ONESOURCE Global Tax for SAP Ariba Solutions returns Determination 
Authority Types in the Ariba tax response, and SAP Ariba matches the authority types with the tax types 
on the Vendor’s Invoice. But given the scope of SAP Ariba Buying Solutions (use of various channels that 
Vendor Invoices are submitted through), current tax type mapping and matching leaves some gaps 
leading to tax type mismatch and tax calculation failure errors. 

The Tax Code qualifier based Ariba Tax Type mapping feature in ONESOURCE Global Tax for SAP 
Ariba Solutions allows flexible mapping of Ariba Tax Types to ONESOURCE Determination Authority 
types. This mapping allows the Ariba tax response to have tax types as defined and found in SAP Ariba 
Buying Solutions. 

• Integration users will maintain required SAP Ariba Tax Types on ONESOURCE Determination 
Tax Code Qualifiers and activate the feature in the ONESOURSE Global Tax for SAP Ariba 
Solutions.   

• During Transaction processing, Integration will map Ariba tax types from Tax Code Qualifiers to 
Determination Authority types so that the Ariba tax response from ONESOURCE contains tax 
types as expected in the SAP Ariba Buying Solution. 

Ariba Tax types are of summarized i.e. not granular (example: “sales”) whereas ONESOURCE 
Determination Authority Types are granular (State Sales/Use tax, City Sales/Use tax etc.). So, when the 
Tax Code Qualifier based Ariba Tax Type mapping feature is configured, Integration would summarize 
Determination result per unique Ariba Tax Type, making the Ariba tax response acceptable in SAP Ariba 
Buying solution with unique tax types. 

• If you are using Ariba Integration and have the ONESOURCE Global Tax for SAP version 6.1 and 
above, then it is likely that Tax Code Qualifiers are already configured for the SAP Integration in 
your Determination instance. In that situation you will be adding the Ariba Tax type designation as 
part of your current TCQ configurations.    

• If you do not have the ONESOURCE Global Tax for SAP then you will likely need to create the 
TCQ configuration a new and populating the results for the ERP_TAX_CODE field based solely 
on the Tax Type designation needed for the Ariba Integration. 

• Please refer to the Determination documentation and help guides on Tax Code Qualifiers 
configuration if you need further assistance setting up the proper TCQ conditions and other steps. 

Below example scenarios are based on assumption that TCQ configuration in Determination 
already maintained. 



74 Configuration Set Up - ONESOURCE Global Tax 

Tax Code Qualifier Based Ariba Tax Type Mapping 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

SAMPLE SCENARIOS 
Customers can map Ariba Tax Types on Determination Tax Code Qualifiers as required to reduce tax 
type mismatch exceptions and tax code calculation errors in SAP Ariba Buying Solutions. 

Here are some of the possible sample scenarios listed for illustration purpose. 

For the examples shown in the table below the first 6 characters represent the two-digit tax code, a 
hyphen, followed by the three-digit account assignment key that is required for the ONESOURCE Global 
Tax for SAP. The following [ATT] encapsulated designator is the portion required for the Ariba Tax Type 
mapping.  Together they represent the field that will be returned by Determination as the 
ERP_TAX_CODE field in the XML response from Determination.  If you do not have the Integration for 
SAP (Global Next), then the first 7 characters will not be required. 

Ariba Tax Type maintained 
on the Tax Code Qualifier 

Determination Authority 
Type returned during 
tax calculation 

Ariba Tax Response 

USCA_S vendor charged to 
expense acct 
V1-NVV-[ATT]SalesTax[ATT] 

Document Line1: 
State Sales/Use Tax 
City Sales/Use Tax 

Summarized tax with Ariba Tax Type 
"SalesTax" 

GB_ReverseCharge_I 
V4-ESE-[ATT]VATTax[ATT] 

GB_ReverseCharge_O 
V4-ESA-[ATT]VATTax[ATT] 

Document Line1: 
VAT_1 
VAT_2 

Summarized tax with Ariba Tax Type 
"VATTax" 

GB_ReverseCharge_I 
V4-ESE-[ATT]VAT_1[ATT] 

GB_ReverseCharge_O 
V4-ESA-[ATT]VAT_2[ATT] 

Document Line1: 
VAT_1 
VAT_2 

No summarization, Input and Output 
tax blocks with Ariba tax types 
"VAT_1" on first tax block and "VAT_2" 
on second tax block 

MX_B_DP_StandardRate 
V1-VST-[ATT]VATTax[ATT] 

IVA_1 No summarization with Ariba tax type 
“VATTax” 

CH_B_StandardVAT 
V1-VST-[ATT]VATTax[ATT] 

MWST No summarization with Ariba tax type 
“VATTax” 

FR_B_StandardVAT 
V1-VST-[ATT]VATTax[ATT] 

TVA_1 No summarization with Ariba tax type 
“VATTax” 

The Determination TCQ based Ariba Tax Types allows flexible tax type mapping.   
Please ensure that you are maintaining Ariba tax types on TCQ ERP Tax Codes that are valid 
and expected on the Ariba tax response from Integration. 
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CONFIGURATION 

MAINTAIN ARIBA TAX TYPES USING ONESOURCE DETERMINATION 
TAX CODE QUALIFIER 
The Tax Code in each applicable Tax Code Qualifier needs to be updated with the required and 
appropriate SAP Ariba Tax Type. 

The Ariba Tax Type that is being maintained on Tax Code Qualifier should be a valid tax type in 
SAP Ariba Buying Solutions. 

Example: 

• You have “sales” as Tax Category on SAP Ariba Network and corresponding Tax type  
(TaxLineType in Tax Type mapping data) is “SalesTax” in SAP Ariba Buying Solution 
(P2X/Invoice Management).   

• When an Invoice from Ariba Network is posted in to SAP Ariba Buying Solution, it picks up 
“SalesTax” as tax type (per your Tax Type Map data “sales” will be mapped to “SalesTax” in 
standard mapping).   

• When ONESOURCE Determination Tax Code Qualifier is maintained with SAP Ariba Tax types, 
make sure to use the tax types defined in SAP Ariba P2X/Invoice Management solution. 

Steps: 

1. Update each applicable Tax Code Qualifier with a valid Ariba Tax Type (both input and output tax 
code qualifiers in a Determination Company). 

2. The Ariba tax type segment format on the Tax Code Qualifier should be as below: 

a) Enclosed within the tagged brackets. ex: [ATT]vat[ATT], 
b) Added anywhere after the Tax Code and Account Key segment on the Tax Code field of TCQ 

configuration. 

• XX-YYY-[ATT]vat[ATT] or 
• XX-YYY-ZZZ-[ATT]vat[ATT] (ZZZ=custom segment if there is any) 

ÿ
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If you have a custom segment after the Tax Account key, Ariba tax type segment can be added after the 
custom segment: 

3. Please make sure that all Tax Code Qualifiers currently present, are updated with the right 
combination of SAP Ariba Tax Type, Country that tax type belongs to, and Determination Company. 
Here is an illustration of what is valid what is not: 

AP Ariba Tax 
Type 

Country that SAP Ariba 
Tax Type belongs to 

Example Determination Company 
that belongs to Country 

Valid? 

sales US 3000 Yes 
sales GB 2000 No 
vat GB 2000 Yes 
vat DE 1000 Yes 
vat US 3000 No 
vat or TVA FR 2200 Yes 
vat or MWST CH 2700 Yes 
gst, hst, qst, pst CA 4000 Yes 

ENABLE TAX CODE QUALIFIER BASED ARIBA TAX TYPE 
MAPPING FEATURE 
Please follow below steps to enable the Tax Code Qualifier based Ariba Tax Type mapping feature 

ONESOURCE INDIRECTTAXDETERMINATION THOMSONREUTERS

Menu Help Ready Venu Kotagiri- SAP USINC 3000 Logout

TaxCodeQualifiers Search Edit Conditions

Selected Group: SAP US ERP TaxCodes Selected Tax Code Qualifier: USCA_S vendor charged to expense acct Submit Actions

Order: 10 Name:usCA_S vendor charged to expense acct
Start Date: 10/01/2012 31 End Date: 31

Action

Tax Code: V1-NVV-[ATT]sales[ATT]

@ 2017 Thomson Reuters/ONESOURCE. All rights reserved.

ONESOURCE INDIRECTTAXDETERMINATION THOMSONREUTERS

Menu Help Ready Venu Kotagiri - SAP USINC 3000 Logout

TaxCodeQualifiers Search Edit Conditions

Selected Group: SAP US ERP TaxCodes Selected Tax Code Qualifier: USCA_ S vendor charged to expense acct Submit Actions

Order: 10 Name: USCA_S vendor charged to expense acct
Start Date: 10/01/2012 End Date: 31

Action

Tax Code: V1-NVV-ZZZ-[ATT]sales[ATT]

@ 2017 Thomson Reuters/ONESOURCE. All rights reserved.
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1. Log in to Integration. 
2. Once logged in, on Home screen navigate to Configuration > Tax Summarization 

3. Go to Tax Type Mapping > Click on drop down menu > Select Tax Code Qualifier based Ariba Tax 
Type Mapping option. 

4. You will see a pop up window prompting to maintain Ariba Tax Types on Determination Tax Code 
Qualifier. 

ÿ ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaTestConfig
AribaTest_Tenant

Home Configuration AribaIntegrationSettings Logs

Arlba Realm SpeciflcConflguratlons

XMLsLogEnablement

TaxSummarization

CustomFleld Mapplng

TaxSummarizationConfiguration

USTaxSummarizationOptions
Default tax response is at Tax Authority level detail but optionally user can configure one of two summarization levels.

VAT Summarization Options

Default tax response has both Input Tax and Recovery Tax blocks but optionally user can configure summarized response option.

US TaxSummarization Options VAT Summarization Options

Authority Detail Input and Output Authorities 

Tax Types Mapping
ONESOURCE Determination Tax Code Qualifier based Ariba Tax Type mapping takes precedence over the Tax Summarization Configuration

Determination Authority Type Based (Default)

Tax TypesMapping
Determination Authority TypeBased(Default)  Ariba Tax Type mapping takes precedence over the Tax Summarization Configuration
Tax Code Qualifier based Ariba Tax Type Mapping
Determination Authority Type Based
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5. Click OK button on pop up window to continue 
6. You will see system message that the configuration is saved indicating that feature is active now. 

Tax Code Qualifier based Ariba Tax Type mapping takes precedence over the Tax 
Summarization Configuration. If you have configured Tax Summarization option (ex: US Four 
Buckets Summarization), when Tax Code Qualifier based Ariba Tax Type mapping is 
configured, Ariba tax response would be according to Tax Code Qualifier based Ariba Tax Type 
mapping feature. 

TRANSACTION LOGGING 

ONESOURCE Global Tax for SAP Ariba Solutions enables Integration users to configure logging at 
desired levels and access the transactions logs via the Integration UI 

Tax Summarization Configuration

US TaxSummarization Options

Default tax response is at Tax Authority level detail but optionally user can configure one of two summarization levels.

VAT Summarization Options Please remember to configure desired and valid Ariba Tax Type(s) on Determination Tax

Default tax response has both Input Tax arCode Qualifier Ex: [ATT]sales[ATT]

OK
US

Authority Detail Input and Output Authorities 

Tax Types Mapping

Tax Code Qualifier based Ariba Tax Type Mapping 

Home Configuration Ariba Integration Settings
User selection has been saved successfully

Tax Summarization Configuration

US Tax Summarization Options

Default tax response is at Tax Authority level detail but optionally user can configure one of two summarization levels.

VAT Summarization Options

US TaxSummarization Options VAT Summarization Options

Authority Detail Input and Output Authorities 

Tax Types Mapping

TaxCodeQualifierbasedAribaTaxTypeMapping

ÿ
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To get transactions logged, users will need to enable the XMLs log on user interface. Integration allows 
XMLs logging at SAP Ariba Realm, Determination Company and Document Type (SAP Ariba PR and IR) 
levels. Users can enable logs at any desired level. Once logging is enabled, users can search, view and 
download transactions logs from Logs functionality on the UI. 

All tax transaction requests from SAP Ariba will be logged that meet the below criteria: 

1. SAP Ariba Tax calculation request has valid credentials. 

2. SAP Ariba Tax calculation request has valid Realm ID, Company Code / Organization. 

3. XMLs Logging is enabled for the Partition (SAP Ariba Realm ID) and/or Company Code / 
Organization. 

4. SAP Ariba Tax calculation request is not null. 

XMLS LOG ENABLEMENT 
This feature allows you to enable the XMLs log settings. When XMLs are enabled, ONESOURCE Global 
Tax for SAP Ariba Solutions will store transaction logs. Transaction logs are useful for troubleshooting 
and verification purposes. 

Integration offers three levels at which the logs can be enabled: 

1. SAP Ariba Realm 
2. Determination Company 
3. Document Type 

This is an optional configuration. By default, XMLs are not enabled. If you would like to see 
transaction logs in xml format, configure XMLs log enablement at desired level 

The transaction logs available under Logs UI screen are dependent on these settings. XMLs can be 
enabled at any desired level. 

Here are some possible options you may find: 

• Enabling XMLs log at SAP Ariba Realm level: 
When XMLs are enabled at SAP Ariba Realm, and Determination Company and Document Type 
are not selected, XML logs will be enabled for all Determination Companies under that SAP Ariba 
Realm and two document types (Purchase Requisition and Invoice Reconciliation). 

SAP Ariba Realm is an optional selection. You can skip selecting SAP Ariba Realm but 
choose to enable XML at Determination Company and Document Type level. If you do not     
select any SAP Ariba Realms, XML Logs will be enabled for all your valid SAP Ariba Realms   
in the Integration. 

• Enabling XMLs log at Determination Company level: 
When one or more entries from Determination Company list are selected, logs will be enabled for 
those Determination companies under all SAP Ariba Realms Customer may have. 
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• Enabling XMLs log at Document Type level: 
When only Document type(s) are selected, XMLs log would be enabled for Determination 
Companies and SAP Ariba Realm(s) Customer have on Determination (across SAP Ariba 
Realms(s) and Determination Companies). 

• Enabling XMLs log at SAP Ariba Realm/Determination Company level: 
XMLs logs will be enabled for selected SAP Ariba Realm and Determination Company 
combination. 

• Enabling XMLs log at SAP Ariba Realm/Determination Company/Document Type combination 
level: 
This setting would enable XMLs at selected SAP Ariba Realm, Determination Company and 
Document Type levels. This is most optimized level where logs will be enabled and transaction 
logs will be generated at levels which are truly required. 

Please make sure that External ID is maintained for Determination Company in ONESOURCE 
Determination system. Even one of the Determination Companies under a Tenant ID without 
External ID will lead to error “Cannot save these settings. Please review.” while saving XMLs 
log enablement (Enable XMLs log Add/Edit configuration). 

CONFIGURATION 

To enable XMLs log, please follow below steps: 
  

1. On Home screen, go Configuration > XMLs Log Enablement. 

2. Click on XMLs Log Enablement option. 

3. You will be navigated to XMLs Log Enablement screen. 

This UI screen will show Enable XMLs log add button and a display grid. Enable XMLs log button 
enable user to add new logging. And the display grid will show log settings when added. 

By default, XML logs will not be enabled. You may not see any existing configuration when you are 
setting up Integration for the first time. 

ÿ ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaTestConfig
TENANT-IndirectTaxIntegrationsQA

Home Configuration Ariba IntegrationSettings Logs

Ariba RealmSpecificConfigurations

XMLsLogEnablement

TaxSummarization

CustomField Mapping

ÿ
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4. Click on Enable XMLs Log button to enable XMLs. 

SAP Ariba Realm is an optional selection. You can skip selecting SAP Ariba Realm but choose 
to enable XML at Determination Company and Document Type level. If you do not select any 
SAP Ariba Realms, XML Logs will be enabled for all your valid SAP Ariba Realms in the 
Integration. 

5. On this UI screen make selection at which you would like to enable XMLs. 

a. Click on SAP Ariba Realm button (Clickable) to select the SAP Ariba Realm for which you 
would like enable XML Logs. You will see a window opening and showing list of SAP Ariba 
Realms. 

Home Configuration AribaIntegrationSettings Logs

XMLs Log Enablement

Enable XMLs Log

ID Action SAP Ariba Realm DeterminationCompany Document Type

XMLs Log Enablement
SAPAribaRealm

Select SAP Arlba Realms

Determination Company Name

Select Companles

Document Type

Select Document Types

SAVE CANCEL
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b. Select SAP Ariba Realm ID from the list as shown in screenshot based on your requirement. 
(The values are pre-populated based on User’s Tenant ID).   

c. Click on DONE button once you are done with selecting SAP Ariba Realm(s). The selection 
window disappears and the selections made are shown on XML Log Enablement main 
screen under SAP Ariba Realm field. 

ONESOURCEGLOBA
Show All Show Selected

Home enter SAP AribaConfiguration
Q1 Realm ID in

search field if
known for quick

XMLs Log Enablen (Select All) search

SAP Ariba Realm QA_TEST select check
Select SAP Arlba Realms box to select

all

Determination Company Nameselect check box
Select Companles against

individual items
to make specific

Document Type selections

Select Document Types

SAVE CANCEL

DONE
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d. Select Determination Companies by clicking on SELECT COMPANIES button. UI would 
present you a pop up window to make selections as shown in the below screenshot. 

XMLs Log Enablement
SAPAriba Realm

QA_TEST Select SAPArlba Realms

Determination Company Name

Select Companles

Document Type

Select Document Types

SAVE CANCEL
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e. To find companies:   

 search by name in the Search box or, 

 click on Show all (to see the complete list) or, 

 click on Show selected if you have already made some selections. 

f. Select one or more companies from the list (if list is big, scroll bar helps to find the desired 
selection) and click on DONE button. Selected company/companies’ will be shown on UI 
under Determination Company Name UI field. 

ONESOURCEC
Show All Show Selected

Home Configuratior

enter Company
XMLs Log Enal (Select All) Nameherefor

quick search
SAP Ariba Realm Ariba DE

QA_TEST Select SAP click check
Ariba GB box against

select allto
Determination CompanyAriba US selectall

entries
Select Companles

AribaA

Document Type AribaB click individual
check boxto make

Select Document Types

SAVE CAI

DONE
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g. Click on SELECT DOCUMENT TYPEs button to select SAP Ariba document type(s). 

h. Integration UI would present a pop up showing two document types (PR and IR). 

XMLs Log Enablement
SAPAriba Realm

QA TEST SelectSAPArlba Realms

Determination Company Name

Ariba US Select Companles

Document Type

SelectDocument Types

SAVE CANCEL
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i. Select desired document type like how SAP Ariba Realm and Determination Company 
entries are selected and click on DONE button when you are done with making selections 
based your requirement. 

j. Your selection will be shown under Document Type UI field label. 

ONESOURCEGLOB
Show All Show Selected

Home Configuration
Q1

XMLs Log Enablel  (Select All)

SAP Ariba Realm Purchase Requisition (PR)

QA_TEST Select SAP Ariba
Invoice Reconciliation (IR)

Determination Company Name

Ariba US Select Companles

Document Type

Select Document Types

SAVE CANCEL

DONE
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6. Click on SAVE button to save the changes and continue.   

7. A confirmation message is promoted and if you would like to continue, click on YES button. 
(otherwise click on NO and you will be back on XMLs log enablement screen where you can make 
changes and continue or cancel the action to go to main XMLs Log enablement UI screen) 

8. You will be navigated to XMLs Log Enablement main UI screen where you can see the display grid 
reflecting the changes made. 

XMLs Log Enablement
SAPAribaRealm

QA_TEST Select SAP Arlba Realms

Determination Company Name

Ariba US Select Companles

Document Type

All (2) selectedSelect Document Types

SAVE CANCEL

XMLs Log Enablement
SAP Ariba Realm

QA_TEST Select SAP Ariba Realms

Determination Company Name
Are you sure you want to save the changes?

Ariba US Select Companles

Document Type YES NO

All (2) selected Select Document Types

SAVE CANCEL
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9. Display grid shows a clickable button with text showing number of entries for columns SAP Ariba 
Realm, Determination Company and Document Type when there is more than one entry for that 
selection parameter. 

10. Click on any button showing number of entries to see the details of selections for that parameter. 

XMLs Log Enablement

EnableXMLs Log

ID Action SAPAriba Realm Determination Company DocumentType

QA_TEST 2 Companies 2 Document Types

XMLs Log Enablement

no clickablebutton
for single entry

Enable XMLs Log
clickablebutton
formultiple

ID Action SAPAribaRealm Determination Company selections Document Type

6 QA_TEST Ariba US 2 Document Types

9 ÿ QA TEST 2 Companies 2 Document Types

3 ÿ QA_TEST 4 Companies 2 Document Types

XMLs Log Enablement

Document Type List:
Enable XMLs Log

click to close

Purchase Requisition (PR) selected
ID Action values

Document Type

6
Involce Reconclllatlon (IR)

2 Document Types

9
click to close oruseX mark 2 Document Types

OK
ontoprightofthepopup

2 Document Types

XMLs Log Enablement
Determination Company List:

 Enable XMLs Log SAP QA GB 2000 ECC-Arlba

ID Action SAP QA CA 4000 ECC-Arlba Document Type

SAP QA DE 1000 ECC-Arlba
6 2 Document Types

SAP QA US 3000 ECC-ARIBA
6 2 Document Types

3 2 Document Types
OK
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Note on SAVING XMLS Log Enablement without making any selection. 

If no selections are made on XML Log Enablement button but you click on Save button, a pop-up 
window appears to prompt you that you have not made any selection and would like to continue or 
just leave the page without making any selections. 

If no selection made but you have clicked on SAVE button, XMLs will be enabled for all your 
configured SAP Ariba Realms, Determination Companies and two Document Types. 

Display Grid showing SAP Ariba Realm and all Determination Companies and two Document Types 
selected automatically when you just SAVE without making any specific selections. 

If you do not want to enable XMLs at any level, click on NO button and you will stay on the XML Log 
Enablement page. 

EDIT XMLS LOG ENABLEMENT 
To edit the XMLs logging settings, please follow below steps: 

1. Click on edit (pencil icon) on the row in the display grid for which XMLs enablement logging you 
would like to make change. 

XMLs Log Enablement
SAP Ariba Realm

Select SAP Arlba Realms

Determination Company Name You have not made any specific selection, XMLs Logs will be enabled for all parameters

Select Companles and for all available options. Do you want to continue?

Document Type
YES NO

Select Document Types

SAVE CANCEL

XMLs Log Enablement

Enable XMLs Log

ID Action SAP Ariba Realm Determination Company Document Type

3 QA_TEST 16 Companies 2 Document Types

10 QA_TEST 5 Companies 2 Document Types

ÿ QA_TEST 2 Companies 2 Document Types
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2. Integration would navigate you to the Edit XML Log Enablement screen 

3. Please make changes as desired. (you may refer steps 5 a to f under Configure XMLs Enablement) 
to make changes to SAP Ariba Realm, Determination Company Name and Document Type 
selections. 

XMLs Log Enablement

Enable XMLs Log

ID Action SAPAribaRealm Determination Company DocumentType

4 ÿ QA_TEST Ariba US 2 Document Types

ONESOURCEGLOBALT
Show All Show Selected

Home Configuration Arib
Q1

Edit XMLs Log Enabl

SAP Ariba Realm  Ariba DE

QA_TEST Select SAPArlba Reali
Ariba GB

Determination Company Name M

Ariba US Select Companles
AribaA

Document Type AribaB

All (2) selected Select Document

SAVE CANCEL

DONE
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4. Once changes are made, click on SAVE button on Edit XMLs Log Enablement screen. You would be 
prompted for confirmation. 

5. Click on YES button to confirm the action. Integration saves the changes and you would be navigated 
to XMLs Log Enablement main UI screen where display grid shows (click on drop-down list) the 
updates made. 

Edit XMLs Log Enablement
SAPAribaRealm

QA_TEST Select SAP Arlba Realms

Determination Company Name

2 selected Select Companles

Document Type

All (2) selected Select Document Types

SAVE CANCEL

Edit XMLs Log Enablement
SAP Ariba Realm

QA_TEST Select SAP Arlba Realms

Determination Company Name
Are you sure you want to save the changes?

2 selected Select Companles

Document Type YES NO

All (2) selected Select Document Types

SAVE CANCEL

XMLs Log Enablement

EnableXMLs Log

ID Action SAPAriba Realm Determination Company DocumentType

QA_TEST 2 Companies 2 Document Types
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DELETE XMLS LOG ENABLEMENT 
To delete XMLs logging settings, please follow the below steps. 

1. Click on the trash can icon in the display grid Action column for the row you would like to delete. 

2. You will be prompted to confirm the decision. 

3. Click on YES button to confirm the delete action. You can see a system message as shown in below 
screenshot about the status of the action. 

4. The display grid reflects the change made, deleting the selected entry. 

XMLs Log Enablement

EnableXMLs Log

ID Action SAPAribaRealm Determination Company Document Type

ÿ QA_TEST 2 Companies 2 Document Types

XMLs Log Enablement

Enable XMLs Log

Are you sure you want to delete this record?
D Action Document Type

ÿ 2 Document Types
YES NO

3 2 Document Types

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaTestConfig
TENANT - Indirect Tax Integrations QA

Deleted successfuly
Home Configuration Ariba Integration Settings

XMLs Log Enablement

 Enable XMLs Log

ID Action SAP Ariba Realm Determination Company Document Type

QA_TEST 2 Companies 2 Document Types

QA_TEST 4 Companies 2 Document Types
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TAX SUMMARIZATION 
Tax Summarization feature is an optional configuration available on Integration User interface. 

The Tax Summarization (Configuration > Tax Summarization) screen contain two sections. 

1. Tax Summarization Configuration 

2. Tax Types Mapping 

XMLs Log Enablement

EnableXMLs Log

ID Action SAPAriba Realm DeterminationCompany DocumentType

3 ÿ QA_TEST 4 Companies 2 Document Types

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaTestConfig
TENANT-IndirectTaxIntegrationsQA

Home Configuration AribaIntegrationSettings Logs

AribaRealmSpecificConfigurations

XMLsLogEnablement

TaxSummarization

CustomFieldMapping
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The section Tax Summarization Configuration section contain US Tax Summarization Options and 
VAT Summarization Options which is NOT required for Integration version 1.0.3.x. 

Even if any configuration is made on this section by mistake, it will be ignored by Integration software with 
version 1.0.3.x. 

Integration UI also shows a pop window as shown below to guide 1.0.3.x users that this feature 
configuration is not at all required. 

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS QAe Config
TENANT - Indirect Tax Integrations QAe

Home ConfigurationAriba Integration SettingsLogs

Tax Summarization Configuration

US Tax Summarization Options
Default tax response is at Tax Authority level detail but optionally user can configure one of two summarization levels.

VAT Summarization Options

Default tax response has both Input Tax and Recovery Tax blocks but optionally user can configure summarized response option.

US Tax Summarization Options VAT Summarization Options

 Authority Detail Input and Output Authorities 

US Tax Summarization Options VAT Summarization Options

Tax Types Mapping
ONESOURCE Determination Tax Code Qualifier based Ariba Tax Type mapping takes precedence over the Tax Summarization Configuration

Tax Code Qualifier based Ariba Tax Type Mapping 
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The other section Tax Types Mapping is also an optional configuration but this can be used with 
Integration version 1.0.3.x 

To know more about Tax Types Mapping feature please check Tax Code Qualifier Based Ariba Tax Type 
Mapping section in this document. And check Configuration for enabling this feature. 

Tax Summarization optional configuration available on Integration UI allows users to set up the granularity 
of tax information sent to SAP Ariba system. 

ONESOURCE Global Tax for SAP Ariba Solutions 1.0.3.x which supports SAP Ariba enhanced Tax API 
by default offers tax summarization and hence 1.0.3.x users need NOT to configure this functionality. 

CUSTOM FIELD MAPPING 
Ariba allows Custom fields to cover functionality not available through out of the box standard fields. 
ONESOURCE Determination also enables Customers to use custom fields known as Determination User 
Elements for tax calculation and audit purposes. 

The Custom Field Mapping functionality on Ariba Integration allows you to map Ariba Custom fields to 
ONESOURCE Determination User Elements. 

ONESOURCE allows Determination User Elements from 1 to 40 only. Ariba Integration has validation in 
place to check this reservation. 

Customers need to work with SAP Ariba Customer Support to have Custom fields 
created in their SAP Ariba Buying Solution. 

To have Custom fields work on ONESOURCE tax calculation and or audit, it should be 
first defined in Ariba Buying Solution and those custom fields should be mapped to 
Determination User Elements. 

Tax Summarization Configuration 

US Tax Summarizat ion Options 

Default tax response is at Tax Authority level detail but 

VAT Summarization Options 

Default tax response has both Input Tax and Recovery 

US Tax Summariza 

Authority Detail 

' • 

Please note that Integrat ion Users using Ariba Tax APIZ are not 

required to configure Tax Summarization as it is determined 

automat ically. Any configuration made here for Tax 

Summarization opt ions will be ignored. 

c::=J 
____ _ Options 

dropdown Input and Output Authorities dropdown

ÿ
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CREATE CUSTOM FIELD MAPPING 
To configure the Custom Field Mapping, please follow below navigation steps: 

1. Log in to ONESOURCE Global Tax for SAP Ariba Solutions. 

2. On Home screen, go to Configuration > Custom Field Mapping 

3. Click on Custom Field Mapping option. You will be navigated to Custom Field Mapping screen where 
you would see Add Custom Fields button and a “Display Grid”. Display Grid will show Custom Field 
Mappings that are configured through this UI page. 

4. Click on Add Custom Fields button located on top of the display grid to create mapping. 

5. You will be navigated to Add Custom Mapping screen where you can create mapping. 

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaTestConfig
TENANT-IndirectTaxIntegrationsQA

Home Configuration AribaIntegrationSettings Logs

AribaRealmSpecificConfigurations

XMLsLogEnablement

TaxSummarization

CustomFieldMapping

CustomField Mapping

 Add Custom Fields

ID Action SAP Ariba Realm Document Level Custom Type Ariba Field Name DeterminationUserElementID

11 ÿ QA_TEST LINE CUSTOM_STRING Testing 1

17 ÿ QA_TEST LINE CUSTOM INTEGER Integer 4

15 ÿ QA_TEST LINE CUSTOM_DATE Date 3

10 ÿ QA_TEST INVOICE CUSTOM_DATE Date 3
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This screen has below fields to configure the mapping. 

a. SAP Ariba Realm:   

a) This is a required field. The input type is drop-down list where you can select the values 
from the pre-populated list. The list is pre-populated based on SAP Ariba Realms set up 
under User’ 

It is required to create SAP Ariba Realms first under SAP Ariba Realm Specific 
Configurations section if it is not done already. 

b. Document Level: 

a) This is also a required field and input type is drop-down list 

b) Integration has two pre-populate values that are Invoice and Line 

c) The Invoice level also means Document level or Header level where a field at this level 
applicable to the whole document. 

  

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS

Home ConfigurationAriba Integration SettingsLogs

Add Custom Mapping
SAP Ariba Realm *

Document Level *

Custom Type *

Ariba Field Name *

Determination User Element ID *

SAVE CANCEL
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c. Custom Type: 

a) This is a required entry presented as drop-down list. 

b) The available values are: 
1. CUSTOM_BOOLEAN 
2. CUSTOM_DATE 
3. CUSTOM_INTEGER 
4. CUSTOM_STRING 

c) Select the value here, based on the type of Ariba Custom field. 

d. Ariba Field Name: 

a) This is a required text field. Enter the name of the Ariba Field here, that is defined and 
maintained in the SAP Ariba Buying Solution. 

Integration cannot validate the Ariba Custom field that is maintained in the SAP Ariba 
Buying Solution so please make sure to enter correct name of the Ariba field here. 

e. Determination User Element ID: 

a. This is a required text field. Please choose Determination User Element IDs from 1 to 40 
only. 

b. Integration checks the range (1-40) and shows error if the value is not in between the 
range. 

6. Select SAP Ariba Realm, Document Level, Custom Type and enter Ariba Field Name and 
Determination User Element ID which you would like map. 
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7. Click on SAVE button to create the mapping. You would be prompted to confirm the changes. 

8. Click on YES to continue. When clicked on YES button, you would be navigated back to Custom Field 
Mapping main UI Screen where you can see the display grid showing the mapping that has been 
created. 

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS

Home Configuration Ariba Integration SettingsLogs

Add Custom Mapping
SAP Ariba Realm *

QA_TEST

Document Level *

INVOICE

Custom Type *

CUSTOM_STRING

Ariba Field Name *

CostCenter

Determination User Element ID *

12

SAVE CANCEL

Add Custom Mapping
SAP Ariba Realm *

QA_TEST

Document Level *

INVOICE Are you sure you want to save the changes?

Custom Type *

CUSTOM_STRING YES NO

Ariba Field Name *

CostCenter

Determination User Element ID *

12

SAVE CANCEL
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Repeat steps from 1-8 to create more mappings as desired. 

If clicked on NO button in step 8, pop up would disappear and you would be on Add Custom 
Field Mapping screen.   

1. Here you may make changes and click on SAVE button to create the mapping. OR 

2. To cancel the created mapping, click on CANCEL button so that you would be navigated 
back to Custom Field Mapping main UI Screen. Display grid would not be updated as 
user’s action is cancelled. 

Validation rule does not allow mapping the same Determination User Element ID to any other 
Ariba Field at the same Document level and Custom Type under the same SAP Ariba Realm 

EDIT CUSTOM FIELD MAPPING 
To edit an existing mapping follow below steps: 

1. Click on the Edit (pencil) icon on the row in the display grid for which you would like to make changes. 

Custom Field Mapping

This Custom Field Mapping page is to view and configure Custom Field Mappings for your SAP Ariba Realm.
udde play wosn mau e aei oiyu ey wosn pp, a poaes ahed s uo budde paly wosn ino as pou op no  

 Add Custom Fields

ID Action SAP Ariba Realm Document Level Custom Type Ariba Field Name Determination User Element ID

11 ÿ QA_TEST LINE CUSTOM_STRING Testing

17 ÿ QA_TEST LINE CUSTOM_INTEGER Integer 4

15 ÿ QA_TEST LINE CUSTOM_DATE Date 3

10 ÿ QA_TEST INVOICE CUSTOM_DATE Date

12 ÿ LINE CUSTOM_BOOLEAN Boolean 2

13 ÿ QA_TEST INVOICE CUSTOM_BOOLEAN Boolean 2

14 ÿ QA_TEST INVOICE CUSTOM_STRING Testing 1

16 A INVOICE CUSTOM_INTEGER Integer 4

19 ÿ QA_TEST INVOICE CUSTOM_STRING CostCenter 12

ÿ
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Custom Field Mapping 
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2. Integration allows changes to Ariba Filed Name and Determination User Element ID. Here you can 
make changes as desired and click on SAVE 

  

 Add Custom Fields

ID Action SAP Ariba Realm Document Level Custom Type Ariba Field Name Determination User Element ID

11 ÿ QA_TEST LINE CUSTOM_STRING Testing

17 ÿ QA_TEST LINE CUSTOM_INTEGER Integer 4

15 LINE CUSTOM_DATE Date 3

10 QA_TEST CUSTOM_DATE Date 3

12 QA_TEST LINE Boolean 2

13 QA_TEST INVOICE CUSTOM_BOOLEAN 2

14 ÿ QA_TEST INVOICE CUSTOM_STRING Testing 1

16 ÿ QA_TEST INVOICE CUSTOM INTEGER Integer 4

19 ÿ QA_TEST INVOICE CUSTOM_STRING CostCenter 12

Edit Custom Mapping
SAP Ariba Realm*

QA_TEST

Document Level *

INVOICE

Custom Type *

CUSTOM_STRING

Ariba Field Name 

CostCenter

Determination User Element ID *

12

SAVE CANCEL
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CONFIGURATION GUIDE 

3. You will be prompted to confirm the change 

4. If you select YES, system will take you to Custom Field Mappin main screen where display grid 
shows changes made. 

Edit and Add Custom field mapping configuration have same validation logic. 

DELETE CUSTOM FIELD MAPPING 
To delete custom field mapping, please follow below steps: 

1. Click on delete icon on the row in the display grid which you would like to get deleted. 

Edit Custom Mapping
SAP Ariba Realm *

QA_TEST

Document Level *

INVOICE Are you sure you want to save the changes?

Custom Type *

CUSTOM_STRING YES NO

Ariba Field Name *

CostCenter-2

Determination User Element ID *

12

SAVE CANCEL

CustomField Mapping

This Custom Field Mapping page is to view and configure Custom Field Mappings for your SAP Ariba Realm.
If you do not see your Custom Field Mapping on this page, select the “Add Custom Fields" link to create a new Custom Field Mapping.

AddCustomFields

ID Action SAP Ariba Realm Document Level Custom Type Ariba Field Name DeterminationUserElementID

I QA_IES1 LIINC LUSTUMI_OIRIING Tesuny

17 QA_TEST LINE CUSTOM_INTEGER Integer 4

15 ÿ QA_TEST LINE CUSTOM_DATE Date

10 ÿ QA_TEST INVOICE CUSTOM_DATE Date 3

12 ÿ LINE CUSTOM_BOOLEAN Boolean 2

13 ÿ QA_TEST INVOICE CUSTOM_BOOLEAN Boolean 2

14 ÿ QA_TEST INVOICE CUSTOM_STRING Testing 1

ÿ QA_TEST Integer 4

19 ÿ QA_TEST INVOICE CostCenter-2 12
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CONFIGURATION GUIDE 

2. You will be prompted to confirm the action. 

3. Click on YES button to continue to delete the mapping. You would see the message confirming the 
deletion and display grid would not show the entry that has been deleted. 

CustomField Mapping

This Custom Field Mapping page is to view and configure Custom Field Mappings for your SAP Ariba Realm.

If you do not see your Custom Field Mapping on this page, select the “Add Custom Fields" link to create a new Custom Field Mapping.

Add CustomFields

ID Action SAP Ariba Realm Document Level Custom Type Ariba Field Name DeterminationUser ElementID
I1 LIINL LUOTUIWI_OIRIINU bunsal

17 ÿ QA_TEST LINE CUSTOM_INTEGER Integer 4

15 ÿ QA_TEST LINE CUSTOM_DATE Date 3

10 INVOICE CUSTOM_DATE Date 3

12 ÿ QA_TEST LINE CUSTOM_BOOLEAN Boolean 2

13 ÿ INVOICE CUSTOM_BOOLEAN Boolean 2

14 ÿ QA_TEST INVOICE CUSTOM_STRING Testing 1

16 ÿ QA_TEST INVOICE CUSTOM_INTEGER Integer 4

19 ÿ QA_TEST INVOICE CUSTOM_STRING CostCenter-2 12

Custom Field Mapping

 This Custom Field Mapping page is to view and configure Custom Field Mappings for your SAP Ariba Realm.
If you do not see your Custom Field Mapping on this page, select the *Add Custom Fields" link to create a new Custom Field Mapping.

 Add Custom Fields

ID Action SA Determination User Element ID

Are you sure you want to delete this record?
17

15 ÿ NO 3

10 ÿ 3

ÿ QA_TEST LINE Boolean 2

13 ÿ QA_TEST INVOICE CUSTOM_BOOLEAN 2

14 ÿ QA_TEST INVOICE CUSTOM_STRING Testing

16 ÿ QA_TEST INVOICE CUSTOM_INTEGER Integer 4

ÿ QA_TEST INVOICE CUSTOM_STRING CostCenter-2 12
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CONFIGURATION GUIDE 

ARIBA INTEGRATION SETTINGS 
Ariba Integration Settings gives provision to maintain Health Check Entries settings and Tax Block 
Negation table. These settings are managed by Thomson Reuters for Cloud customers, and by your 
system administrator in on-premise. Do not change them unless adviced. 

HEALTH CHECK ENTRIES 
Two input fields are offered to enter maximum number of health check history entries and health check 
entries duration. 

To configure health check entries and tax block negation table, please follow below steps: 
1. Log in to ONESOURCE Global Tax for SAP Ariba Solutions Integration UI. 
2. On Home screen, click on Ariba Integration Settings. 

3. You will be navigated to Add Integration Settings screen. This UI screen has sections for Health 
check entries set up and Tax block negation table. The highlighted in below screenshot shows the 
health check entries section. 

Home ConfigurationAriba Integration SettingsLogs
Mapping has been deleted successfuly

CustomField Mapping

This Custom Field Mapping page is to view and configure Custom Field Mappings for your SAP Ariba Realm.
If you do not see your Custom Field Mapping on this page, select the "Add Custom Fields" link to create a new Custom Field Mapping.

 Add CustomFields

ID Action  SAP Ariba Realm Document Level Custom Type Ariba Field Name Determination User ElementID

11 ÿ QA_TEST LINE CUSTOM_STRING Testing

17 ÿ QA_TEST LINE CUSTOM_INTEGER Integer 4

15 ÿ QA_TEST LINE CUSTOM_DATE Date 3

10 ÿ QA_TEST INVOICE CUSTOM_DATE Date 3

12 QA_TEST LINE CUSTOM_BOOLEAN Boolean 2

13 ÿ QA_TEST INVOICE CUSTOM_BOOLEAN Boolean 2

14 ÿ QA_TEST INVOICE CUSTOM_STRING Testing 1

16 ÿ QA_TEST INVOICE CUSTOM_INTEGER Integer 4

ÿ ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaTestAdmin
TENANT-IndirectTaxIntegrationsQA

Home Configuration AribaIntegrationSettings Logs
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Ariba Integration Settings 
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The default values you would see in the configuration are: 

Health Check Max History Entries (Number)=20 
Health Check Entries History Duration (Milliseconds)=300000 

4. To update the default values, enter desired number (only whole number accepted) in both the Health 
Check Max History Entries (Number) and Health Check Entries History Duration (Milliseconds). 

Home Configuration  Ariba Integration SettingsLogs

Add Integration Settings
Health Check Max History Entries (Number)

20

Health Check Entries History Duration (Milliseconds)

300000

SAVE CANCEL

Tax Block Negation
 Defines which tax block(s) to negate from Determination before sending to Ariba.

 Add Tax Block Negation

ID Action Tax Type Tax Direction

ÿ AC 0

2 ÿ 0

3 ÿ

ÿ IR 0

5 ÿ RC 0
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Ariba Integration Settings 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

5. Click on SAVE button to make the changes. UI would show banner message that the entries are 
saved successful.   

TAX BLOCK NEGATION 
Tax block negation table allows Integration users to set up negation logic based on ONESOURCE IDT 
Determination Tax Type and Tax Direction. Determination returns the tax type and tax direction for each 
tax block in its response. And Integration (ONESOURCE Global Tax for SAP Ariba Solutions) negates the 
tax amount in a tax block based on the configuration found in this table for a tax type.   
Integration negates the tax amount when the Tax direction is O (output). 

The Integration UI is delivered with below tax block negation table: 

Home Configuration Ariba Integration Settings Logs

AddIntegrationSettings
Health Check Max History Entries (Number)

50

Health Check Entries History Duration (IMilliseconds)

320000

SAVE CANCEL

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaTestAdmin
TENANT - Indirect Tax Integrations QA

Your changes have been saved successfuly
Home Configuration Ariba Integration Settings

Add Integration Settings
Health Check Max History Entries (Number)

50

Health Check Entries History Duration (Milliseconds)

320000

SAVE CANCEL
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Ariba Integration Settings 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
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ONESOURCE Global Tax for SAP Ariba Solutions OP Users, may contact Thomson Reuters 
ONESOURCE Customer Support for any questions on modifying (update, edit, delete) the 
entries in the table. 

For OP Customers, DBA/System Admin users should have Integrations Admin role to perform 
changes to SAP Ariba Integration Settings   

UPDATE TAX BLOCK NEGATION 
To modify the tax block negation table, please follow below steps: 

1. Log in to ONESOURCE Global Tax for SAP Ariba Solutions Integration UI. 

2. On Home screen, click on Ariba Integration Settings. 

3. You will be navigated to Add Integration Settings screen where you can see Tax Block negation table 
with default values. 

TAX TYPE DIRECTION 
AC O 
ER O 
IM O 
IR O 
RC O 

ÿ

https://tax.thomsonreuters.com/support/onesource/indirect-tax/
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Ariba Integration Settings 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

ADD NEW ENTRIES 
1. To add new entries, click on Add Tax Block Negation button 

Home Configuration Ariba Integration SettingsLogs

Add Integration Settings
Health Check Max History Entries (Number)

50

Health Check Entries History Duration (Milliseconds)
320000

SAVE CANCEL

Tax Block Negation
Defines which tax block(s) to negate from Determination before sending to Ariba.

 Add Tax Block Negation

ID Action Tax Type Tax Direction

AC Q

2 ÿ 0

3 ÿ

4 ÿ ÿ 0

5 ÿ RC

TaxBlockNegation
Defines which tax block(s) to negate from Determination before sending to Ariba.

 Add TaxBlock Negation

ID Action Tax Type TaxDirection

ÿ AC

2 ÿ ER

3 IM O

4 ÿ IR

5 ÿ RC
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You will be navigated to Add Tax Block Negation screen.   

a. Enter Tax Type to be added (these should be standard tax types defined in ONESOURCE 
Determination).   

b. And click on triangle button on Tax Direction drop-down list 

c. Tax Direction drop-down shows two default values (I and O) where I is input and O is output. 

Home Configuration AribaIntegrationSettings Logs

AddTaxBlockNegation
Defines which tax block(s) to negate from Determination before sending to Ariba.
Do not change these settings unless instucted by Thomson Reuters.

Tax Type *

RC

Tax Direction *
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d. Select the direction (in this example) 

Home ConfigurationAriba Integration SettingsLogs

Add TaxBlock Negation
Defines which tax block(s) to negate from Determination before sending to Ariba.
Do not change these settings unless instucted by Thomson Reuters.

Tax Type *

RC

Tax Direction *

SAVE CANCEL
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2. Click on SAVE button. You will be navigated to Ariba Integrations Settings UI screen where the 
display grid under Tax Block Negation shows the entry that is added 

EDIT EXISTING ENTRIES 
Let’s say you have an entry with AC and Direction I. If you would like to make it correct where it is 
supposed to be AC and I follow below steps to edit the entry. 

1. Click on Edit (pencil icon) on the row in the Tax Block Negation table for which you would like to 
make an edit. 

  

TaxBlockNegation
Defines which tax block(s) to negate from Determination before sending to Ariba.

AddTaxBlockNegation

ID Action TaxType Tax Direction

AC

2 ÿ ER

3 ÿ IM O

4 ÿ IR

5 ÿ RC

TaxBlockNegation
Defines which tax block(s) to negate from Determination before sending to Ariba.

Add TaxBlockNegation

ID Action Tax Type Tax Direction

1 ÿ AC

2 ER

3 ÿ IM

ÿ IR

5 RC
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2. You will be navigated to Edit Tax Block Negation screen 

3. Click triangle button on drop-down and select the direction (in this case it should be O) 

Home Configuration AribaIntegration SettingsLogs

Edit Tax Block Negation
Defines which tax block(s) to negate from Determination before sending to Ariba.
Do notchange thesesettings unlessinstucted byThomsonReuters.

Tax Type *

AC

Tax Direction *

SAVE CANCEL

Home Configuration Ariba Integration SettingsLogs

EditTaxBlockNegation
Defines which tax block(s) to negate from Determination before sending to Ariba.
Do not change these settings unless instucted by Thomson Reuters.

Tax Type*
AC

Tax Direction *

CANCEL
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4. Click on SAVE button make changes saved. You will be navigated to Add Integration Settings UI 
screen where display grid shows the updated value for tax type AC. 

DELETE EXISTING ENTRIES 
To delete any entry from Tax Block Negation table, follow these below steps. 

1. Click on the Delete icon as shown in the below screenshot. 

  

TaxBlockNegation

Defineswhich tax block(s)to negate from Determination before sending to Ariba.

Add TaxBlockNegation

ID Action Tax Type Tax Direction

AC

2 ÿ ER O

3 ÿ IM ÿ

4 ÿ IR

5 ÿ RC

TaxBlockNegation
Defines which tax block(s) to negate from Determination before sending to Ariba.

Add Tax Block Negation

ID Action Tax Type Tax Direction

ÿ AC

2 ÿ ER

3 IM

ÿ IR

6 ÿ NR O

5 ÿ RC
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2. You will be promoted to confirm the action. 

3. Click on YES button to continue. You will see system message that the entry has been deleted 
successfully. And display grid also gets updated. 

  

TaxBlockNegation
Defines which tax block(s) to negate from Determination before sending to Ariba.

 Add Tax Block Negation Are you sure you want to delete this record?

ID Action ction

YES NO
ÿ

2 ÿ ER

ÿ IM

ÿ IR

6 NR

ÿ RC

Health Check Entries History Duration (Milliseconds)

320000 Deleted successfuly

SAVE CANCEL

TaxBlockNegation
Defines which tax block(s) to negate from Determination before sending to Ariba.

Add TaxBlockNegation

ID Action Tax Type Tax Direction

AC ÿ

ÿ 0

3 ÿ IM

4 ÿ IR 0

5 ÿ RC 0
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ARIBA SUMMARIZED TAX TYPES 
Ariba Summarized Tax Types is an Integration Database Table. This table helps Integration 
(ONESOURCE Global Tax) identify the summarized vs granular tax on the source system tax calculation 
request. 

This table contains Ariba out of the box summarized tax types like SalesTax and SUTTax by default. The 
contents of the table can be seen on ONESOURCE Global Tax Integration User Interface screen Ariba 
Summarized Tax Types Configuration (Home > Ariba Summarized Tax Types > Ariba Integration 
Settings. 

There is no additional set up/configuration required by Integration users and please do not 
edit/delete the default contents of this table. 

If for any reason like new taxable country being supported by ONESOURCE Global Tax or new 
Ariba tax type introduced in SAP Ariba Buying Solution and that tax types are required on this 
table, then it can be extended by using add/edit options on the Ariba Summarized Tax Types 
Configuration UI screen. 

ONESOURCE Global Tax Integration Cloud version users need to request Thomson Reuters 
Professional Team or Customer Support for changes (adding new entry) to this table.   
On Premise users with role Integrations Admin will have authorization make changes to this      
table. 

Please follow below steps to make changes to the table (add/edit/delete). 

ADD NEW ENTRIES 
1. Log on to ONESOURECE Global Tax Integration User Interface. 

2. Navigate to click on Home > Ariba Integration Settings > Ariba Summarized Tax Types   

3. Click on Ariba Summarized Tax Types button 

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS

Home Configuration AribaIntegrationSettings Logs

HealthCheckandTaxBlockNegatlon

ArlbaSummarized TaxTypes

ÿ
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4. Enter Ariba Tax Type name in the input field. 

5. Click on SAVE button to continue to add the entry (CANCEL button aborts the change and take you 
to main screen). 

6. A pop up shows up for confirmation. Click on YES button to confirm the change. 

Home Configuration Ariba Integration SettingsLogs

Ariba Summarized Tax Types Configuration

Note1: Please create Ariba Summarized Tax Type exactly as it is defined (case sensitive) in Ariba Buying Solutions.

Note2: While you perform Edit, or Delete actions on an existing entry, please consider impact on Ariba Tax Response to Ariba Buying Solution.

AribaSummarizedTaxTypes

ID Action Ariba Summarized Tax Type

SalesTax

2 ÿ SUTTax

Home Configuration Ariba Integration Settings Logs

Add Ariba Summarized Tax Type

Ariba Summarized Tax Type*

ARIBA TAX TYPE

SAVE CANCEL
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7. The newly added entry will be shown in the grid on the main screen 

EDIT EXISTING ENTRIES 
1. Click on Edit button on the grid entry (Ariba Summarized Tax Types Configuration UI Screen) as 

shown below 

2. Update name of the Ariba tax type in the input field 

Home Configuration Ariba Integration Settings Logs

Add Ariba Summarized Tax Tvne

Are you sure to make this change?Ariba Summarized Tax Type*

ARIBA TAX TYPE

YES NO

SAVE CANCEL

Home Configuration AribaIntegrationSettingsLogs

Ariba Summarized Tax Types Configuration

Note1: Please create Ariba Summarized Tax Type exactly as it is defined (case sensitive) in Ariba Buying Solutions.

Note2: While you perform Edit, or Delete actions on an existing entry, please consider impact on Ariba Tax Response to Ariba Buying Solution.

+ Ariba Summarized Tax Types

ID Action AribaSummarizedTaxType

4 ÿ ARIBATAXTYPE

SalesTax

2 SUTTax

AribaSummarized TaxTypes

ID Action Ariba Summarized Tax Type

ARIBATAXTYPE

SalesTax

2 ÿ SUTTax
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Ariba Integration Settings 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

3. Click on SAVE button (CANCEL button will abort the change and takes you back to main screen). 

4. A pop up shows up prompting for confirmation. Click on YES to continue (NO button will take you 
back to Edit screen). 

5. Change will be reflected on the main screen in the screen grid. 

Home Configuration Ariba Integration Settings Logs

Edit Ariba Summarized Tax Type

Ariba Summarized TaxType*

ARIBA TAX TYPE X

SAVE CANCEL

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS

Home Configuration Ariba Integration Settings Logs

Edit Ariba Summarized Tax Tvne

Are you sure to make this change?Ariba Summarized Tax Type*

ARIBA TAX TYPE X

YES NO

SAVE CANCEL
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Ariba Integration Settings 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

DELETE ENTRIES 
1. To delete an entry, click on delete icon as shown below. 

2. A pop up appears for confirmation of action. Click on YES button to continue (NO button will abort the 
change) 

Ariba Summarized Tax Types Configuration

Note1: Please create Ariba Summarized Tax Type exactly as it is defined (case sensitive) in Ariba Buying Solutions.

Note2: While you perform Edit, or Delete actions on an existing entry, please consider impact on Ariba Tax Response to Ariba Buying Solution.

 Ariba Summarized Tax Types

ID Action Ariba Summarized Tax Type

4 ÿ ARIBA TAX TYPE X

SalesTax

2 SUTTax

Ariba Summarized Tax Types Configuration

Note1: Please create Ariba Summarized Tax Type exactly as it is defined (case sensitive) in Ariba Buying Solutions.

Note2: While you perform Edit, or Delete actions on an existing entry, please consider impact on Ariba Tax Response to Ariba Buying Solution.

 Ariba Summarized Tax Types

ID Action Ariba Summarized Tax Type

4 ÿ ARIBA TAX TYPE X

SalesTax

2 SUTTax
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ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

3. System message will be shown to confirm that the changes are saved. 

4. Display grid on main screen will reflects the changes. After deletion, the entry will be deleted from the 
database and will not be shown on display grid. 

TRANSACTION LOGS 
ONESOURCE Global tax for SAP Ariba Solutions offers transaction logging capability Once XMLs are 
enabled (XMLs Log Enablement) at desired level, Integration will generate logs for transactions 
processed. Users can search for transaction logs, view results on UI and download in a zip format in to 
their local system. 

Integration UI screen for Logs offers different search criteria. 

• Company Name: Pre-populated based on what Integration User has access for in Determination 

• External Company ID: This is the external company ID and pre-populated based on companies 
associated with User account in Determination 

Ariba Summarized Tax Types Configuration

Note1: Please create Ariba Summarized Tax Type exactly as it is defined (case sensitive) in Ariba Buying Solutions.

Note2: While you perform Edit, or Delete actions on an existing entry, please consider impact on Ariba Tax Response to Ariba Buying Solution.

Are you sure to delete this entry?
 Ariba Summarized Tax Types

ID Action YES NO

SalesTax

SUTTax

Ariba Summarized Tax Types Configuration

Note1: Please create Ariba Summarized Tax Type exactly as it is defined (case sensitive) in Ariba Buying Solutions.

Note2: While you perform Edit, or Delete actions on an existing entry, please consider impact on Ariba Tax Response to Ariba Buying Solution.

AribaSummarizedTaxTypes

D Action AribaSummarizedTaxType

SalesTax

2 SUTTax
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Company Name or External Company ID are required fields. Select either Company Name 
or External Company ID. Selecting one populates the other automatically. All other fields are 
optional but for faster results, enter more search criteria. 

• Log Date and Time (From/Through): Dates can be entered manually or Calendar tool can be 
used. Input fields Start time and End time are available. 

• Search string: User can enter anything relevant to transactions. 

• SAP Ariba Document Number (SAP Ariba ID of the Purchase Requisition/Invoice Reconciliation 
Document) 

• Document Type: These are the document types in SAP Ariba Buying Solution from which tax 
calculation requests are originated. 

Users with Integrations Admin, Integrations Configurator and Integrations User can have access 
to logs. The companies for which a User can search against is determined by the User’s 
permissions in the Determination. 

Please make sure that External ID is maintained for Determination Company in ONESOURCE 
Determination system. Even one of the Determination Companies under a Tenant ID without 
External ID will cause issues as listed below on Integration UI: 

1. You would not be able to see all Determination Company values (under Company Name drop 
down on Search Logs Screen). 

2. Integration would not be able to load values for External Company ID drop down (system may 
keep searching for results for unknown time). 

  

ÿ
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DISPLAY TRANSACTION LOGS 
1. Log in to ONESOURCE Global Tax for SAP Ariba Solutions. 

2. On Home screen, click on Logs 

3. You will be navigated to Search Logs UI Screen 

  

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaQAUser
TENANT-IndirectTaxIntegrationsQA

Home Configuration Ariba Integration SettingsLogs

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS AribaTestAdmin
TENANT - Indirect Tax Integrations QA

Home Configuration  Ariba Integration SettingsLogs

Search Logs
Company Name *

Select Company Name Here

External Company ID *

Select Extemal Company ID Here

Log Date From  Start Time
HH24:MM:SS

Through Log Date End Time 

HH24:MM:SS

 Search String

SAP Ariba Document Number

 Document Type

Select Document Type Here

SEARCH
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4. Select Company Name or External Company ID (required fields). You may search for company on 
the search bar on drop-down list or scroll through to find desired company (option a or b as shown 
below). 

a) Using search bar to find a company: 

b) Using drop-down/scroll bar list to find company: 

  

Search Logs
Company Name

Ariba DE

Ariba DE

Search Logs
Company Name *

Select Company Name Here

Ariba DE

Ariba GB

Ariba US

AribaA

AribaB
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4.1 Click on the company you wish you search logs for once you find the entry. External Company ID will 
be populated automatically. 

If you would like to select External Company ID, follow steps 4 and 5. Company Name will be 
populated based on your selection of external company ID. 

4.2 Enter Date and Time. Enter Log Date from and Through Date or select the dates from the calendar 
tool. To use calendar tool, click on the calendar icon and select the dates. To enter time use, Start 
Time input fields and enter time manually. End time will be populated automatically when you enter 
Date Through 

4.3 Search string for example Ariba Realm ID “DEV_TEST”. 

4.4 Enter Document number if you would like to see log for a transaction. 

  

Search Logs
Company Name

SAP DEV US 3000 ECC-ARIBA

External Company ID

INTSAPDEV 3000
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4.5 Select the Document type to restrict the search to a document type. 

5. Click on SEARCH button to get the results. 

6. System would fetch results per search criteria. 

Home Configuration AribaIntegrationSettingsLogs

Search Logs
Company Name *

SAP DEV US 3000 ECC-ARIBA

External Company ID *

INTSAPDEV_3000

Log Date From Start Time

07/22/2018 00:00:00

Through Log Date End Time

07/23/2018 23:59:59

Search String

DEV_TEST

SAP Ariba Document Number

Document Type

Invoice Reconciliation (IR)

SEARCH
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Please see what search results display grid means here: 

Search results include four xml data files. 

• Ariba Request XML: request from SAP Ariba Buying Solution 

• Determination Request XML: request to Determination from ONESOURCE Global Tax for SAP 
Ariba Solutions (Integration) 

• Determination Response XML: response from Determination to ONESOURCE Global Tax for 
SAP Ariba Solutions (Integration) 

• Ariba Response XML: Response from Integration SAP Ariba Buying Solution. 

7. To view xml data: 

a. Click on document icon to see data in a pop up window within the same browser. 

Home Configuration Ariba Integration Settings Logs

Search Results

Company External Search SAP Ariba SAP Ariba Log Date Zip Ariba Determinatiol Determinatioi Ariba Timings
Name Company String Document Document And Time Request Request Response Response

ID Number Type XML (Tax XML XML XML (Tax
Service (INDATA) (OUTDATA) Service
Export Export
Request Reply
Messade) Messade)

SAP DEVU:INTSAPDEV DEV_TEST IRAuditSc12Invoice Rec( 2018-07-23 ÿ ÿ ÿ ÿ

BACKTOSEARCHLOGS

Home Configuration Ariba Integration SettingsLogs

click to download zip file logs in xml format click to open window
search critera with four xml data files with xml data

Search Results

Company Extemal Search String SAP Ariba SAP Ariba Log Date And Zip Ariba Request DeterminationDetermination Ariba Timings
Name Company ID Document Document Time XML (Tax Request XML Response XMLResponse XML

Number Type Service Export (INDATA) (OUTDATA) (Tax Service
Request Export Reply

Message) Message)

SAP DEVUS 3IINTSAPDEV_3IDEV_TEST TotalAccrl Invoice Reconci2018-07-23 18 ÿ ÿ ÿ ÿ

SAPDEVUS3IINTSAPDEV_3IDEV_TEST PartialAccrl Invoice Reconc2018-07-23 18 ÿ ÿ ÿ ÿ

SAPDEVUS3IINTSAPDEV_3IDEV_TEST Sc12 Invoice Reconci 2018-07-2318 ÿ ÿ ÿ ÿ

SAPDEVUS3IINTSAPDEV_3IDEV_TEST Sc11 Invoice Reconci2018-07-2318 ÿ ÿ ÿ ÿ ÿ

DEddlddR1 Invoice Reconci2018-07-23 16 ÿ ÿ ÿ ÿ ÿ

DEddldR1 Invoice Reconci2018-07-23 16ÿ ÿ ÿ ÿ ÿ ÿ

ÿ
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b. click on download link icon to download all 4 types of xml data files in a zip file to your 
local computer system. 

8. To check time took to get the transaction log, please click on icon under Timings column 

9. Click on BACK TO SEARCH XML button to go back to search results UI screen. 

10. Click on BACK TO SEARCH LOGS button on Search Results UI screen to go back to Search Logs UI 
screen search for other transactions. 

ONESOURCEGLOBALTAXFORSAPARIBASOLUTIONS QAe Config 2
TENANT - Indirect Tax Integrations QAe

Home ConfigurationAriba Integration SettingsLogs scrollto
<SOAP-ENV:Envelope> view xml

<SOAP-ENV:Header> message

Search Results
<wsseiSecurity>

<wsse:UsernameToken>

<Wsse:Password>+*********</wsse:PassW

Company NameExtemal CompanySearch String SAP Ariba </wsse:UsernameToken> etermination DeterminationAriba ResponseTimings
ID Document Number

</wsse:Security>
</SOAP-ENV:Header> Request XML  Response XMLXML (Tax Service
<SOAP-ENV:Body> (INDATA) (OUTDATA) Export Reply

<ns2:taxCalculationRequest> Message)
<nS2:INDATA>

SAP QA US 3000 EIINTSAPQAE_3000 IRarbabaplinv5-44
<ns2:H0ST_SYSTEM>prea1m_2284</ns2:HOST_ ÿ ÿ
<nS2:CALLING_SYSTEM_NUMBER>Vrealm_2204<
<nS2:INVOICE>

SAP QA US 3000 EINTSAPQAE_3000 IRarbabapiinv4-45 <nS2:COMPANY_ROLE>S</nS2:COMPAN ÿ ÿ ÿ
<nS2:CURRENCY_CODE>USD</nS2:CUR

SAP QA US 3000 EINTSAPQAE_3000 IRarbabapiinv3-45 <ns2:DocUMENT_TYPE>ariba.invoic ÿ ÿ
<nS2:EXTERNAL_COMPANY_ID>INTSAP
<ns2:INV0ICE_DATE>2018-11-26</n

SAP QA US 3000 E:INTSAPQAE_3000 IRarbabapiinv2-45 <ns2:INVOICE_NUMBER>IRarbabapii ÿ ÿ ÿ
<nS2:TRANSACTION_TYPE>GS</nS2:T

SAP QA US 3000 EIINTSAPQAE_3000 IRbapi-nopo1-452 click on this <nS2:UNIQUE_INVOICE_NUMBER>INTS. ÿ ÿ
button to close <ns2:LINE>

<nS2:BILL_TO>
SAP QA US 3000 E:INTSAPQAE_3000 PR732-V2 message pop- <nS2:COUNTRY>US ÿ ÿ

up and go back <nS2:STATE>TX</
SAP QA US 3000 EINTSAPQAE_3000 PR732-V2 to search <nS2:CITY>Austi ÿ ÿ

<nS2:POSTCODE>7

SAP QA US 3000 EINTSAPQAE_3000 PR732
</ns2:BILL_T0>
<nS2:COMMODITY_CODE>141 ÿ ÿ ÿ

SHA1T. 4A85

SAP QA US 3000 EINTSAPQAE_3000 PR732 ÿ ÿ ÿ
click on this button to

INTSAPQAE_3000
RETURN TO SEARCH RESULTCOPY XML MESSAGE

SAP QA US 3000 E: IR1126inv-451 copy the xml message ÿ ÿ

D

Home Configuration Ariba Integration SettingsLogs

Timings
ID Description Milliseconds Synchronization Timestamp

b7c3a3b4-3db4-47fd-a2da-c818227fe988 Sending tax to Determination. 1534968024472 2018-08-22 20:00:30

3916d230-2cb9-4548-b2d0-a792830f838e Receiving response from Determination. 1534968030515 2018-08-22 20:00:30

f48b9f62-b67e-4424-a599-6d3a045dd933 Preparing to save log. 1534968030571 2018-08-22 20:00:30

BACK TO SEARCH XML
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Ariba Request Fields Mapping 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
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APPENDIX I 
ARIBA REQUEST FIELDS MAPPING 

Ariba Request TR Mapping Comments 
Header <Collection> 

variant Batch.Calling_System_Number 

partition Batch.Host_System 

item <Collection> 
partition N/A Set at batch level 

variant N/A Set at batch level 

TaxServiceExportReply <Collection> 
item <Collection> 

CompanyCode <Collection> 
UniqueName Invoice.External_Company_ID 

DocumentDate Invoice.Invoice_Date 

LineItems <Collection> 
item Line.LineID 

BillingAddress Line.Bill_To 

Line1, Line2, Line3 
are not mapped to 
Determination 
Address structure. If 
desired, Custom 
Attributes be used. 

BuyerTaxRegistrationNumber Line.Registrations.Buyer_Role 
Multiple values 
allowed 

ChargeDetail <Collection> 
not use by SAP Ariba 
(unsupported) 

ChargeAmount Line.Document_Amount.Gross_Amount 
not use by SAP Ariba 
(unsupported) 

Home Configuration Ariba Integration SettingsLogs

Search Results

Company Name External Search String SAP Ariba SAP Ariba Log Date And Zip Ariba Request Determination Determination Ariba Response Timings
Company ID Document Document Type Time XML (Tax ServiceRequest XML Response XML XML(Tax Service

Number Export Request (INDATA) (OUTDATA) Export Reply
Message) Message)

SAP QA US 3000INTSAPQAE 300 PR732-V2 Purchase Requisi2018-11-26 20:38 ÿ ÿ ÿ ÿ

SAP QA US 3000INTSAPQAE_300 PR732-V2 Purchase Requisi22018-11-26 20:38 ÿ ÿ ÿ ÿ

SAP QA US 3000INTSAPQAE_300 PR732 Purchase Requisi2018-11-26 20:27? ÿ ÿ ÿ ÿ

SAP QA US 3000INTSAPQAE_300 PR732 Purchase Requisi2018-11-26 20:27 D ÿ ÿ ÿ ÿ

SAP QA US 3000INTSAPQAE_300 Purchase Requisi2018-11-26 20:03 ÿ ÿ ÿ ÿ

click on this button to go back
BACK TO SEARCH LOGS
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Ariba Request TR Mapping Comments 

Currency <Collection> 
not use by SAP Ariba 
(unsupported) 

UniqueName Invoice.Currency_Code 
not use by SAP Ariba 
(unsupported) 

ChargeType <Collection> 
not use by SAP Ariba 
(unsupported) 

UniqueName Line.Product_Code 
not use by SAP Ariba 
(unsupported) 

CommodityCode <Collection> 

UniqueName Line.Product_Code 

Description Line.Description 

CommonCommodityCode <Collection> 

UniqueName Line.Commodity_Code 

Domain Line.User_Element.Attribute47 

UnitOfMeasure <Collection> 

UniqueName Line.Qunatities.Qunatity.Uom 

IncoTermsCode <Collection> 

UniqueName Line.Delivery_Terms 

IncoTermsDetail Line.Title_Transfer_Location 

LineType <Collection> 

UniqueName Invoice.User_Element.Attribute41 Used from first line 

Category N/A 

NetAmount <Collection> 

Amount Line.Document_Amount.Gross_Amount 

Currency <Collection> 
UniqueName Invoice.Currency_Code Used from first line 

NumberInCollection Line.Line_Number 

ParentLineNumber Line.Related_Line_Number 

Quantity Line.Qunatities.Qunatity.Amount 

SellerTaxRegistrationNumber Line.Registrations.Seller_Role 
Multiple values 
allowed 

ShipTo Line.Ship_To 

Line1, Line2, Line3 
are not mapped to 
any Determination 
elements. If desired, 
Customer Attributes 
can be used. 

SupplierLocation Line.Ship_From 

Line1, Line2, Line3 
are not mapped to 
any Determination 
elements. If desired, 
Customer Attributes 
can be used. 

TaxExclusion Line.Is_No_Tax.All 

If TRUE set to 
Is_No_Tax for 
Determination, Ariba 
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Ariba Request TR Mapping Comments 
response will have an 
empty line structure 
with only the 
NumberInCollection 
reference 

ShipFromAddress Line.Ship_From 

Line1, Line2, Line3 
are not mapped to 
any Determination 
elements. If desired, 
Customer Attributes 
can be used. 

Parent <Collection> 

NumberInCollection N/A 

OriginalSupplierAmount <Collection> 

Currency <Collection> 

UniuqeName N/A 

Amount N/A 

Taxes <Collection> 

FinalAmount <Collection> 

Currency <Collection> 

UniqueName N/A 

Amount N/A 

TaxType <Collection> 

UniqueName N/A 

OriginalSupplierAmount <Collection> 

Currency <Collection> 

UniqueName N/A 

Amount N/A 

IsBuyerPayableTax N/A 

SAPPlant <Collection> 

Ariba will not have 
ERP Plant ID in this 
field 

UniqueName N/A 

SupplierID Invoice.Vendor_Number 

OrganizationName 

OrganizationUnit Invoice.External_Company_ID 

Type Invoice.Document_Type 

UniqueName Invoice.Invoice_Number 

RelatedDocument Invoice.Original_Invoice.Number 

DocumentSubType Invoice.User_Element.Value, Attribute42 

IsRetry N/A 

custom <Collection> 
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Ariba Request TR Mapping Comments 

CustomBoolean Line.User_Element.Value 
Value # mapped in 
integration layer 

CustomInteger Line.User_Element.Value 
Value # mapped in 
integration layer 

CustomMoney <Collection> 

Amount Line.User_Element.Attribute42 

AmountInReportingCurrency Line.User_Element.Attribute43 

ApproxAmountInBaseCurrency Line.User_Element.Attribute44 

ConversionDate Line.User_Element.Attribute45 

Currency <Collection> 

UniqueName Line.User_Element.Attribute46 

CustomString Line.User_Element.Value 

Type Invoice.Document_Type 

OrganizationName Invoice.External_Company_ID 

OrganizationUnit N/A 

Only 
OrganizationName 
used to capture ERP 
Company Code 

UniqueName Invoice.Invoice_Number 

custom <Collection> 

CustomBoolean Line.User_Element.Attribute 
Value # mapped in 
integration layer 

CustomInteger Line.User_Element.Attribute 
Value # mapped in 
integration layer 

CustomMoney <Collection> 
Amount Invoice.User_Element.Attribute42 

AmountInReportingCurrency Invoice.User_Element.Attribute43 

ApproxAmountInBaseCurrency Invoice.User_Element.Attribute44 

ConversionDate Invoice.User_Element.Attribute45 

Currency <Collection> 
UniqueName Invoice.User_Element.Attribute46 

CustomString Invoice.User_Element.Attribute 
Value # mapped in 
integration layer 
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ARIBA RESPONSE FIELD MAPPING 
Ariba Response TR Mapping Comments 
ExternalTaxResponseStatus <Collection> 

Description Invoice.Requst_Status.Error.Descrpiton 

ErrorCode Invoice.Requst_Status.Error.Code 

ErrorLocationPath Invoice.Requst_Status.Error.Error_Location_Path 

Success Invoice.Requst_Status.Is_Success 

LineItems <Collection> 
item <Collection> 
ExternalTaxItem <Collection> 

item <Collection> 

AbatementPercent Tax.Basis_Percent 

If provided 
(times 100), if 
NIL set it to 
100% default. 

BuyerTaxRegistrationNumber Line.Tax.Buyer_Registration single value 

Category Tax.Tax_Type 

Description Tax.Authority_Type 

ExternalTaxType <Collection> 
UniqueName Tax.Authority_Type 

FormulaString 
Tax.Jurisdiction_Text | Tax.Rule_Order |    
Tax.Nature_of_Tax 

Concatenate 
the three 
fields with a 
pipe 
separator 

InvoiceCitation 
Tax.Invoice_Description 
Tax.Jurisidcition_Text 

Jurisdiction 
text for tax 
types NL, RC, 
TR, ZE, ZC, 
else invoice 
description 

IsDeductible Tax.Tax_Type, = NR, set to "true", else to "false" 

PerUnit Tax.Fee.Amount 

Percent Tax.Tax_Rate 

Only first fee 
will be 
returned 

SellerTaxRegistrationNumber Line.Tax.Seller_Registration single value 

TaxAmount <Collection> 
Amount Tax.Tax_Amount.Document_Amount 

Currency <Collection> 
UniqueName Invoice.Currency_Code 

TaxableAmount <Collection> 
Amount Tax.Document_Amount.Taxable_Basis.Amount 
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Ariba Response TR Mapping Comments 
Currency <Collection> 

UniqueName Invoice.Currency_Code 

AccountInstruction Tax.Erp_Tax_Code 

TaxAuthority Tax.Authority_Name 

TaxComponents <Collection> 

item <Collection> 

TaxAmount <Collection> 

Currency <Collection> 

UniqueName Invoice.Currency_Code 

Amount Tax.Tax_Amount.Document_Amount 

ExternalTaxType <Collection> 

UniqueName Tax.Authority_Type 

TaxabaleAmount <Collection> 

Currency <Collection> 

UniqueName Invoice.Currency_Code 

Amount Tax.Document_Amount.Taxable_Basis.Amount 

Description Tax.Authority_Type 

FormulaString 
Tax.Jurisdiction_Text | Tax.Rule_Order | 
Tax.Nature_of_Tax 

Percent Tax.Tax_Rate 

PostinngComponents <Collection> 

item <Collection> 

TaxAmount <Collection> 

Currency <Collection> 

UniqueName Invoice.Currency_Code 

Amount Tax.Tax_Amount.Document_Amount 

TaxableAmount <Collection> 

Currency <Collection> 

UniqueName Invoice.Currency_Code 

Amount Tax.Document_Amount.Taxable_Basis.Amount 

ExternalTaxType <Collection> 

UniuqeName Tax.Authority_Type 

PostingInstructions <Collection> 

item <Collection> 

Value Tax.Erp_Tax_Code 

Name AccountInstruction 

item <Collection> 

Value Values based on accrual logic true/false 
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Ariba Response TR Mapping Comments 
Name IsAccrual 

Description Tax.Authority_Type 

Percent Tax.Tax_Rate 

IsDeductible Tax.Tax_Type, = NR, set to "true", else to "false" 

InvoiceCitation 
Tax.Invoice_Description 
Tax.Jurisidcition_Text 

IsBuyerPayableTax N/A 

NumberInCollection Line.Line_Number 

TaxCode <Collection> 

Country <Collection> 

UniqueName Tax.Taxable_Country 

UniqueName Tax.Erp_Tax_Code 

custom <Collection> 

CustomBoolean Line.User_Element.Value 

CustomInteger Line.User_Element.Value 

CustomMoney <Collection> 

Amount Line.User_Element.Attribute42 

AmountInReportingCurrency Line.User_Element.Attribute43 

ApproxAmountInBaseCurrency Line.User_Element.Attribute44 

ConversionDate Line.User_Element.Attribute45 

Currency <Collection> 

UniqueName Line.User_Element.Attribute46 
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APPENDIX II 
SAP ARIBA REPORTS WITH TAX DATA 
SAP Procurement Solution offers reporting functionality to analyze the transaction data. The two options 
“Pre-packaged reports” and “Analytical report” provide users opportunity to extract the transaction data for 
different analysis purpose.   

User can use prepackaged reports and modify them for desired reporting data or may use Analytical 
Reports option to create completely customized reports. Here we show sample prepackaged reports with 
a little modification (Invoice Report modified) to show tax calculated by ONESOURCE Global Tax for SAP 
Ariba Solutions.   

Tax Data generated on approvable documents during procurement transactions can also be seen on 
standard reports. And reports can be customized by adding report fields required from available report 
field inventory or deleting fields which are not necessary per user’s requirement. 

REQUISITION REPORT WITH TAX DATA 
Tax data generated during Requisition transaction processing can be seen on report “Requisition Spend 
with Charges and Taxes” available in Pre-packaged reports. 

Navigation for accessing the Requisition Spend with Charges and Taxes report: 

1. Log in SAP ARIBA Procurement Solution 

2. On Home screen navigate to > Manage > Prepackaged Reports 

3. System would display list of available Prepackaged Reports. Under the Name Column > Click on 

Requisition Reports > Click on Open on pull down menu 

4. System would display all reports related to Requisition reporting 

5. Click on Requisition Spend with Charges and Taxes > Click on Open on the pull-down menu 

6. System would display the report as shown in below screenshot   
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User can use standard edit and export and other functionalities to modify the report. Reporting feature 
description is beyond the scope of this document. Please refer SAP ARIBA product documentation to 
learn more about working with Reports. 

  

Reporting Requisition Spend with Charges and Taxes Edit Save... Export Actions

Field Browser
Pivot table Chart  Dashboard

Page Others

Applied Filters

2,319.64 Requisition DateSpanning: most recent 2 Year(s) Display Options Edit

Line Type Min/Max rows: 3/8
*Exclude * Charge, Tax, Discount

Detail View

Requisition Line  Requisition RequisitionDiscount Charge
 Requisition RequisitionLine ERP TypeUnit of QuantityUnit PriceAmountAmountTa
ID Date  Number Supplier  Part Name  DescriptionCommodity Measure + (USD) (USD) (USD) (U

Total 2,319.64 639.25 -723.75 504.00

IL Office(3001_IT
PR170 - 1/13/2017 Cafeteria CatalogSupplies Consultation 3001)Consultation hourItem 1,000.00 15.00 0.00 0.00

State Sales/Use - services

IL Office12/14/2016 (3001_IT Organizational
PR52- Supplies Consultation 3001)Consultation Catalogstructure hour 160.00Item 100.00 0.00 0.00

State Sales/Use consultation
IL Office1/13/2017 Cafeteria Non-

PR172- SuppliesUnclassified - Service Req3 Catalog each 100.00 15.00 0.00 0.00
services

Detail View

Line Requisition  Requisition DiscountCharge
ERP TypeUnit of QuantityUnit PriceAmountAmountTax AmountGross Amount
Supplier  Part Name Description Commodity Measure + (USD) (USD) (USD) (USD) (USD)

2,319.64 639.25 -723.75 504.00 152,191.151,635,241.21
IL Office (3001_IT Cafeteria Catalog hour SuppliesConsultation 3001)Consultation services Item 1,000.00 15.00 0.00 0.00 1,275.00 16,275.00

State Sales/Use -
IL Office (3001_IT Organizational
 Supplies CatalogConsultation 3001)Consultation structure Item hour 160.00 100.00 0.00 0.00 0.00 16,000.00

State Sales/Use - consultation
IL Office Cafeteria Non-
Supplies Unclassified - Service Req3 Catalog each 100.00 15.00 0.00 0.00 127.50 1,627.50services Item
IL Office Printer and

facsimile andNon-
 SuppliesUnclassified - Tax Test Catalog each 100.00 10.00 0.00 0.00 0.00 1,000.00photocopier Itemsupplies

IL Office Printer and
facsimile and Non-

 SuppliesUnclassified - Tax Test Catalog each 100.00 10.00 0.00 0.00photocopier 0.00 1,000.00
supplies Item

IL Office (3001_PrintSupplies Printer and

 Supplies3001) State facsimile andCatalogPrint Supplies each 100.00 100.00 0.00 0.00 825.00photocopierItem 10,825.00
Sales/Use - supplies

IL Office (3001_PhotoCopier2

 Supplies3001) Multi-PurposePhoto Copier2 PhotocopiersCatalog
Photocopier- Item each 90.00 3,000.00 0.00 0.00 22,275.00 292,275.00
200400A

  

     

 
   

  

 

   
 

 
 

 

    
        

       
     

    
 

         
    

  
    

            
  

            

 

        
        

     
   

   
       

 
   

            
  

              

  
  

             
  

  
        

 
  

  

  
 

           
 

 
  

  
    

         



Appendix II 137 

Requisition Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

To display tax data at authority level: Click on Report Column Line Type > Select Line Type (all) option on 
the pull-down menu. 

Detail View

quisition Line RequisitionRequisitionDiscountCharge
e ERP Type Unit of Quantity Unit PriceAmount Amount Tax Amount Gross Amount
mber Supplier  Part Name Description Commodity Measure (USD) (USD) (USD) (USD) (USD)

2,319.64 639.25 -723.75 504.00- 152,191.15 1,635,241.21

IL Office (3001_IT
Supplies Consultation 3001) Cafeteria CatalogConsultation hour 1,000.00 15.00Item

0.00 0.00 1,275.00 16,275.00
State Sales/Use services

IL Office (3001_IT Organizational
Supplies Consultation 3001) CatalogConsultation structure hour 160.00 100.00 0.00 0.00 0.00Item 16,000.00

State Sales/Use consultation
IL Office Cafeteria Non-
Supplies Unclassified- Service Req3 Catalog each 100.00 15.00 0.00 0.00 127.50 1,627.50

services Item
IL Office Printer and

facsimile and Non-
SuppliesUnclassified Tax Test Catalog each 100.00 10.00 0.00 0.00 0.00 1,000.00photocopier

supplies Item

IL Office Printer and Non-
Supplies Unclassified Tax Test facsimile and Catalog each 100.00 10.00 0.00 0.00 0.00 1,000.00photocopier Itemsupplies

Expand Next Level Detail View

quisition At lowest level RequisitionDiscount Charge
e ERP Unit PriceAmount AmountTax Amount Gross Amount
mber Supplier Part Name Description Commodity Select Level, Values: (USD) (USD) (USD) (USD) (USD)

Line Type (all)
639.25 -723.75 504.00- 152,191.15 1,635,241.21

IL Office (3001_IT
Supplies Consultation 3001)Consultation Cafeteria Catalog ltem 15.00 0.00 0.00 1,275.00 16,275.00

State Sales/Use services

IL Office (3001_IT Organizational Non-Catalog Item
Supplies Consultation 3001)Consultationstructure Select Others. 100.00 0.00 0.00 0.00 16,000.00

State Sales/Use consultation
IL Office Cafeteria Select Search Filter..
Supplies Unclassified - Service Req3 15.00 0.00 0.00 127.50 1,627.50services

Move Field
IL Office Printer and

SuppliesUnclassified - Tax Test facsimile and
Left 10.00

photocopier 0.00 0.00 0.00 1,000.00

supplies Right
IL Office Printer and

Supplies Unclassified Tax Test facsimile and
Show Field On 10.00 0.00 0.00 0.00photocopier 1,000.00

supplies

 

     
          

           

      
  
         

    
 

 

   
             

  
  

           
 

  
 

           
  

  
   

 
         

  

  
   

       
          

 
     

  
           

    
          

 
 

  
         

 
 

 
   

 
  

 
    

  
  
   

 
       



138 Appendix II 

Requisition Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

Report can be exported to user’s system. SAP ARIBA solution exports the data in pivot table. 

1. Click on Export button 

2. System would process export in 6 automatic steps as shown in below screenshot. Once 

completed, an Excel file will be opened on User’s computer system with report data 

Detail View

juisition Requisition RequisitionDiscount Charge
ERP Line Unit of QuantityUnit PriceAmountAmountTax AmountGre ss Amount

nber  SupplierPart Name DescriptionCommodity Type Measure + (USD) (USD) (USD) (USD) (US D)
2,319.64 639.25 -723.75 504.00 303,807.55 1,938,325.01

IL Office (3001_IT
 SuppliesConsultation 3001) ConsultationCafeteria Catalog

Item hour 1,000.00 15.00 0.00 0.00
services 1,275.00 16,275.00

State Sales/Use
IL Office (3001_IT

001-  SuppliesConsultation 3001)State Cafeteria
Sales/Use Tax hour 0.00 0.00 0.00 900.00 1,800.00

State Sales/Use services

IL Office (3001_IT
002 - SuppliesConsultation 3001)District Cafeteria

Sales/Use x1 hour 0.00 0.00 0.00 187.50 375.00
State Sales/Use services

IL Office (3001_IT
103-  Supplies CityConsultation 3001) Cafeteria Tax hour 0.00 0.00Sales/Use 0.00 187.50 375.00

State Sales/Use services

IL Office (3001_IT Organizational
 SuppliesConsultation 3001)Consultation Catalogstructure Item hour 160.00 100.00 0.00 0.00 0.00 16,000.00

State Sales/Use consultation
IL Office

Cafeteria Non-
 SuppliesUnclassified Service Req3 Catalogeach 100.00 15.00 0.00 0.00 127.50 1,627.50services Item
IL Office

001 - Supplies Unclassified State Cafeteria TaxSales/Use each 0.00 0.00 0.00 90.00 180.00services

IL Office
002-  SuppliesUnclassified District Cafeteria

Sales/Use Tax each 0.00 0.00 0.00 18.75services 37.50

>

ExportingtoExcel template Return to Report

Your data is being exported. If you are asked to enable ActiveX, respond Yes. Otherwise, your data cannot be exported to Excel.

1. Contacting Excel

2.Downloadingtemplate

3. Waiting for query
4.Downloadingdata

5. Configuring layout
6. Done

Return to Report
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Requisition Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

  

B C D E
Re Total

2 This Worksheet Will ContainDataPopulated From AribaSpend Management.
3 Requisition Quantity Requisition Unit PriceDiscount Amount (USD)Charge Amount (USD)Tax Amount (USD)
4 ToQuery Parameters: Range"Ariba Data Params"
5 Source Data Requisition

Fixed_Columns FALSE

6
7 Query_Filters
8 Field Mappings
6 RawFieldNames Requisitionld,RequisitionDate.Day,RequisitionLineNumber, Supplier. SupplierName, Part.PartName,Description, Commodity.Com.
10 Sort Fields
11
12 Data Table: Range"Ariba_Data"
13
14 Requisition ID Requisitioning DateRequisition Line NumberSupplier - ERP SupplierPart - Part Name
15 PR713 5/12/2017 100002 Office Products GB (2001_9X-Propane 2001) VAT
16 PR720 5/14/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
17 PR743 5/18/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
18 PR728 5/16/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
19 PR747 5/18/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
20 PR696 5/9/20171 Office Products GB Unclassified
21 PR713 5/12/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
22 PR745 5/18/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
23 PR753 5/18/20171 Office Products GB (2001_9X-Propane 2001)VAT
24 PR697 5/10/20171 Office Products GB (2001_Propane 2001) VAT
25 PR800 5/31/20171 Ofice Products GB (UK2001LMS-LANMaintenanceSupport2001)
26 PR710 5/12/2017 2 IL Office Supplies (3001_InkCatridge 3001) State Sales/Use
27 DD712 5/12/20172 IOffca Cunnliar /3nn1InlCatridao3nn11CtataCalac/llca
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Purchase Order Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

PURCHASE ORDER REPORT WITH TAX DATA 
In SAP ARIBA Procurement Solution, once PR is approved, Purchase Order is generated. The tax 
calculated on PR will be copied over to Purchase Oder document. The tax amount, tax authority data 
received from ONESOURCE Global Tax for SAP Ariba Solutions would be similar to the data found on 
Purchase Requisition. But the report Purchase Order Spend with Charges and Taxes would show tax on 
Purchase Order. 

Navigation for accessing the Purchase Order Spend with Charges and Taxes: 

1. Log in SAP ARIBA Procurement Solution. 

2. On Home screen navigate to > Manage > Prepackaged Reports. 

3. System would display list of available Prepackaged Reports. Under the Name Column > Click 

on Purchase Order Reports > Click on Open on pull down menu. 

4. System would display all reports related to Purchase Order reporting. 

5. Click on Purchase Order Spend with Charges and Taxes > Click on Open on the pull-down 

menu. 

  

Purchase Order Reports Show Detailed View

Purchase Order Reports Show Details Actions A

Name Owner

PCard Order Details aribasystem

Purchase Order Activity aribasystem

Purchase Order Spend with Charges and Taxes aribasystem

Purchase Order Spend with Charges and Taxes Detail aribasystem

ÿ Purchase Price Variance by Commodity aribasystem

ÿ Received Not Invoiced Report aribasystem

ÿ Requisition Total by Supplier - aribasystem

ÿ  Spend Concentration Analysis by Commodity aribasystem

ÿ Spend Penetration by Commodity aribasystem

Top items ordered by Punchout vs. Contained - aribasystem

ÿ Total number of items ordered aribasystem
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Purchase Order Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

6. System would display the report as shown in below screenshot. 

7. To display tax data at authority level > Click on Report Column Line Type > Select Line Type 
(all) option on the pull-down menu 

Reporting Purchase Order Spend with Charges and Taxes 11P3 Save. Export Actions

Field Browser
Pivot table Chart Dashboard

Page Others

Applied Filters

2,078.82 Ordered DateSpanning: most recent 2 Year(s) Display Options Edit

Line Type Min/Max rows: 3/8*Exclude * Charge, Tax, Discount

Detail View

Line PO PO Unit Discount Charge
Order Ordered PO LineType ERP Unit of QuantityPrice PO SpendAmountAmount

 RequesterId Date  Number Description Supplier  Measure+ (USD) (USD) (USD) (USD)

Total 2,078.82 569.7593 1,184,643.75 -713.75 234.81

Venu KotagiriPO68 1/13/2017 Catalog Consultation IL Office
Item Supplies hour 1,000.00 15.0000 15,000.00 0.00 0.00

PO22 12/14/2016 CatalogConsultation IL Office
Item hourSupplies 160.00 100.0000 16,000.00 0.00 0.00

PO16 12/9/2016 Non-
Catalogg Tax Test- IL Office

Supplieseach 100.00 10.0000 1,000.00 0.00 0.00
Item 

PO31 12/18/2016 Catalog Print Supplies TIL Office
Item Sunnlies each 100.00 100.0000 10,000.00 0.00 0.00

Detail View

Line PO PO Unit Discount Charge
Order Ordered PO Line Type ERP Unit of Quantity Price PO Spend Amount Amount

Requester Id Date Number Description Supplier Measure + (USD) (USD) (USD) (USD)

Total 2,078.82 569.7593 1,184,643.75 -713.75 234.81

VenuKotagiri PO68 1/13/2017 CatalogConsultation IL Office
Item Supplies hour 1,000.00 15.0000 15,000.00 0.00 0.00

PO22 12/14/2016 CatalogConsultation IL Office
Item Supplies hour 160.00 100.0000 16,000.00 0.00 0.00

PO16 12/9/2016 Non-
CatalogTax Test IL Office

Supplies each 100.00 10.0000 1,000.00 0.00 0.00
Item 

PO31 12/18/2016 CatalogPrint Supplies IL Office
Item Supplies

each 100.00 100.0000 10,000.00 0.00 0.00

PO36 12/19/2016 CatalogPhoto Copier2 IL Office
Item Supplies each 90.00 3,000.0000 270,000.00 0.00 0.00

Pivot table Chart Dashboard Expand Next Level

At lowest level

Applied Filters
Select Level, Values:

2,078.82 Ordered Date Spanning: most re Display Options Edit

Line Type Line Type (all) Min/Maxrows:3/8
*Exclude * Charg

Catalog Item

Non-Catalog Item Detail View

Select Others..
PO PO Unit Discount Charge

Order Ordered PO Line T Select Search Filter.. ERP Unit of Quantity Price PO Spend Amount Amount
RequesterPI Date Number Supplier Measure + (USD) (USD) (USD) (USD)

Move Field
Total 2,078.82 569.7593 1,184,643.75 -713.75 234.81

Venu Kotagiri PO68 1/13/2017 C Left IL Office
It Supplies hour 1,000.00 15.0000 15,000.00 0.00 0.00

PO22 12/14/2016 C Right IL Office
It hourSupplies 160.00 100.0000 16,000.00 0.00 0.00

      

 
   

  

 

    
 

  

 

     
       

         

      
     

 
      

      
     

     
 

      

    
 
      

 

     
           

            

      

     
 

      

     
 

      

  
   

 
      

    
 

 
      

     
      

    

 

 
 

    

   
 

 

  

 
    

   
        

           
 

      

     
        

     
   

    



Appendix II 142 

Purchase Order Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

Line Type with Description column showing tax data by tax authority level 

Report can be exported to user’s system. SAP ARIBA solution exports the data in pivot table (export file 

type can be configured. The option to do so is available under > Actions > Configure Export). 
1. Click on Export button 

2. System would process export in 6 automatic steps as shown in below screenshot. Once 

completed, an Excel file will be opened on User’s computer system with report data 

Detail View

PO PO Unit DiscountCharge
Line ERP Unit of Quantity Price PO Spend Amount AmountTax AmountGross AmountNumber
Type Description Supplier Measure + (USD) (USD) (USD) (USD) (USD) (USD) Accepted

2,078.82 569.7593 1,294,869.92-713.75 234.81- 222,454.58 1,516,845.56 650.00

CatalogConsultation IL Office
Item Supplies hour 1,000.00 15.0000 15,000.00 0.00 0.00 1,275.00 16,275.00 0.00

xe1 State Sales/Use IL Office
Supplieshour 0.00 900.00 0.00 0.00 900.00 1,800.00 0.00

Tax - District Sales/Use - IL Office
 Supplieshour 0.00 187.50 0.00 0.00 187.50 375.00 0.00

TaxT City Sales/Use - IL Office
Supplieshour 0.00 187.50 0.00 0.00 187.50 375.00 0.00

CatalogConsultation IL Office
Item Supplieshour 160.00 100.0000 16,000.00 0.00 0.00 0.00 16,000.00 160.00
Non-
CatalogTax Test - IL Office

Supplies each 100.00 10.0000 1,000.00 0.00 0.00 0.00 1,000.00 50.00
Item
CatalogPrint Supplies IL Office
Item Supplieseach 100.00 100.0000 10,000.00 0.00 0.00 825.00 10,825.00 1.00

Tax State Sales/Use IL Office
Supplieseach 0.00 625.00 0.00 0.00 625.00 1,250.00 0.00

City Sales/Use - IL Office
Supplieseach 0.00 100.00 0.00 0.00 100.00 200.00 0.00

Tax T District Sales/Use - IL Office
Supplieseach 0.00 100.00 0.00 0.00 100.00 200.00 0.00

CatalogPhoto Copier2 IL Office
Item Supplies each 90.00 3,000.0000 270,000.00 0.00 0.00 22,275.00 292,275.00 13.00

ExportingtoExcel template Return to Report

Your data is being exported. If you are asked to enable ActiveX, respond Yes. Otherwise, your data cannot be exported to Excel.

1. Contacting Excel

2.Downloadingtemplate

3. Waiting for query
4.Downloadingdata

5. Configuring layout
6. Done

Return to Report

 

   
        
            

      
  

           

  
         

   
         

   
         

  
          

   
          

 
  

  
         

  
 

        

  
 

        

   
 

        
  

          

  

 

 

 
 

 

 
 



143 Appendix II 

Purchase Order Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

A B C D E G
PCTotal

2 ThisWorksheetWill ContainDataPopulated FromAribaSpend Management.
3 PO Quantity PO Unit Pri PO Spend (US[Discount Amount (Charge Amount (UTax Amount (USD) Gross Amot
4 ToQueryParameters:Range"AribaDataParams"
5 Source Data Purchase Order(Procurement & Invoicing)

Fixed_Columns FALSE

6
7 Query_Filters
8 Field Mappings
6 RawFieldNames RequesterUserName,OrderD,OrderedDate.Day,POLineNumber,LineType,Description,SupplierSupplierName,UnitOfMasure.
10 Sort Fields
11
12 DataTable:Range"Ariba_Data*
13
14 Requester Order Id OrderedDatePOLineNumberLineTypeDescription Supplier -
15 Rob Montanez PO243 5/23/20171 Catalog IltemOficeProDesktopComputer Office Produ
16 George Compton PO259 6/8/20171 Catalog Item Photocopier-3001PCS IL Office Su
17 Venu Kotagiri PO108 3/15/2017 2 Catalog ItemIT EquipmentService IL Office Su
18 Venu Kotagiri PO51 1/10/20171 Catalog ltem Photo Copier2 IL Ofice Su
19 Venu Kotagiri PO30 12/18/20161 Non-Catalog ItemIR failure test 12/18 IL Office Su
20 Venu Kotagiri PO38 12/22/20161 Catalog ltem Photo Copier2 IL Office Su
21 Venu Kotagiri PO134 3/23/20171 Catalog ltem Multi-Purpose Photocopier-3001PCAIL Office Su
22 Venu Kotagiri P0104 3/9/20171 Catalog ItemPhotocopier-3001PCS IL Office Su
23 Venu Kotagiri PO24 12/15/20161 Catalog ItemPhoto Copier2 IL Office Su
24 Venu Kotagiri PO172 4/18/20171 Catalog ltem 3001PCAlnkCatridge IL Office Su
25 Venu Kotagiri PO165 4/18/20171 Non-Catalog Itemdemo non catalog Office Produ
26 Venu Kotagirni PO18 12/13/20161 Catalog Item Photo Copier2 IL Office Su

      
 

  
    
  
   

  

 
  
  
  
  
 
  
 
      
      
       
       
       
       
       
       
      
       
       
       
      



Appendix II 144 

Invoice Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

INVOICE REPORT WITH TAX DATA 
Tax data is captured on Invoice approvable during transaction processing. SAP ARIBA Procurement 
solution provides reports on Invoice spend with tax data. 

Navigation for accessing Invoice report with tax data: 

1. Log in to SAP ARIBA Procurement Solution 

2. Navigate to Manage > Prepackaged Reports > Buyer Settlement Reports > Click on Open on 

the pull-down menu 

3. System would display all reports related to Invoice 

4. Click on report Invoice spend with charges and taxes details > Click on Open on the pull-

down menu 

5. System would display Invoice spend with charges and taxes details report 

The standard report shows tax relevant reportingd fields like Tax Code ID, Tax Code Description, Tax 

Amount and Tax Authority (Line Type) but to analyze tax exceptions and tax accrual data, user can add 

more required fields by following below steps: 

Reporting Invoice Spend with Charges and Taxes Edit Save.. Actions

Field Browser
Pivot table Chart Dashboard

Page Others

Applied Filters 
728.82 Accounting DateSpanning: most recent 2 Year(s) Display Options Edit

Line Type Min/Max rows:3/8
Catalog Item 

Detail View

Invoice Line
ERP AccountingLine Type Unit of Tax Code Tax C
Supplier Invoice ID Date Number Part Name Description CommodityMeasureName Id 

Total
IL Office IRservice test PO22/RC25-12/14/2016 Catalog(3001_IT Consultation Organizational
Supplies 29- Item - 3001) State Sales/UseConsultation structure hour Unclassified Uncl:

consultation
Printer and IDT

IRIRFailureTest2_12/18-4712/18/2016 Catalog(3001_PrintSupplies 3001) Print Suppliesfacsimile andeach Fallback
Item State Sales/Use photocopier Self AccrualZZ

supplies Input Tax
(3001_IT Information IDT

RI79 test.152 2/11/2017 Catalo Eallh

    

 
   

  

    
 

 

 

 
      

        

 
      
       

 
  

    
 

   
   

 

  
   

    



145 Appendix II 

Invoice Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

1. Click on Edit button (top, right side of the page) 

2. User would be presented with Edit UI > Click on Source Data 

3. Source Data UI presented with options to edit source data 

Invoice Spend with Charges and Taxes Edit Save. Export Actions

Pivot table Chart Dashboard

Applied Filters

728.82 Accounting DateSpanning: most recent 2 Year(s) Display Options Edit

Line Type
Min/Max rows:3/8

Catalog Item

Detail View

Invoice Line
ERP AccountingLine Type Unit of Tax Code Tax Co
Supplier Invoice ID Date Number Part Name Description CommodityMeasure Name Id

Total

IL Office IRservice test PO22/RC25-12/14/2016 Catalog (3001_IT Consultation Organizational
Supplies29- Item - 3001) State Sales/Use Consultation structure hour Unclassified Uncl:

consultation

Edit Analysis Invoice Spend with Charges and Taxes Previous Done Save

Filter the data in your report by selecting values for the fields below. Allreports include a date field flter. To select a different date field to use as a filter, select Advanced Options. For More

Accounting Date (Calendar): * O Relative date range
Source Data

Time period:Year(s)

Pivot Layout Most recent2 time periods

Future time periods
Refine Data

OFixeddaterangefrom:4/1/2017 6/30/2017 ÿ

Advanced Options

Line Type:Catalog Item

Customize this form

Show Report Query

     

   

 

    

 
 

 

 

  
       

         

 
     
        

     

  
  

    

  
 

    

 

  

 



Appendix II 146 

Invoice Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

4. Available Measures section gets updated with Purchase Order related fields 

Edit Analysis InvoiceSpend withCharges and Taxes Next Done

Enter a tile for your report, select a data source to investigate from the Main Fact pull-down menu, and add at least one data field to the Data area of the pivot layout. To create a multi- More

Title: Invoice Spend with Charges and Taxes

Source Data
Description:Invoice Spend with Charges and Taxes

Pivot Layout

Report Currency:UserPreference

Refine Data
Data Sources

Main Fact: Invoice

Second Fact: (None selected)

Third Fact:(None selected)

Available Measures Page Fields

Pre-defined

 Measures in Original Currency
Column Fields

 Standard Calculations

Age (Days) Row Fields
ERP Supplier Data

Amount Accepted (USD)- Invoice ID Invoice Quantity
Accounting Date

Amount Disputed (USD)- Invoice Line NumberInvoice Unit Price (USD)
Line Type

Amount Invoiced (USD) Invoice Spend (USD)

Discount Amount (USD)
Create User-defined Field

Charge Amount (USD)

Tax Amount (USD)

Detail Fields
Part Name
Description
Commodity
Unit of Measure
Tax Code Name
Tax Code Id
Tax Code Description

AvailableMeasures AlIl
Page Fields

Line Count -

Paid Amount (USD) Column Fields

Split Count 

Sum of Paid Payment Row Fields Data
ERP Supplier
Invoice ID [INV] Invoice Quantity

Tax Accrual Amount (USD) Accounting Date
Invoice Line Number

Purchase Order
[INV] Invoice Unit Price (USD)

Line Type

User-defined [INV] Invoice Spend (USD)

Create User-defined Field [INV] Discount Amount (USD)

    

 
 

  

 

  

 
 

  

  

  

 
 

 

 
 

 

  
 

 

   
 

   
 

 

 

 
 

 

 
 
 
 

 
 

 

  
 

 

  

   
 

    
 

 
 

 

  

 



147 Appendix II 

Invoice Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

5. Click on Purchase Order pull down menu > Select Tax Amount > Click on Add to Report 

6. Select next field Tax Amount Invoiced > Click Add to Report 

Available Measures All
Page Fields

Price Variance Cost (USD) 

Serviced Amount Approved (USD) Column Fields

Serviced Amount in Approval (USD) 

Split Count Row Fields
ERP Supplier

 Data

Invoice ID [INV] Invoice QuantityTax Amount (US[
Action Accounting Date

Invoice Line Number[INV] Invoice Unit Price (USD)
Tax Amount Invoi Line TypeAdd to Report
User-detined [INV] Invoice Spend (USD)

Create User-defined Field [INV] Discount Amount (USD)

[INV] Charge Amount (USD)

[INV] Tax Amount (USD)

Detail Fields
Part Name
Description
Commodity
Unit of Measure
Tax Code Name

Available Measures All
Page Fields

Price Variance Cost (USD) 

Serviced Amount Approved (USD) Column Fields

Serviced Amount in Approval (USD) 

Split Count Row Fields
ERP Supplier

 Data

Invoice ID [INV] Invoice QuantityTax Amount (US[
Action Accounting Date

Invoice Line Number[INV] Invoice Unit Price (USD)
Tax Amount Invoi Line TypeAdd to Report
User-detined [INV] Invoice Spend (USD)

Create User-defined Field [INV] Discount Amount (USD)

[INV] Charge Amount (USD)

[INV] Tax Amount (USD)

Detail Fields
Part Name
Description
Commodity
Unit of Measure
Tax Code Name

  
 

  

 
 

 

   
  

     

  

  

 

 

 
 
 
 

 

  
 

  

 
 

 

   
  

     

  

  

 

 

 
 
 
 

 



Appendix II 148 

Invoice Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

7. Scroll up > Click on Invoice pull down option > Select Amount Accepted, Amount Disputed, 

and Amount Invoiced fields (click on field, then click on Add to Report; repeat for each field). 

8. Add Tax Accrual Amount field (Click on the field > click on Add to Report option on pull 

down menu). 

AvailableMeasures AlIl

Invoice

Measures in Original Currency

Standard Calculations

Age (Days)

Amount Accepted (USD)

Amount Disputed (USD)

Amount Invoiced (USD)

Create User-defined Field

AvailableMeasures All
Page Fields

Line Count

Paid Amount (USD)-

Split Count -
Column Fields

Sum of Paid Payment
Row Fields Data

Tax Accrual Amount (USD [INV] ERP Supplier
Action [INV] Invoice ID [INV] Invoice Quantity

[INV] Accounting Date
Purchase Order

Add to Report [INV] Invoice Line Number[INV] Invoice Unit Price (USD)
[INV] Line Type

Measures in Original Currency

[INV] Invoice Spend (USD)
Amount Acrantad in Oriainal Currone

Create User-defined Field [INV] Discount Amount (USD)

[INV] Charge Amount (USD)

[INV] Tax Amount (USD)

[PO] Tax Amount (USD)
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Invoice Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

9. The fields user selected all are added to report structure. 

10. To change the positioning of the fields on report display, click on the field pull down arrow > 
select either move up and move down option to create desired order of the fields 

11. Once desired editing is completed, click on Done button. 

Measures in Original Currency
Column Fields

Standard Calculations

Age (Days)- Row Fields
[INV] ERP Supplier Data

Expected Tax Amount (USD) [INV] Invoice ID [INV] Invoice Quantity
[INV] Accounting Date

Invoice Count [INV] Invoice Line Number[INV] Invoice Unit Price (USD)
[INV] Line Type

Line Count -
[INV] Invoice Spend (USD)

Create User-defined Field [INV] Discount Amount (USD)

[INV] Charge Amount (USD)

[INV] Tax Amount (USD)

[PO] Tax Amount (USD)

[PO] Tax Amount Invoiced
(USD)

[INV] Amount Invoiced (USD)

[INV] Amount Accepted (USD)

[INV] Amount Disputed (USD)

[INV] Tax Amount (USD)

[PO] Tax Amount (USD)

[PO] Tax Amount Invoiced
(USD)

[INV] Amount Invoiced (USD)

IINMA Amount Aecontod (USD)
Action

(USD)
Remove

Move Up

Move Down

Edit.

[INV] Tax Code Name
[INV] Tax Code Id
[INV] Tax Code Description
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CONFIGURATION GUIDE 

12. System would display the report. 

EditAnalysis InvoiceSpendwithChargesandTaxes Next Done

Enter a title for your report, select a data source to investigate from the Main Fact pull-down menu, and add at least one data field to the Data area of the pivot layout.To create a multi-More

Title: * InvoiceSpendwithCharges and Taxes
Source Data

Description: InvoiceSpend with Charges and Taxes

Pivot Layout

Report Currency:User Preference

3 Refine Data
Data Sources

Reporting Invoice Spend with Charges and Taxes 1P3 Save.. Actions

 Field Browser
 Pivot table Chart  Dashboard

Page Others

Applied Filters

Accounting DateSpanning: 4/1/2017 -- 6/30/2017 Display Options Edit
Min/Max rows: 3/8

[INV] Line TypeCatalog Item

Detail View 

[INV] [INV] [INV] [INV 
[INV] invoice Line [INV] Unit Tax Tax [IN

[INV] ERP AccountingLine Type [INM] of Code Code Cc
Supplier[INV] Invoice ID Date Number [INV] Part Name [INV] Description CommodityMeasure Name Id De

Total 
IDT

DE SpareIRRecal.Tax-365 - 4/19/2017 Catalog (3013_Photocopier 3013)Photo Copier Photocopierseach Standard
Parts Item Photo Copier  1ndnoA1

TAX
IDT

ERS IRlnv-CR10-394 - 4/21/2017 Catalog(3010 3010) TestCR1 TestCR1 Ink cartridgeseach fallback
vendor - Item 1ndino XX

tax

Information IDT
AN612017 Standard
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ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

13. Click on Line Type > Select Line Type (All) option. (This can be also done on Source Data UI 

Page > Line Type pull down menu). 

Invoice Spend with Charges and Taxes Edit Save.. Export Actions

Pivot table Chart Dashboard

Applied Filters

Accounting Date Spanning: 4/1/2017 -- 6/30/2017 Display Options Edit
Min/Max rows:3/8

[INV] Line TypeCatalog Item

Detail View

[INV] [INV] [INV] [INV] 
[INM] Invoice Line [INV] Unit Tax Tax [IN

[INV] ERP AccountingLine Type [INV] Code CodeCc
Supplier [INV] Invoice ID Date Number [INV] Part Name [INV] Description Commodity Measure Name Id De

Total
IDT

DE SpareIRRecal.Tax-365 4/19/2017 Catalog (3013_Photocopier 3013)Photo Copier Photocopiers Standard
Parts Item - Photo Copier each indino A1

TAX

Invoice Spend with Charges and Taxes Edit Save... Export Actions

Expand Next Level
Pivot table Chart Dashboard

At lowest level

Applied Filters Select Level, Values:

Accounting DateSpanning: 4/1/2017 -- 6/30/2017 Display Options Edit
[INV] Line Type (all)

Catalog Item
Min/Max rows:3/8

[INV] Line Type
Catalog lItem

Select Others..
Detail ViewSelect Search Filter..

[INV] Move Field [INV] [INM]
[INV] Invoice [INV] Unit x1 [IN

[INV] ERP AccountingLine Left [INV] of Code Code Cc
Supplier [INV] Invoice ID Date Number [INV] Description CommodityMeasure Name Id De

Right
Total
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ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

14. Move columns left or right, scroll left or right to check the data. Line Type and Description 

fields show the authority level tax information. Scroll right to check relevant Tax amounts. 

[INV] [INV] 
Invoice [INV] [INV] Unit [INV] Tax [INV] Tax invoice [INV] Invoice
Line Line [INV] of Code [INV] Tax Code QuantityUnit Price
Number Type [INV] Description [INV] Part Name Commodity Measure Name Code Id Description+ (USD)

State Sales or use taxes
Sales/Uselevied by a state (auto-Unclassified Ink cartridgesUnclassifiedIDT fallbackXX Unclassified 0.00

generated) - output tax

County Sales or use taxes
Sales/Uselevied by a county Unclassified Ink cartridgesUnclassifiedIDT fallbackXX Unclassifiedoutput tax 0.00

(auto-generated)
Information IDT

CatalogMilestone Test - (UELC_3010 3010) Statetechnologyhour
Standard

Item Sales/Use Output TAXAD Unclassified 1.00 100.0000consultation
services Exempt

State Sales or use taxes Information IDT
technologySales/Uselevied by a state (auto-Unclassified UnclassifiedStandard

Output TAXAO Unclassified 0.00
generated)- consultation

services Exempt
County Sales or use taxes Information IDT
Sales/Uselevied by a countyUnclassified technologyUnclassifiedStandard

Output TAXAO Unclassified 0.00
(auto-generated) consultation

services Exempt
Catalog IDT

Item TestCR1 - (3010 3010) TestCR1 Ink cartridgeseach Standard A1 Unclassified 1.00 25.0000
Output TAX

State Sales or use taxes IDT
Sales/Uselevied by a state - lineUnclassified Ink cartridgeseach Standard A1 Unclassified 0.00

level - Output TAX
City Sales or use taxes IDT

3 Sales/Use levied by a city - lineUnclassified Ink cartridgeseach Standard A1 Unclassified 0.00
<

[INV] [INV] [INV [PO] Tax [INV] [INV] [INV] [INV] Tax
[INV] Tax invoice [INV] Invoice [INV] InvoiceDiscountCharge[PO] Tax [INV] Tax Amount Amount Amount Amount Accrual
Code QuantityUnit Price Spend Amount AmountAmount Amount Invoiced Invoiced Accepted Disputed Amount
Description + (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD)

Unclassified 0.00 1.50 0.00 0.00 2.13 1.50 2.13 0.25 1.50 -1.25 1.25

Unclassified 0.00 0.31 0.00 0.00 2.13 0.31 2.13 0.25 0.31 -0.06 0.06

Unclassified 0.00 0.32 0.00 0.00 2.13 0.32 2.13 0.25 0.32 -0.07 0.07

Unclassified 1.00 25.0000 25.00 0.00 0.00 2.13 2.13 2.13 25.00 25.00 0.00 0.00

Unclassified 0.00 0.50 0.00 0.00 0.32 0.00 0.00 0.50 0.50 0.00 0.00

Unclassified 0.00 1.50 0.00 0.00 2.13 1.50 2.13 0.00 1.50 0.00 0.00

Unclassified 0.00 0.32 0.00 0.00 2.13 0.32 2.13 0.00 0.32 0.00 0.00

Unclassified 0.00 0.31 0.00 0.00 2.13 0.31 2.13 0.00 0.31 0.00 0.00

>
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Invoice Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

15. To work on this data in an excel file > Click on Export (Export function has options to choose 

file type and other download and display options which is beyond the scope of this document 

16. System would perform 6 steps to prepare and download data in to excel file. 

Reporting Invoice Spend with Charges and Taxes 1P3 Save.. Export Actions

Field Browser
Pivot table Chart Dashboard

Page Others

Applied Filters

114.82 Accounting DateSpanning: 4/1/2017 --6/30/2017 Display Options Edit 
Min/Max rows: 3/8

Detail View

[INV] [INV] [INV] [PO] Tax [INV [INV] [INV] [INV] Tax 
[INV] TaxInvoice [INV] Invoice [INV] Invoice DiscountCharge[PO] Tax [INV] Tax Amount Amount Amount Amount Accrual

X Code QuantityUnit Price Spend AmountAmountAmount Amount Invoiced Invoiced Accepted Disputed Amount
Description + (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD)

Unclassified 0.00 1.50 0.00 0.00 2.13 1.50 2.13 0.25 1.50 -1.25 1.25

Unclassified 0.00 0.31 0.00 0.00 2.13 0.31 2.13 0.25 0.31 -0.06 0.06

Unclassified 0.00 0.32 0.00 0.00 2.13 0.32 2.13 0.25 0.32 -0.07 0.07

ExportingtoExceltemplate Return to Report

Your data is being exported.If you are asked to enable ActiveX,respond Yes. Otherwise,your data cannot be exported to Excel.

1. Contacting Excel

2.Downloadingtemplate

3. Waiting for query
4.Downloadingdata

5. Configuring layout

6.Done

Return to Report
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Invoice Report With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

17. When all steps are completed, excel file will be opened. 

This file can be manipulated further to display data as desired by user. Pivot table can be updated or 

formulas can be added to analyze the data further. Below sample file downloaded from customized report 

showing tax authorities, PO tax Amount vs. Tax amount on Invoice and Tax Accrual data which can be 

further manipulated based on requirement. 

(Pivot_Area_Pie).xls;jsessionid=BE9D1A52FC19498A3E89DF25E4EBBA71.Node19app212snv [Read-Only] [Compatibility Mode] - Microsoft Excel
Home Insert  Page Layout Formulas Data Review View ÿ

m%  Wrap Text ÿ AutoSumArial 10
ÿCopy FillÿPaste B D %±$ Conditional Cell InsertDelete Format Sort & Find & Format Painter Formatting = as Table + Styles + Q Clear +Filter+ Select

Clipboard Font ÿ Number  Styles Cells 
F30 fc Catalog Item

A B C D E
[INTotal

2 This Worksheet Will Contain Data Populated From Ariba Spend Management.
3 [INV] Invoice Quantity [INV] Invoice Unit Price (USD) [INV] Invoice Spend (USD)[INV]Discount Amount(USD)[INV]ChargeAmol
4 ToQuery Parameters:Range"AribaDataParams"
5 Source_Data Invoice (Procurement & Invoicing);:PurchaseOrder(Procurement & Invoicing)

Fixed_Columns FALSE
6
7 Query Filters
8 Field Mappings
6 Raw Field Names SSPInvoiceLineltem.Supplier SupplierName,SSPInvoiceLineltem.lnvoiceld, SSPInvoiceLineltem.AccountingDate.Day,SSPInvo
10 Sort Fields
11
12 Data Table: Range "Ariba_ Data”
13
14 [INV]Supplier (ERP Supplier) [INV] Invoice ID [INVJAccounting Date(Date)[INV Invoice Line Number[INV LineType
15 IL Office Supplies IRRM-05-05-2017-OVER-459 5/8/2017 5 Catalog Item
16 IL Office Supplies IRRM-05-05-2017-OVER-459 5/8/2017 7 District Sales/Use
17 IL Office Supplies IRRM-05-05-2017-OVER-459 5/8/2017 3 City Sales/Use
18 IL Office Supplies IRRM-05-05-2017-UNDER-460 5/8/2017 2 City Sales/Use
19 IL Ofice Supplies IRRM-05-05-2017-UNDER-460 5/8/2017 4 District Sales/Use
20 IL Office Supplies IRRM-05-05-2017-OVER-459 5/8/20171 Catalog Item
21 IL Office Supplies IRRM-05-05-2017-OVER-459 5/8/20174 District Sales/Use
22 ERS vendor IRvi_test1111-421 4/25/2017 4 County Sales/Use
23 Office Products GB IRTR_VI_INV_Demo1-370 4/20/20171 Catalog Item
24 Office Products GB Raccept the engine calculated tax-352 4/18/20171 Catalog Item
25 Office Products GB IRVI_Demo_UK_Apr26_1-417 4/25/20171 Catalog Item
26 IL Office Supplies IR123444-333 4/13/2017 1 Catalog Item
27 IL Office Supplies IR2345566543-346 4/17/2017 1 Catalog Item
28 IL Office Supplies IR12455-342 4/14/20171 Catalog Item
20 Of ID\/1Im 1/20/20171

[INTotal
ThisWorksheetWill ContainDataPopulatedFromAribaSpendManagement.
[INV] Invoice Quant[INV] Invoice Unit Price[INV] Charge Amou[INV] Amount Accepted(USI [INV] Amount Disputed (USD)

01 QueryParameters:Range"Ariba_Data_Params" Query Details:Rang
Source Data Invoice (Procurement &Invoicing);Purchase Order (Procurement & Invoicing) AppliedFilters
Fixed_ColumnsFALSE Applied_FilterDes

Query_Filters
Field Mappings
Raw_Field _Name SSPInvoiceLineltem.Supplier.SupplierName, SSPInvoiceLineltem.lnvoiceld,SSPInvoiceLineltem.AccountingDate.Day, SSPInvoiceLineltem.InvoiceLineNumber, SSPInvoiceLineltem.LineType, SSPInvoiceLin
Sort_Fields

Data Table: Range"Ariba_Data" Extra (Derived) Colu

[INVJTax
[INV]Supplier [INV]Tax Code (Tax CodeCode (Taxsum(Tax Amount sum(Amount sum(Amountsum(Amount sum(Tax Accrual
(ERP Supplier)[INV] Invoice ID [INV] LineType Name) Code Id) Invoiced) Invoiced) Accepted) Disputed) Amount) Sample
IL Ofice SuppliesIRRM-05-05-2017-OVEI Catalog ItemIDT Standard Output TAXA1 2.48 30.00 30.00 0.00 0.00 add formula here
IL Ofice SuppliesIRRM-05-05-2017-OVEIDistrictSales/UseIDT Standard Output TAXA1 2.48 0.60 0.30 0.30 0.00
IL Office SuppliesIRRM-05-05-2017-OVEICitySales/Use IDT Standard Output TAXA1 412.50 75.00 50.00 25.00 0.00
IL Ofice SuppliesIRRM-05-05-2017-UNDI City Sales/UseIDT Standard Output TAXA1 850.00 200.00 125.00 75.00 0.00
IL Office SuppliesIRRM-05-05-2017-UNDEDistrictSales/Use IDT Standard Output TAXA1 850.00 200.00 125.00 75.00 0.00
IL Office SuppliesIRRM-05-05-2017-OVEICatalogltemIDT Standard Output TAXA1 412.50 5,000.00 5,000.00 0.00 0.00
IL Ofice SuppliesIRRM-05-05-2017-OVEIDistrictSales/UseIDT Standard Output TAXA1 412.50 75.00 50.00 25.00 0.00
ERS vendor IRvi_test1111-421 County Sales/UseUnclassified Unclassified 0.00 0.25 0.25 0.00 0.00
OfficeProductsGEIRTRVIINV_Demo1-3CatalogItemIDT Standard Input TAX V1 125.00 625.00 625.00 0.00 0.00
OfficeProducts GEIRaccept the engine ca Catalog ltemIDT Standard Input TAXV1 225.00 1,125.00 1,125.00 0.00 0.00
Office Products GEIRVI_Demo_UK_Apr26_Catalog ItemIDT Standard Input TAXV1 148.40 742.00 742.00 0.00 0.00
IL Ofice SuppliesIR123444-333 Catalog ItemIDT Standard Output TAXA1 0.00 3,000.00 3,000.00 0.00 0.00

A1 112.50 0.00 0.00
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XSD Changes To External Web Services 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

APPENDIX III 
XSD CHANGES TO EXTERNAL WEB SERVICES 

When SAP Ariba makes changes to Import/Export Files or Web Services format, Customers need to 
review, accept the changes and publish all changes accepted to apply the changes introduced. This is 
SAP Ariba standard process and applies to external tax calculation web service task “Export Document 
Data for External Tax Calculation”. 

Please follow below steps to review, accept and publish changes made to task Export Document Data for 
External Tax Calculation. 

1. It is recommended to consult SAP Ariba Customer Support and Thomson Reuters Professional 
Services before making decision to accept XSD changes. And remember that upgrade cannot be 
reverted to SAP Ariba Platform limitation on for this feature so careful consideration is required 
before upgrading to new XSD. 

2. New SAP Ariba Buying solutions Customers with solution having Service pack SSP.2017.Rel-
9535/Release Number SSP.2017.09 would have Tax API with new XSD as default so can ignore 
this section. 

NEW WSDL ELEMENTS ON API2 

Request Type: 

This is a new element that has been added at Document header level. This element has two unique 
status values: Tax Calculation or ERP Posting Call 

TaxCalculation call - seen on tax calculation request 

ERPPosting call – This is a second call on SAP Ariba Invoice Reconciliation document after 
successful Invoice reconciliation and before OK2PAY is sent to Buyer's backend ERP system. 

Line1,Line2,Line3 address elements: 

Line1, Line2 and Line3 elements is now added to Bill to, Ship to, SupplierLocation,ShipFrom 
address collections. 

LineType: 

ÿ
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ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

This is a number (type:Integer) in SAP Ariba Buying Solution which indicates type of a document 
line. Tax calculation request would have this new element indicating what is type of document line 
(ex: Tax, Material, etc). SAP Ariba would provide list; 

OriginalSupplierAmount: 

This collection is added at two places. 

1. Under LineItem->Item→OriginalSupplierAmount. This would show total tax amount charged 
by Vendor 

2. Under LineItem→Item→Taxes (block gets repeated for each tax type if Vendor entered 
taxes at granular level on Invoice)→item→OriginalSupplierAmount. This would show the tax 
amount charged by Vendor by tax type (if Vendor submitted Invoice with granular taxes). 

Taxes: 

This block is seen on ERPPostingCall (RequestType=ERPPosting) This section would have TaxType, 
OriginalSupplierAmount collection (elements: Amount, Currency), FinalAmount collection (elements: 
Amount, Currency) This block should get repeated for each tax type (if Vendor entered taxes at 
granular level on Invoice). 

ShipFrom: 

This is new address element (collection) added to show the ShipFrom address from where goods are 
shipped. This would have PostalAddress collection (elements city,country,Line1,Line2,Line3, 
PostalCode,State.In previous version the SupplierLocation which may not be actual ship from 
location. 

PostingComponent: 

The posting component is similar to ExternalTaxItem in previous versions and will be populated on 
Ariba Tax response for posting call.PostingInstruction would have <Name> and <Value> element pair 
which would be populated with TaxAccountKey/AccountInstruction and corresponding value 
respectively. 

DocumentSubType: 

This new element is introduced on tax calculation request to classify  invoice types including Standard 
invoice, Line-item Credit memo and Line-item Debit Memo. 

RelatedDocument: 

This is the unique SAP Ariba IR number for which Line-item Credit or Debit memo is created. This 
reference number is provided on tax calculation request for either Line-item Credit or Debit memo. 

RelatedDocumentDate 

This new field captures the posting date of the related document. 

 



157 Appendix III 
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REVIEWING AND ACCEPTING CHANGES 
Navigation: 

1. Log in to SAP Ariba Buying Solution 

2. On Home screen navigate to Manage > Core Administrator 

3. Go to > Integration Manager > Data Definition > Select Web Services from Format drop-down menu 
and click on Search button 

Note: if there are more than one web services configured, user can search for specific task by entering 
Export Document Data for External Tax Calculation in Task Name input field 

Result: System would display integration task with status Changed as shown in below screen shot 

5. Click on Action button and select option Review as shown in the screenshot 

HOME PROCUREMENT INVOICING USERPROFILE MORE... Recent Manage Createv

Administration PurchasingWorkbench

Payment PaymentID ERPPayment# Supplier Invoice# Purchase Ord ApprovalProcesses Queues

Contracts Receive
CommonActions

ToDo Core Administration Reconcile Charges

Create MyTasks ReconcileInvoice
Requisition IDÿ Date From Status

MyToDo ReportSearchFilters
Analytical Report Noitems

Payments SMAdmin
KnowledgeProject

Supplier PersonalWorkspace SupplierKnowledge
MyDocuments

More PrepackagedReports Unassigned Charges
ID Title Dateÿ

Manage PublicReports

NoitemsAdministration PurchaseOrders

HOME PROCUREMENT INVOICING ADMINISTRATION MORE... Recent Manage Create T

Data Definition
 Site Manager

Data Import/Export

Audit Log Review and accept changes to the data definition in integration events.

Integration Manager Search Filters:

Data Import/Export Task Name:

Data Definition
Format: Web ServicesIntegration Configuration Search List All

End Point Configuration

Integration Toolkit Security
Data Definition Download Data DictionaryMaster Data Default Values

Tasks Status Format
Master Data Manager

Export Document Data for External Tax Calculation Changed Web Services Actions 
Customization Manager
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System would show the list of groups under ‘Export Document Data for External Tax Calculation' 
integration event.   

There would be two groups like ProcureLineItemCollection_TaxServiceAPIRequest and 
ProcureLineItemCollection_TaxServiceAPIResponse which would show the Status as Needs Review 
Publish All Changes in active 

6. Click on group ProcureLineItemCollection_TaxServiceAPIRequest. The section ‘Field Order for 
ProcureLineItemCollection_TaxServiceAPIRequest' would show the fields under this group. 

Scroll down to find the fields marked in red which has been newly added. Here, Organization Unit and 
Organization Name are new fields. Click on Accept Changed Fields button to accept the changes. 

DataDefinition

Review and accept changes to the data definition in integration events.

SearchFilters:

Task Name:

Format: Web Services Search List All

DataDefinition DownloadDataDictionary

Tasks Status Format

Export Document Data for External Tax Calculation Changed Web Services Actions
Review

Export Document Data for External Tax Calculation Publish All Changes Exit

Review and accept the changes for each group of fields that needs review, then publish all changes. You must accept all the changes before publishing.

Groups for 'Export Document Data for External Tax Calculation'

Group Names Status

Money_Reference No Change

ProcureLineltemCollection_TaxServiceAPlRequest Needs Review

ProcureLineltemCollection_TaxServiceAPlResponse NeedsReview

Field Orderfor'Money_Reference'

PositionCurrent Field New Field Description

Amount Amount

2 AmountinReportingCurrency AmountinReportingCurrency
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ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
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7. Now click on another group ‘ProcureLineItemCollection_TaxServiceAPIResponse’. System would 
show the fields under this group. Scroll down to find the fields added newly in green color. 

LineItems.ExternalTaxItem.AccountInstruction is a new field. Click on Accept Changed Fields 
button to accept the changes. 

8. As a final step, to make changes effective, click on Publish All Changes button on top (below 
Application 

Menu bar) as shown in the below screenshot. 

ProcureLineltemCollection_TaxServiceAPIRequest Needs Review

ProcureLineltemCollection_TaxServiceAPlResponse Needs Review

Field Orderfor'ProcureLineltemCollection_TaxServiceAPIRequest'

Position Current Field New Field Description

31 Lineltems.SupplierLocation.PostalAddress.State Lineltems.SupplierLocation.PostalAddress.State

32 Lineltems.TaxExclusion Lineltems.TaxExclusion

33 Type Type

34 UniqueName UniqueName

35 OrganizationName

36 OrganizationUnit

Accept Changed Fields

Group Names Status

Money_Reference No Change

ProcureLineltemCollection TaxServiceAPIRequest Needs Review

ProcureLineltemCollection_TaxServiceAPIResponse Needs Review

Field Order for 'ProcureLineltemCollection_TaxServiceAPIResponse'

Position Current Field New Field Description

21 Lineltems.ExternalTaxltem.TaxableAmount.Currency.UniqueNameLineltems.ExternalTaxltem.TaxableAmount.Currency.UniqueName

22 Lineltems.ExternalTaxltem.Accountlnstruction

23 Lineltems.NumberlnCollection Lineltems.NumberlnCollection

24 Lineltems.TaxCode.Country.UniqueName Lineltems. TaxCode.Country.UniqueName

25 Lineltems.TaxCode.UniqueName Lineltems. TaxCode.UniqueName

26 UniqueName UniqueName

Accept Changed Fields
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HOME PROCUREMENT INVOICNG ADMINISTRATION MORE Recent Manage Create

Export Document Data for External Tax Calculation PublishAllChanges Exit

To revert to the previously accepted data definition, review and accept the reversion changes for each group of fields that needs review, then publish all changes. You must acceptMore
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ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
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9. Once the changes are accepted and published, new fields turn in to red representing that fields were 
added. And field groups show the status as Changes Accepted 

Group Names Status

ProcureLineltemCollection_TaxServiceAPIRequest Changes Accepted

ProcureLineltemCollection_TaxServiceAPlResponse Changes Accepted

Field Order for'ProcureLineltemCollection_TaxServiceAPlRequest

 Position Current Field New Field Description

31 Lineltems.SupplierLocation.PostalAddress.State Lineltems.SupplierLocation.PostalAddress.State

32 Lineltems.TaxExclusion Lineltems.TaxExclusion

33 Type Type

34 UniqueName UniqueName

35 OrganizationName

36 OrganizationUnit

Accept Changed Fields

Groupsfor'ExportDocumentDataforExternalTaxCalculation

GroupNames Status

ProcureLineltemCollectionTaxServiceAPiRequest ChangesAccepted

ProcureLineltemCollection_TaxServiceAPIResponse ChangesAccepted

FieldOrderfor'ProcureLineltemCollection_TaxServiceAPIResponse

Position CurrentField NewField Description

21 Lineltems.ExternalTaxltem.TaxableAmount.Currency.UniqueName Lineltems.ExternalTaxltem.TaxableAmount.Currency.UniqueName

22 Lineltems.ExternalTaxltem.Accountinstruction

23 Lineltems.NumberlnCollection Lineltems.NumberlnCollection

24 Lineltems.TaxCode.Country.UniqueName Lineltems.TaxCode.Country.UniqueName

25 Lineltems.TaxCode.UniqueName Lineltems.TaxCode.UniqueName

26 UniqueName UniqueName
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Finally, the data definition main UI page will show you web service task status as unchanged telling you 
that changes available are accepted and no more changes exists. 

DataDefinition

Review and accept changes to the data definition in integration events.

SearchFilters:

Task Name.

Format: Web Services Search List All

DataDefinition DownloadDataDictionary

Tasks  Status Format

Export Document Data for External Tax Calculation Unchanged Web Services Actions
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UPDATING ENDPOINT 
In addition to upgrading to new XSD, Customers also need to update the End point URL for 
ONESOURCE Tax Web Service. 

Users must be a member of Customer Administrator or Integration Admin to perform this activity. 

To update endpoint URL, please follow below steps: 

1. Log in to SAP Ariba Solution 

2. Manage > Core Administrator > Integration Manager > End Point Configuration 

HOME PROCUREMENT INVOICING CATALOG MORE... Recent- Manage Create T

Administration Purchase Orders

Payment Payment ID ERP Payment # Supplier Invoice # Purchas Approval Processes Queues

Contracts Receive

Common Actions
To Do Core Administration Reconcile Charges

Create My Tasks Reconcile Invoice

Requisition ID ÿ Date From Status
My To Do Report Search Filters

Analytical Report No items
Payments Supplier Knowledge

Supplier
Personal Workspace Unassigned Charges

Customer My Documents
More Prepackaged Reports

ID Title Date ÿ
Manage Public Reports

HOME PROCUREMENT INVOICING ADMINISTRATION

Recent Manage Create 
MORE...

Integration Manager
Site Manager

Data Import/Export
s   g n    o  e n n n Audit Log

Integration Manager Data Import/Export Data Definition
Data Import/Export

Import and export data. View status, details, errors, and Review and accept changes to the data definition in
Data Definition the history of past data imports and exports. integration events.
Integration Configuration

End Point Configuration Integration Configuration EndPointConfiguration

Integration Toolkit Security Search, edit, activate or deactivate data import/export Configure external systems connection information.

Master Data Default Values tasks. Search fields are case-insensitive and you can enter
all or part of a name.
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CONFIGURATION GUIDE 

3. Find endpoint to be updated and click search as shown in below screenshot 

4. When user clicks on Edit, system would offer endpoint UI in edit mode. 

5. Once Endpoint URL is updated click Save to complete the update. 

Please check with Thomson Reuters Professional Service for updated End point URL 

Updating endpoint also updates endpoint URL for integration event Export Document Data for 
External Tax Calculation 

HOME PROCUREMENT CATALOG ADMINISTRATION MORE... Recent Manage Create T

End Point Configuration
SiteManager

Data Import/Export
Audit Log Search for existing end points or create new end points. Search fields are case-insensitive and you can enter all or part of a name.

1.enter search
Integration Manager text (case insensitive)
Data Import/Export Search Filters: 2. select Add/Remove Search Filters

Outbound as TypeData Definition End Point: indirect
Integration Configuration
End Point Configuration Type. No Choice Inbound Outbound

Search List All
Integration Toolkit Security

3. clickMaster Data Default Values 4. system would Searchdisplay endpoint
Master Data Manager

Name Type
Customization Manager IndirectTax punoqno

User Manager Create New 5.click Edit
Users

End Point Configuration-EditEnd Point"lndirectTax' Save Cancel

2. click
Save

General

Specify end point information and specify either a Web Services Security certificate, an HTTP Authentication, none of them or both. Fields marked with * are required.

Name. IndirectTax 1.enterherethenew
endpoint

Type. Inbound punoqno

URL: 1omsonreuters.com/ExternalTRTaxService/TaxServiceExport/TaxServiceExport.wsdl

ÿ
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6. Verify if endpoint URL updated in Integration Task by following below steps 

Manage > Core Administration > Integration Admin > Integration Configuration 
Under Search Filters section, select ONESOURCE Endpoint from drop down menu and choose 
Status   

Enabled as shown in below screenshot. 

3. Click on the task Export Document Data for External Tax Calculation hyper link shown under 
the Configuration section to check the updated endpoint URL. 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 2.0.0.0 
CONFIGURATION GUIDE 

Integration Manager
Data Import/Export Search Filters:

Data Definition

Integration Configuration Task Name:

End Point Configuration 1. choose endpoint
Format: (no value) created forIntegration Toolkit Security 2.select ONESOURCEintegration

Master Data Default Values check box End Point: IndirectTax
for Enabled

MasterData Manager Status: Enabled Disabled Search List All

Customization Manager

3.system would
User Manager Configuration display integration
Users task

Other User Info Tasks ÿ Format Enabled Supported Formats

Groups Export Document Data for External Tax Calculation
Web

Exports data on approvable documents (such as requisitions and invoice YesService [Web Service] Actions 1
Approval Queues reconciliations) to the external system for calculation of tax.

Data Import/Export
Delegations

View data import/export task Done
2.click Done

Activate or deactivate task, specify integration format and connectivity information.

Name: Export Document Data for External Tax CalculationView WSDL

Description: Exports data on approvable documents (such as requisitions and invoice reconciliations) to the external

system for calculation of tax.

Status:  Enabled

Format:Web Service

Type: Outbound to External System

End point:  IndirectTax 1. verify if this URL is similar to
whathasbeenenetered for

URL: * https://int-ariba-

uat.hostedtax.thomsonreuters.com/ExternalTRTaxService/TaxServiceExport/TaxServiceExport.wsdl
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